
 

  

 

Deltek Vision® 7.6 
Technical Installation Guide 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

July 29, 2016 
 



 

 

Technical Installation Guide ii 

 

While Deltek has attempted to verify that the information in this document is accurate and 
complete, some typographical or technical errors may exist. The recipient of this document is 
solely responsible for all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is 
subject to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are 
reserved. No part of this document may be reproduced or transmitted in any page or by any 
means, electronic or mechanical, or translated into another language, without the prior written 
consent of Deltek, Inc. 

This edition published July 2016. 

© 2016 Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license agreement. 
Unauthorized reproduction or distribution of the program or any portion thereof could result in 
severe civil or criminal penalties. 

All trademarks are the property of their respective owners. 
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Overview 
This guide contains technical installation and setup information for the staff at your company who 
maintain the hardware and software required to install Deltek Vision. 

 

The Vision 7.6 release contains major technology and configuration changes that affect the 
typical upgrade scenario. Do not uninstall your previous version of Vision. 

If you have any custom DLLs or reports, do not uninstall your previous version since the 
uninstall process may remove all files. 

The installer has built-in intelligence to detect the previous installation – it automatically backs 
up the folder containing your previous installation files and migrates certain custom settings to 
the new version.   

Before performing the upgrade, review the Summary of Upgrade Installation Changes to 
understand how these changes will affect your deployment. 

 

If you are using a Sage Abra (formerly Best Software Abra) application stored in a FoxPro 
database, do not upgrade to Deltek Vision 7.6 

Deltek Vision 7.6 is now running as a native 64-bit application and is unable to integrate with 
the Sage Abra database stored in a FoxPro database for the following reasons: 

 Microsoft FoxPro ODBC/OLEDB drivers are only 32-bit. 

 Microsoft Extended Support for Microsoft Visual FoxPro 9.0 Professional Edition 
ended in January 2015: https://msdn.microsoft.com/en-us/vfoxpro/bb308952.aspx , 
http://support.microsoft.com/lifecycle/?p1=7992  

 

See the Deltek Vision Advanced Technical Administration Guide for more complex topics 
related to the Vision deployment, including HTTP compression, central location for WebLink 
entries (shared databases.enc), reverse proxies, and integrated security. This document is 
available on the Knowledge Center tab of the Deltek Customer Care Connect site 
(http://support.deltek.com). 

Appendices 
This guide contains the following appendices, which provide detailed installation information for 
specific application prerequisites and for changes to the Vision configuration after setup. 

Appendix Title Description 

A Microsoft Internet Information 
Server (IIS) Installation on 
Windows Server 

Provides instructions for enabling the 
components of IIS on the Web/Application 
Server. 

B Microsoft SQL Server Edition 
and Version Information 

Provides links to the Microsoft download 
locations for SQL Server Service Packs, 
Cumulative Updates, and SQL Server Express 
Edition with Advanced Services, which is the only 
version of SQL Server Express Edition supported 
by Vision. 

https://msdn.microsoft.com/en-us/vfoxpro/bb308952.aspx
http://support.microsoft.com/lifecycle/?p1=7992
http://support.deltek.com/
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Appendix Title Description 

C Microsoft SQL Server 
Reporting Services 

Provides instructions for configuring Microsoft 
SQL Server Reporting Services (a prerequisite 
before Vision can be installed on the Web or 
report servers). 

D Printing in Vision  Discusses the various methods for printing in 
Vision. This includes steps for: 
 Saving output to PDF files 

 Printing to local printers on end-user 
computers without printing to PDF 

 Printing to network printers that are installed 
directly on the Web Server 

This appendix also includes instructions for 
modifying the Deltek Vision WebLink entries from 
the default Vision local accounts to domain 
accounts in order to use network printers for 
Vision batch jobs. Steps include creating 
accounts, assigning local policies, and adding 
role memberships. 

E Reload Reports into Vision Provides instructions for manually loading 
standard Vision reports to the report server from 
within the application. This appendix also 
explains how to identify and resolve connection 
errors in loading reports. 
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If You Need Assistance 
If you need assistance installing, implementing, or using Vision, Deltek makes a wealth of 
information and expertise readily available to you. 

Customer Services 
For over 20 years, Deltek has maintained close relationships with client firms, helping with their 
problems, listening to their needs, and getting to know their individual business environments. A 
full range of customer services has grown out of this close contact, including the following: 

 Extensive self-support options through the Customer Care Connect Web portal. 

 Phone and email support from Customer Care analysts 

 Technical services 

 Consulting services 

 Custom programming 

 Classroom, on-site, and Web-based training 

 

Find out more about these and other services from the Customer Care Connect site. 

Customer Care Connect Site 
The Deltek Customer Care Connect site is a support Web portal for Deltek customers who 
purchase an Ongoing Support Plan (OSP).  

The following are some of the many options you have at the Customer Care Connect site: 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers 
through the Deltek Connect Customer Forums 

 Display or download product information, such as release notes, user guides, technical 
information, and white papers 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Use Quick Chat to submit a question to a Customer Care analyst online 

 Subscribe to Deltek communications about your Deltek products and services 

 Receive alerts of new Deltek releases and hot fixes 

 

If you need assistance using the Customer Care Connect site, the online help available on the 
site provides answers for most questions  
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Access Customer Care Connect 

To access the Customer Care Connect site:  

1. Go to http://support.deltek.com. 

2. Enter your Customer Care Connect Username and Password. 

3. Click Log In. 

 

If you do not have a username and password for the Customer Care Connect site, contact your 
firm’s Vision Administrator. 

If you forget your username or password, you can click the Account Assistance button on the 
login screen for help. 

Additional Documentation 
Release notes and other guides are available for this release. You can download these 
documents using Deltek Software Manager or the Customer Care site. 

Deltek Software Manager 
The Documents tab in Deltek Software Manager lists all of the documents associated with a 
release and lets you download the ones that you want.  

To download documents: 

1. On the Deltek Customer Care site, click the Product Downloads tab, then select Launch 
Deltek Software Manager. 

2. When the Deltek Software Manager opens, highlight a release in the left pane. 

 

Do not enter a check next to the release name or click Add to Download Queue. If you 
do so, you will download the software as well as any documentation that you want. 

3. Click the Documents tab to display a list of available documents for the release. 

4. Select the documents that you want. 

5. Click View Download Queue to see a list of documents that you selected. 

6. Click Download. 

Customer Care Site Enterprise Search 
Use the search feature to find specific documents or to see a list of all documents associated with 
a release. Then open or download the ones that you want. 

To download documents: 

1. On the Deltek Customer Care site, click Enterprise Search. 

2. Select Release Documentation as the Source. 

http://support.deltek.com/
https://deltek.custhelp.com/app/home
https://deltek.custhelp.com/app/home
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3. Perform one of the following actions:  

 To see a list of all available documentation for a release, enter the product and 
release number (for example, Vision 7.6) in the search field. 

 To find a specific document, enter a description of the document (for example, Vision 
7.6 release notes) in the search field. 

4. Click on the document, then choose to open or save it. 

Problem Displaying Online Help in Internet Explorer 
If you use Internet Explorer and the help does not display correctly, you need to turn off 
Compatibility View for the browser. Click Tools » Compatibility View settings, and clear the 
Display intranet sites in Compatibility View check box. Then refresh the browser. You could 
also elect to use hosted help or the FQDN of your server in the URL (for example, server.domain) 
to bypass this issue. Make sure you remove deltek.com (if listed) from the Websites you've 
added to Compatibility View list. 
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Downloading Deltek Products Using Deltek 
Software Manager 
Use Deltek Software Manager (DSM) to download complete Deltek products, hot fixes, and sub-
releases. You can access DSM directly or through the Deltek Customer Care Connect site. 

When you access DSM directly, you are prompted to log on before you can access the 
application. If you access DSM from within the Deltek Customer Care Connect site, you do not 
have to log on since you are already logged in to the Customer Care Connect site. 

Access DSM Directly 
To access Deltek Software Manager directly: 

1. Launch Deltek Software Manager by taking one of the following actions: 

 Click here.  

 On your desktop, navigate to the Deltek programs folder and click Vision » Deltek 
Software Manager. 

2. In the Deltek Software Manager logon dialog box, enter your Deltek Customer Care User 
ID and Password, and click Logon. 

3. To select the folder where you want to download Deltek products, click Settings above 
the right pane of Deltek Software Manager. 

 

When you log on for the first time, Deltek Software Manager asks you to select a 
default folder where Deltek products are to be downloaded. 

4. Use the Settings dialog box to specify the folder where you want to download Deltek 
products, and click OK.  

 

You can change this folder anytime on the Settings dialog box. 

5. In the left pane of Deltek Software Manager, expand the Deltek product that you want to 
download, if it is not already expanded.  

 

If you clicked the link in Step 1 to access DSM, the application automatically selects 
Vision for you. 

6. Select the product type that you want to download. Your options are Complete, HotFix, 
and Sub-Release. 

7. In the table, select the check box that corresponds to the Deltek product that you want to 
download. The right pane displays a message stating that the product has been added to 
the download queue. 

 

To view the items in the download queue, click View Download Queue at the 
bottom of the left pane. 

https://dsm.deltek.com/DeltekSoftwareManager/DeltekSoftwareManager.application?ProductVersionID=00E6F14E-D68F-4C2D-BFD6-CEC7996C2A81
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8. Click Download at the bottom of the left pane. Deltek Software Manager downloads the 
product to the folder that you selected.  

Accessing DSM from within Deltek Customer Care Connect 
To access Deltek Software Manager from within Deltek Customer Care Connect: 

1. In your Web browser, go to http://support.deltek.com.  

2. Enter your Customer Care Connect Username and Password, and click Log In. 

3. When the Customer Care Connect site displays, click the Product Downloads tab. 

You are automatically logged in to Deltek Software Manager. 

4. To select the folder where you want to download Deltek products, click Settings above 
the right pane of Deltek Software Manager. 

When you log in for the first time, Deltek Software Manager asks you to select a default 
folder where Deltek products are to be downloaded. 

5. Use the Settings dialog box to specify the folder where you want to download Deltek 
products, and click OK. You can change this folder anytime on the Settings dialog box. 

6. In the left pane of Deltek Software Manager, expand the Deltek product that you want to 
download, if it is not already expanded.  

7. Select the product type that you want to download. Your options are Complete, 
Cumulative Updates, and Sub-Release. 

8. In the table, select the check box that corresponds to the Deltek product that you want to 
download. The right pane displays a message stating that the product has been added to 
the download queue. To view the items in the download queue, click View Download 
Queue at the bottom of the left pane. 

9. Click Download at the bottom of the left pane. Deltek Software Manager downloads the 
product to the folder that you selected.  

10. Proceed to the topic that describes the type of installation that you are performing. 

DSM Documentation and Troubleshooting 
Refer to the following links for additional information: 

 Deltek Software Manager online help 

 Deltek Software Manager tutorial  

 Troubleshooting Deltek Software Manager 

http://support.deltek.com/
https://dsm.deltek.com/DeltekSoftwareManager/Help/
https://dsm.deltek.com/DeltekSoftwareManager/Tutorial/PubData/Engine/Default.htm?https%3A%2F%2Fdsm.deltek.com%2FDeltekSoftwareManager%2FTutorial%2FPubData%2F
https://deltek.custhelp.com/app/answers/detail/a_id/52469
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Vision Installation Programs 

Download Manager 
The Vision installation uses a Download Manager tool embedded into the installer to manage the 
size of the installation download file. This tool is not the same as the Deltek Software Manager 
that is used to download the Vision installer. The Download Manager allows prerequisite third 
party applications and required additional Vision files to be downloaded and installed on the 
Vision tier only when necessary.  

 An example of a third-party application is the Solid PDF Converter.  

 Examples of additional Vision files are the Blank Database, the Sample Database, and 
the help files.  

These files are not part of the Vision download file but are called from a remote FTP server when 
they are required for successful completion of the installation. 

Internet Connectivity for Vision Tier? 
What you do next depends on whether your Vision tier has internet connectivity: 

 If your Vision tier has internet connectivity, proceed to the Preinstallation Checklists, 
which begin on page 16.  

 If your Vision tier does not have internet connectivity, see the procedures in this section 
for downloading your Vision installation and prerequisite files. 

Deltek Vision Install Prepare Utility 
Use the Deltek Vision Install Prepare Utility (DeltekVisionInstallPrepareUtility.exe) for the 
following scenarios: 

 The Vision Server does not have access to the internet. 

 Setup is unable to finish because the download manager is unable to download 
prerequisites needed for the installation to continue.  

The Deltek Vision Install Prepare Utility is a self-extracting tool that downloads the prerequisites 
needed for installation from a machine other than the installation server.  

The process is a combination of two steps: 

1. You extract the setup files from the DeltekVision76.exe file. 

2. You use the Deltek Vision Install Prepare Utility to download the files and place them in 
the extracted folder. 

When you are ready to install Vision, you launch the extracted setup.exe file and it automatically 
finds the downloaded files in the root of the folder where the setup.exe is located and does not try 
to download the prerequisites. 

File Extraction for Multi-Tier Deployments 
The Vision installer includes an extract option that lets you extract the setup.exe file, along with 
the rest of the installation package contents, to a central location that you can then use to launch 
the setup for multi-tier deployments. The most common reason for doing this is that the server on 
which you are performing the installation does not have access to the internet.   
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Use the Deltek Vision Install Prepare Utility to download the prerequisite components and copy 
them into the folder where the extracted setup files are located. When you launch the installer 
from the setup.exe extracted file, it looks for the missing components in the folder in which it is 
located. 

To extract the files manually: 

1. Download the DeltekVision76.exe installer. 

2. Copy the file to a local folder. 

3. At a DOS prompt, run the following command line:  

DeltekVision76.exe/extract_all:<drive>:\<destinationfolder> 

 /extract_all is the flag that tells the installer to extract the contents of the installation.  

 <drive>:\<destinationfolder> is the syntax for specifying the location to extract the 
contents of the installer. 

 The following example assumes that the DeltekVision76.exe file was downloaded 
and saved into a folder named C:\Media and will also be extracted into the same 
folder:  

DeltekVision76.exe /extract_all:c:\media 

 After the extraction is complete, the C:\Media folder will contain a Disk 1 subfolder.  

4. Copy any downloaded prerequisite files into the folder and launch the setup.exe file. 

Download Files and Place in Extracted Folder 

To use the Deltek Vision Install Prepare Utility: 

1. On a machine that has access to the Internet, perform the steps to extract the setup.exe 
and other Vision setup files.  

By default, the extracted files are created in a folder named Disk1 in the folder the 
command line specified for extracting the files. 

2. Obtain the DeltekVisioninstallPrepareUtility.exe file from a Vision Technical Services 
support representative. 

3. Launch the DeltekVisioninstallPrepareUtility.exe file on the same machine. It 
automatically extracts its contents into the folder in which you saved the .exe file. 

4. Change the Path to Save/Extract location to point to the Disk1 folder that was created 
when you ran the extract all switch. This extracts the files and allows download of the 
prerequisite components into the same folder in which the setup.exe file is located. 

5. In the Download all components for drop-down list, select the type of installation that 
you plan to perform The utility automatically selects the prerequisites required for the 
installation you have selected.  

6. Click the Download Components button to download the files into the Vision Setup 
folder. 

7. On the Vision web servers, follow the steps for your deployment model to run the 
extracted setup.exe file.  
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Before You Begin Deployment 

Logical Tiers Overview 
Vision uses a multitier architecture. Various components of the Vision application are distributed 
to logical tiers for performance and scalability. The logical tiers are as follows:  

 Client Tier — This is the user interface layer for Vision. It presents input data to the 
application/Web server tier and displays the returned result in a format that you can 
understand. The client tier is installed on a workstation. Vision uses the ClickOnce 
deployment technology, a technology for delivering Windows-based applications to the 
user. The Deltek Vision Smart Client application uses this technology to check for new 
updates on the Web/Application Server each time the application is launched, and 
automatically installs them into the local user’s profile (%USERPROFILE%\Local 
Settings\Apps\2.0\... ). 

 Web/Application Server Tier — This tier performs Vision’s functional process logic. 
After a request is sent by the client tier, this tier processes that request (such as 
retrieving stored data or performing a specific function) and then returns the result to the 
client tier. This tier also uses IIS to host the Vision applications.  

 Process Server Tier — This tier allows the user to schedule processes and profiles to 
run automatically in the background. Examples of processes that can run on the Process 
Server are the following: 

 All reports 

 All scheduled alerts 

 Large batch jobs (for example, billing, revenue generation) 

 Report Server Tier — This tier handles all Reporting requests. It uses Microsoft SQL 
Server Reporting Services. 

 Database Tier — This tier consists of SQL Server Database Server(s) where the Vision 
data is stored and retrieved.  

Logical Tier Model  
The following diagram provides information about the logical tiers and technologies utilized at 
each tier of a Deltek Vision deployment. Logical tiers do not necessarily require a separate 
physical server for each tier. In a single-server deployment model, each of the tiers below would 
be installed and configured on the single server. 
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Logical Tier Model with Reverse Proxy 
The diagram below displays how the IIS ARR Reverse Proxy has been implemented on a Web 
Server to serve as a proxy for handling requests to the Report Server to resolve the security 
issue.  

It contains the logical tiers and technologies utilized at each tier of a Deltek Vision deployment. 
Logical tiers do not necessarily require a separate physical server for each tier. 

This connection shows the 
requirement that the 
WinForms Report Viewer 
control has for direct 
communication to the report 
server web service. 

This diagram contains the logical tiers and 
technologies utilized at each tier of a Deltek Vision 
deployment. Logical tiers do not necessarily require 
a separate physical server for each tier. 

Deltek Vision WinForms client  
Microsoft Reporting services Windom Viewer 
(Deployed via ClickOnce) 
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Logical Tier Model with Three or More Servers 
The following diagram is an example of a three or more servers deployment model.  
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For load balancing of web servers, the sticky session feature (also known as session affinity) is 
required. 

Installation/Deployment Models 
You use one of three different models to deploy Vision. The model that you choose depends on 
your organization’s needs with regard to size, cost considerations, security requirements, and 
fault tolerance. The following table provides a summary of each model. 

Deployment 
Model 

Overview When Would I Use This Model? 

One-Server  
(Single Server) 

Install Vision tiers (web, 
application, process server, report 
components, and database) on the 
same machine.  

Infrastructure security is not a 
concern with this model because 
all application usage is internal to 
the organization. 

 Deployment needs are simple. 
For example, you are installing 
Vision on a test machine. 

 All users are at a single location 
and will only access Vision in the 
office or over a Virtual Private 
Network (VPN) connection to the 
corporate network. 

 Small organization (fewer than 50 
employees). 

Dual-Server  
(Two-Tier) 

Configuration 1 

Install the database and report 
components on a server machine 
and the Web/Application and 
Process Server components on a 
separate server machine. 

In this configuration the Vision 
client application needs a direct 
connection to the Report Server to 
run and view reports. 

Infrastructure security is not a 
concern with this model because 
all application usage is internal to 
the organization. 

 Your organization has one SQL 
Server license. 

 All users are at a single location 
and will only access Vision in the 
office or over a Virtual Private 
Network (VPN) connection into 
the corporate network. 

 Users are not accessing the 
application over the internet.  

 Since the Database server is also 
on the Report server, it is not 
suitable for use in an environment 
with users accessing the 
application over the Internet. 
Consider using the IIS ARR 
Reverse Proxy for the Web Server 
to serve as a proxy for handling 
requests to the Report Server to 
resolve the security issue. See the 
Deltek Vision Advanced Technical 
Administrator’s Guide for details. 

 Small to medium sized 
organization that may not have a 
technical staff. 
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Deployment 
Model 

Overview When Would I Use This Model? 

Dual-Server  
(Two-Tier) 

Configuration 2 

Install the database component on 
a server machine and the 
Web/Application, Process Server, 
and report components on a 
separate server machine. 

Reporting Services are installed on 
a server separate from the 
Database Engine. 

 Your organization has additional 
Microsoft SQL Server licenses 
and you split the Report Server 
(web service) from the Database 
Server hosting the Report Server 
database. 

 Users will access Vision over the 
internet. 

 Small to medium organization that 
may not have a technical staff. 

Three or More 
Servers 

Install any of the following: 

 A single Database Server 

 One or more Report Servers 

 One or more Web/Application 
servers 

 One or more Process 
Servers, each on its own 
machine 

 You have a large organization 
that has multiple locations, can 
afford multiple SQL Server 
licenses, and will use Vision on an 
internal Wide Area Network 
(WAN). 

 Allows for additional report 
web/application, or process 
servers for load balancing, 
performance, security, or fault 
tolerance reasons. 

 Organizations with complex 
deployment requirements and 
proficient firewall management. 

Changes to Vision Deployment Models for Vision 5.x and Prior Versions 

 

This section applies only to firms that are upgrading from Vision 5.x or a prior version. 

If your firm previously deployed a two tier deployment with the database server on one machine 
and the Web\Application\Report Tier on another machine, you now have the option of using either 
configuration 1 or configuration 2 in the preceding table for deploying a two-tier installation.  

 Your SQL Server Edition and purchased licenses determine your two-server deployment 
configuration.  

 SQL Server Express Edition requires that the report server database used by Reporting 
Services and any external data sources (Vision database) reside on the same machine. If 
you have either of these editions of SQL Server, your options for migrating to Vision will 
be either a single server deployment model or the Dual Server (Two-Tier) Configuration 1 
option of the two server deployment model.  

 Standard, Business Intelligence, and Enterprise Editions support having the Vision 
database on a separate database server than the server that hosts the Reporting 
Services Report Server Database. This will allow deployments on two or more tiers. For 
these editions, review the license information and links above to determine if you have 
the appropriate number of SQL Server licenses. 
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 Vision uses the Microsoft SQL Reporting Services WinForms report viewer control to 
render reports. This control requires a direct connection to the server running the SQL 
Reporting Services web service over Port 80. Your report server (and possibly your 
database server, if they are installed on the same machine) will be directly exposed to the 
internet, which poses a security risk to your data. It also requires an external FQDN so 
that the report server can be resolved by the external users. If your setup requires this 
configuration, using a reverse proxy on your web server will prevent a direct connection 
to the report server and minimize data exposure. A reverse proxy that uses Microsoft’s 
Application Request Routing (ARR) extension for IIS in Windows Server allows the direct 
forwarding of requests through the Vision web server to the reporting services web 
service, with responses back to your Internet clients.  

 

See the Deltek Vision Advanced Technical Administration Guide for more information. 

Installation Order: High-Level Overview 
To install Vision correctly, you must complete installation of the server roles in a specific order: 

1. Database Server tier 

You do not need to perform this installation if your database tier is on its own server 
unless you plan to restore the sample, a blank database, or use the Performance 
Management (Analysis Cubes) module. 

 Creates and configures a Vision SQL Server login account 

 Option to install a blank and/or sample database 

2. Report Server tier 

 Configures the Report Server with security settings required for Vision reporting 

3. Web/Application Server tier 

 Installs Vision 

 Loads the reports onto the Report Server 

 Option to upgrade an existing database 

4. Process Server tier 

 Option to specify a domain account\password if upgrading a previous installation that 
had a custom domain account running the Process Server service. 

What Type of Installation Am I Performing? 
Your Vision installation falls into one of the following categories: 

 Install Vision for the first time with a new database — Proceed with the one server, two 
server, or multiple server installation.  

 Install Vision for the first time on a new server with a supported version (or prior version) 
of the database — Proceed with the one server, two server, or multiple server installation. 

 Install or upgrade a server that already has Vision installed — See Installation Steps 
(Vision Upgrades). 
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 Install Vision for the first time and migrate from Deltek Advantage, Award, CRM and 
Proposals, or Sema4 — See Migrating From Deltek Legacy Products. 

Preinstallation Checklists 
This section includes a separate checklist for each of the following installation models: 

 Single Server 

 Dual-Server (Two Tier) Configuration 1 

 Dual-Server (Two Tier) Configuration 2 

 Three or More Servers 

 

For an overview of the logical tiers and deployment models, see: 

 Logical Tiers 

 Installation/Deployment Models 

Single-Server  

 

After installation, review the Web Server Post-Installation checklist. 

 
 
 
 

Step Related Topics 

1.  Verify that the server operating system is supported.  System Requirements 

2.  Verify that you have at least 2 GB of disk space 
available for this installation. 

 

3.  Verify that the user account performing the 
installation is a member of the local Windows System 
Administrators group. 

 

4.  Verify that your SQL Server Database Engine and 
Reporting Services installations meet the system 
requirements. 

 Database Server 

5.  Verify that the user account performing the 
installation is a member of the SYADMIN role in SQL 
Server security settings, or make sure that you have 
valid SQL Server credentials available for use during 
the installation. 

 

6.  Use SQL Server Configuration manager to ensure 
that the "TCP/IP" and "Shared Memory" protocols are 
enabled. 

 External link: Enable or Disable a 
Server Network Protocol (SQL Server 
Configuration Manager)  

7.  Install Microsoft .NET Framework.  .NET Architecture 

8.  Install Microsoft Internet Information Services (IIS)  
with ASP .NET enabled. 

 Microsoft Internet Information Server 
(IIS) Installation on Windows Server  

http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
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Step Related Topics 

9.  Configure Reporting Services with native mode.  Microsoft SQL Server Reporting 
Services 

 Printing in Vision 

Includes configuring printing to network 
printers for Vision batch jobs after Vision is 
installed. 

If Reporting Services is already configured, you will 
need to know the Web Service URL and the name of 
the Report Server databases.  

 How to Connect to the Report Service 
Web Service 

10.  Verify that the user account has the proper rights and 
privileges in Reporting Services. 

 How to Give Your Account Proper 
Rights and Privileges in Reporting 
Services 

11.  If you experience connection errors to SQL Reporting 
Services and have verified the previous steps, check 
that access is not being blocked by Windows or your 
firewall. 

 External link: Configure a Firewall for 
Report Server Access  

 External link: Configure a Windows 
Firewall for Database Engine Access 

http://msdn.microsoft.com/en-us/library/bb934283.aspx
http://msdn.microsoft.com/en-us/library/bb934283.aspx
http://msdn.microsoft.com/en-us/library/ms175043.aspx
http://msdn.microsoft.com/en-us/library/ms175043.aspx
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Dual-Server (Two-Tier) Configuration 1 

Database and Report Tier 

Deltek recommends that you install the Database Server first because the Database and Report 
Server tiers are on the same machine. You must perform this step before you install Vision on 
your Vision Web Server. 
 
 

Step  Related Topics 

1.  Verify that the server operating system is supported.  System Requirements 

2.  Verify that you have at least 2 GB of disk space 
available for this installation. 

 

3.  Verify that the user account performing the 
installation is a member of the local Windows System 
Administrators group. 

 

4.  Verify that your SQL Server Database Engine and 
Reporting Services installations meet the system 
requirements. 

 System Requirements 

5.  Verify that the user account performing the 
installation is a member of the SYADMIN role in SQL 
Server security settings, or make sure that you have 
valid SQL Server credentials available for use during 
the installation.  

 

6.  Use SQL Server Configuration manager to ensure 
that the "TCP/IP" and "Shared Memory" protocols are 
enabled on your report server and database server. 

 External link: Enable or Disable a 
Server Network Protocol (SQL Server 
Configuration Manager)  

7.  Configure Reporting Services with native mode. 
 

 Microsoft SQL Server Reporting 
Services_Appendix_B:_Microsoft 

 Printing in Vision 

Includes configuring printing to network 
printers for Vision batch jobs after Vision is 
installed. 

If Reporting Services is already configured, you will 
need to know the Web Service URL and the name of 
the Report Server databases.  

 How to Connect to the Report Service 
Web Service 

8.  Verify that the user account performing the 
installation has the proper rights and privileges in 
Reporting Services. 

 How to Give Your Account Proper 
Rights and Privileges in Reporting 
Services 

9.  If you experience connection errors to your database 
or report server and have verified the previous steps, 
check that access is not being blocked by Windows 
or your firewall. 

 External link: Configure a Firewall for 
Report Server Access  

 External link: Configure a Windows 
Firewall for Database Engine Access 

http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/bb934283.aspx
http://msdn.microsoft.com/en-us/library/bb934283.aspx
http://msdn.microsoft.com/en-us/library/ms175043.aspx
http://msdn.microsoft.com/en-us/library/ms175043.aspx
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Web Application and Process Server Tier 

 

After installation, review the Web Server Post-Installation checklist. 

 

Step Related Topics 

1.  Verify that the server operating system is supported.  System Requirements 

2.  Verify that you have at least 2 GB of disk space 
available for this installation. 

 

3.  Install Microsoft .NET Framework.  .NET Architecture 

4.  Install Microsoft Internet Information Services (IIS)  
with ASP .NET enabled. 

 Microsoft Internet Information Server 
(IIS) Installation on Windows Server 

5.  Verify that the user account performing the installation 
has the proper account credentials as stated in the 
database and report tier steps. 

 

6.  Ensure that you have the following information prior to 
starting your installation: 

 Database Server\SQL instance name 

 Report Server database names 

 Report Server Web Service URL 

 Database System Requirements 
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Dual-Server (Two-Tier) Configuration 2 

Database Tier 

Deltek recommends that you install the Database Server first. If you prefer to install the other tiers 
first, the setup for the other tiers will require that you know the Database Server host name or IP 
address, and have the Microsoft SQL Server user name and password. 
 
 

Step Related Topics 

1.  Verify that the server operating system is supported.  System Requirements 

2.  Verify that you have at least 2 GB of disk space 
available for this installation. 

 

3.  Verify that the user account performing the 
installation is a member of the local Windows System 
Administrators group. 

 

4.  Verify that your SQL Server Database Engine and 
Reporting Services installations meet the system 
requirements. 

 System Requirements 

5.  Verify that the user account performing the 
installation is a member of the SYADMIN role in SQL 
Server security settings, or make sure that you have 
valid SQL Server credentials available for use during 
the installation. 

 

6.  Use SQL Server Configuration manager to ensure 
that the "TCP/IP" and "Shared Memory" protocols are 
enabled on your report server and database server. 

 External link: Enable or Disable a 
Server Network Protocol (SQL Server 
Configuration Manager)  

7.  If you experience connection errors to your database 
and have verified the previous steps, check that 
access is not being blocked by Windows or your 
firewall. 

 External link: Configure a Windows 
Firewall for Database Engine Access 

Web Application and Report Tier 

 

After installation, review the Web Server Post-Installation checklist. 

 

Step Related Topics 

1.  Verify that the server operating system is supported.  System Requirements 

2.  Verify that you have at least 2 GB of disk space 
available for this installation. 

 

3.  Install Microsoft .NET Framework.  .NET Architecture 

4.  Install Microsoft Internet Information Services (IIS)  
with ASP .NET enabled. 

 Microsoft Internet Information Server 
(IIS) Installation on Windows Server 

5.  Ensure that you have the SQL Server username and 
password that you created for Reporting Services. 

 Prerequisite Report Server and 

http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms175043.aspx
http://msdn.microsoft.com/en-us/library/ms175043.aspx
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Step Related Topics 

SQL Server Database Credentials 

6.  Configure Reporting Services with native mode. 
 

 Microsoft SQL Server Reporting 
Services 

 Printing in Vision 

Includes configuring printing to network 
printers for Vision batch jobs after Vision is 
installed. 

If Reporting Services is already configured, you will 
need to know the Web Service URL and the name of 
the Report Server databases.  

 How to Connect to the Report Service 
Web Service 

7.  Verify that the user account has the proper rights and 
privileges in Reporting Services. 

 How to Give Your Account Proper 
Rights and Privileges in Reporting 
Services 

8.  Verify that the user account performing the installation 
is a member of the SYADMIN role in SQL Server 
security settings. 

 

9.  Verify that your SQL Server Reporting Services 
installation meets the system requirements. 

 System Requirements 

10.  Use SQL Server Configuration manager to ensure 
that the "TCP/IP" and "Shared Memory" protocols are 
enabled on your report server and database server. 

 External link: Enable or Disable a 
Server Network Protocol (SQL Server 
Configuration Manager)  

11.  If you experience connection errors to your database 
or report server and have verified the previous steps, 
check that access is not being blocked by Windows or 
your firewall. 

 External link: Configure a Firewall for 
Report Server Access  

 External link: Configure a Windows 
Firewall for Database Engine Access 

http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/bb934283.aspx
http://msdn.microsoft.com/en-us/library/bb934283.aspx
http://msdn.microsoft.com/en-us/library/ms175043.aspx
http://msdn.microsoft.com/en-us/library/ms175043.aspx
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Three or More Servers  

Database Tier 

Deltek recommends that you install the Database Server first. You must perform this step before 
you install Vision on your Vision Web Server. If you prefer to install the other tiers first, the setup 
for the other tiers will require that you know the Database Server host name or IP address, and 
have the Microsoft SQL Server user name and password. 
 
 

Step Related Topics 

1.  Verify that the server operating system is supported.  System Requirements 

2.  Verify that you have at least 2 GB of disk space 
available for this installation. 

 

3.  Verify that the user account performing the 
installation is a member of the local Windows System 
Administrators group. 

 

4.  Verify that your SQL Server Database Engine and 
Reporting Services installations meet the system 
requirements. 

 System Requirements 

5.  Verify that the user account performing the 
installation is a member of the SYADMIN role in SQL 
Server security settings, or make sure that you have 
valid SQL Server credentials available for use during 
the installation. 

 

6.  Use SQL Server Configuration manager to ensure 
that the "TCP/IP" and "Shared Memory" protocols are 
enabled on your report server and database server. 

 External link: Enable or Disable a 
Server Network Protocol (SQL Server 
Configuration Manager)  

7.  If you experience connection errors to your database 
and have verified the previous steps, check that 
access is not being blocked by Windows or your 
firewall. 

 External link: Configure a Windows 
Firewall for Database Engine Access 

Report Tier 

You must perform this step before you install Vision on your Vision Web Server. 

Step Related Topics 

1.  Verify that the server operating system is supported.  System Requirements 

2.  Verify that you have at least 2 GB of disk space 
available for this installation. 

 

3.  Verify that the user account performing the installation 
is a member of the local Windows System 
Administrators group. 

 

4.  Verify that the user account has the proper rights and 
privileges in Reporting Services. 

 How to Give Your Account Proper 
Rights and Privileges in Reporting 
Services 

5.  Verify that the user account performing the installation  

http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms175043.aspx
http://msdn.microsoft.com/en-us/library/ms175043.aspx
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Step Related Topics 

is a member of the SYADMIN role in SQL Server 
security settings. 

6.  Verify that your SQL Server Database Engine and 
Reporting Services installations meet requirements. 

 System Requirements 

7.  Use SQL Server Configuration manager to ensure 
that the "TCP/IP" and "Shared Memory" protocols are 
enabled on your report server and database server. 

 External link: Enable or Disable a 
Server Network Protocol (SQL Server 
Configuration Manager)  

8.  Configure Reporting Services with native mode. 
 

 Microsoft SQL Server Reporting 
Services 

 Printing in Vision 

Includes configuring printing to network 
printers for Vision batch jobs after Vision is 
installed. 

If Reporting Services is already configured, you will 
need to know the Web Service URL and the name of 
the Report Server databases.  

 How to Connect to the Report Service 
Web Service 

9.  If you experience connection errors to your report 
server and have verified the previous steps, check 
that access is not being blocked by Windows or your 
firewall. 

 External link: Configure a Firewall for 
Report Server Access  

Web / Application Tier 

 

After installation, review the Web Server Post-Installation checklist. 

 

Step Related Topics 

1.  Verify that the server operating system is supported.  System Requirements 

2.  Verify that you have at least 2 GB of disk space 
available for this installation. 

 

3.  Install Microsoft .NET Framework.  .NET Architecture 

4.  Install Microsoft Internet Information Services (IIS)  
with ASP .NET enabled. 

 Microsoft Internet Information Server 
(IIS) Installation on Windows Server 

5.  Verify that the user account performing the installation 
has the proper account credentials as stated in the 
database and report tier steps. 

 

6.  Ensure that you have the following information prior to 
starting your installation: 

 Database Server\SQL instance name 
 Report Server database names 
 Report Server Web Service URL 

 Database System Requirements 

7.  Note the Vision installation location on your web 
server. You will need this information for the Process 

 

http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/bb934283.aspx
http://msdn.microsoft.com/en-us/library/bb934283.aspx
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Step Related Topics 

Server tier. 

Process Server Tier 

 

After installation, review the Dedicated Process Server Post-Installation checklist. 

 

Step Related Topics 

1.  Verify that the server operating system is supported.  System Requirements 

2.  Verify that you have at least 2 GB of disk space 
available for this installation. 

 

3.  Install Microsoft .NET Framework.  .NET Architecture 

4.  Verify the location (path) of the existing 
databases.enc file on your web server. During the 
installation, you will need to provide this information.  
The default location of this file is: C:\Program 
Files\Deltek\Vision\.  
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Post-Installation Checklist (New Installations) 
Web Server 

Steps 

1.  Set the WebLink password on the Web Server using the Vision Start menu WebLink shortcut. 

2.  In WebLink, click the System Settings tab and review the Polling Interval and Max Concurrent 
Jobs field settings to confirm that they meet your needs.  

3.  Use the same domain account to support server-side printing to domain printers.  

a. In WebLink, configure the Report Server tab. 

b. In IIS, configure the Application Pool Identity settings.  
For more information, see Server-Side Printing to Domain Printers in Appendix D. 

4.  If you have a dedicated Process Server machine: 

a. On the Web Server, navigate to Control Panel » Administrative Tools and disable the 
Deltek Vision Process Server service. 

b. Launch Vision, add the name of the process server, and then assign queues to the server 
that you inserted. 

1. Click Configuration » System Settings. 
2. On the Servers tab, add the name of your Process Server. 
3. Assign the process queues to that Process Server.  

5.   For new installations, perform the Post Installation steps. 

 For upgrade installations, review the Installation Steps (Vision Upgrades) section. 

 

 

Deltek recommends that the total of all of the process queues (per server) does not exceed the 
number in the Max Concurrent Jobs field.  

You set the process queue maximum in Vision (Configuration » General » System Settings 
» Servers tab » Process Queues grid » Max field).  

If the total of all of your process queues (per server) exceeds the number in the Max 
Concurrent Jobs field, only the number of jobs as specified in the Max Concurrent Jobs field 
will run concurrently. If you run too many concurrent jobs, you will add load to your Database 
Server and/or Report Server. 

Dedicated Process Server 
Refer to Step 2 of the Web Server post-installation checklist above to add and configure dedicated 
process servers in Vision. 

Additional/Optional Modules 
Vision is a prerequisite for certain additional or optional modules. Install these modules before deploying 
Vision to the end users. 
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Client Tier (Workstation) 
Steps 

1.  Supply Vision users with the Vision URL.  

Replace servername in the URL with your server name (http://servername/visionclient). 

2.  When you launch Vision, the credentials for new / sample databases are:  
Username: ADMIN 
Password: <no password> 

http://servername/visionclient
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Post-Installation Checklist (Upgrades) 
Web Server 

Steps 

1.  Verify that the databases.enc file was copied over from the previous installation. 

2.  Verify that the web.config file was copied over from the previous installation. 

3.  Verify that unused values are commented out in the web.config file. 

4.  Verify that the DeltekVisionAppPool (or custom application pool) has the following settings: 
 .NET CLR Version: v4.0. 

 Enable 32-bit Applications: False  

5.  Verify the physical paths for the Vision and VisionClient virtual directories. 

6.  Verify that you can view VisionServices (http://localhost/Vision/VisionServices.asmx). 

7.  Verify that you can launch and run WebLink. 

8.  Verify that you can launch and run Vision. 

9.  If you have a dedicated Process Server machine: 
Perform these steps only if you had previously applied any custom web.config settings to customize 
Process Server behavior. 

a. Launch Vision. 
b. Verify that the custom web.config settings were applied during the installation.  

For example, perform these steps if you have custom settings for the number of emails 
being sent at a time (EmailChunkSize) or the maximum size of an email 
(MaxEmailSize): 

1. Click Configuration » System Settings » Email Tab. 
2. Verify or update the Email Size Limit (Megabytes) setting. 
3. Verify or update the Number of Emails to Send at Once setting. 

10.  Verify that the Process Server Windows Service is running. 

11.  If you performed an in-place upgrade and entered bypass when prompted for the process server 
service identity password, you must update the identity with the correct password or the service will 
not start. 

Dedicated Process Server 
Refer to Steps 9, 10, and 11 of the Web Server Post-installation Checklist (Upgrades) to add and 
configure dedicated process servers in Vision. 
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System Requirements 

Platform Virtualization  
Virtual environment software, such as VMware®, resides in the hardware layer underneath the 
operating system and is used to partition a single server into a multiple server/multiple operating 
system environment. Deltek’s product development makes limited use of virtual environments.  

 

See the Virtual Environments Statement document on the Deltek Customer Care Connect site 
(http://support.deltek.com) for more information. 

Software Requirements 
Some parts of the Vision application are distributed to logical tiers for performance, scalability, 
and security purposes. These logical tiers are distinct technologies required to run Vision, such as 
Report Server software or Web server software. They may or may not be hosted on the same 
machine. The method that you use to distribute Vision’s logical tiers across physical tiers or 
actual machines depends on your organization’s needs.  

The software requirements for each logical tier are listed in the tables later in this section. 

Supported Versions, Compatible Versions 
Supported versions are the most current, actively tested technologies used to deploy Vision.  

Compatible versions are recent technologies that have been tested for deploying Vision; 
however, these are not actively being tested but are believed to be compatible with Vision.  

 

See the Deltek Product Support Compatibility Matrix document on the Deltek Customer Care 
Connect site (http://support.deltek.com) for more information. 

Display Settings for All Servers 
The Deltek Product installation is created using Flexera's InstallShield, which requires the color 
display depth on the server (via the console or through a remote desktop session) to be greater 
than 256.  

If the color display depth is set to 256 or lower, the following error displays when you try to launch 
the installer: 

Error Number: 0x80004005 

Description: Unspecified error 

Setup will now terminate. 

The following Microsoft TechNet link provides steps for setting the values for Remote Desktop 
Sessions: http://technet.microsoft.com/en-us/library/cc753755.aspx. 

http://support.deltek.com/
http://support.deltek.com/
http://technet.microsoft.com/en-us/library/cc753755.aspx
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Database Server 

 

64-bit (x64) Database Server supported. 

 

Supported Deployment Technology 

The supported minimum software requirements for a complete installation of Deltek Vision 
Database Tier with Microsoft SQL Server include: 

Operating System 

 Windows Server 2012 R2  
 Windows Server 2012 

Database Platform 

 The Microsoft SQL Server Database Engine and Reporting Services (64-bit) supported 
versions: 
 Standard, Business Intelligence, and Enterprise editions 

 Express Edition with Advanced Services 

 Microsoft SQL Server 2014 SP1 + CU6 (build (12.0.4457) 
 Microsoft SQL Server 2012 SP3 + CU3 (build 11.00.6537) 

 

For more information, see Links to Recommended Microsoft SQL Server Service Packs and 
Cumulative Updates. 

Other 

 Microsoft SQL Server Database Login  
 The SQL Server Login Account used by Vision in WebLink should use English as the 

Default Language 
 Microsoft .NET Framework 4.6.1 
 Microsoft .NET Framework 4.5.2  
 Microsoft SQLXML 4.0 (SP1) — Embedded with installation 

Database Compatibility Level 

 SQL Server 2014 (120) 
 SQL Server 2012 (110) 

 

Compatible Deployment Technology 

Operating Systems 

Database Platform 

 Microsoft SQL Server 2014 SP1+CU1 (build 12.0.4416.0) 
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Compatible Deployment Technology 

 Microsoft SQL Server 2012 SP3 (build 11.0.6020.0) 

 Microsoft SQL Server 2012 SP2+CU6 (build 11.0.5592.0) 

Report Server (Microsoft SQL Reporting Services) 

 

 64-bit (x64) Report Server supported. 

 Microsoft SQL Server Reporting Services are supported in Native Mode configuration 
only. The SharePoint Integrated Mode is not supported. 

 Deltek recommends the “simple” recovery model for your Report Server database unless 
you are doing transaction log backups. If you leave the recovery model at FULL and do 
not back up the transaction log regularly, you risk allowing the database to grow until the 
log file consumes all available free space on the drive where it is stored, rendering the 
database and possibly the server unusable. For more information, see 
https://msdn.microsoft.com/en-us/library/ms189275(v=sql.120).aspx 

 

Supported Deployment Technology 

The supported minimum software requirements for a complete installation of Deltek Vision 
Report Server Tier with Microsoft SQL Server include: 

Operating System 

 Windows Server 2012 R2  
 Windows Server 2012  

Report Server 

 The Microsoft SQL Server Database Engine and Reporting Services (64-bit only) 
supported versions: 
 Standard, Business Intelligence, and Enterprise editions 

 Express Edition with Advanced Services 

 Microsoft SQL Server 2014 SP1 + CU1 (build 12.0.4416.0) 
 Microsoft SQL Server 2012 SP2 + CU6 (build 11.0.5592.0) 

 

For more information, see Links to Recommended Microsoft SQL Server Service Packs and 
Cumulative Updates. 

 

 If Reporting Services is not already configured, refer to the steps in How to Configure 
Microsoft SQL Server Reporting Services in Appendix C. 

 You must know the Report Server Virtual Directory and database names in order to 
answer the prompts from the installation when it tries to connect to the Report Server.  

 If Reporting Services is configured but you are not sure how to obtain this information, 
refer to How to Connect to the Report Server Web Service in Appendix C for all the 
steps on how to obtain that information. 

https://msdn.microsoft.com/en-us/library/ms189275(v=sql.120).aspx
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Supported Deployment Technology 

Other 

 Microsoft .NET Framework 4.6.1 
 Microsoft .NET Framework 4.5.2 

 

Compatible Deployment Technology 

Report Server 

 Microsoft SQL Server 2014 SP1+CU1 (build 12.0.4416.0) 

 Microsoft SQL Server 2012 SP3 (build 11.0.6020.0) 

 Microsoft SQL Server 2012 SP2+CU6 (build 11.0.5592.0) 

Web/Application Server 

Supported Deployment Technology 

The supported minimum software requirements for a complete installation of Deltek Vision 
Web/Application Tier include: 

Operating System 

 Windows Server 2012 R2, with Microsoft Internet Information Services (IIS) 8.5 Role 
enabled 

 Windows Server 2012, with Microsoft Internet Information Services (IIS) 8.0 Role 
enabled 

Other 

 Microsoft .NET Framework 4.6.1 
 Microsoft .NET Framework 4.5.2 
 Solid Documents (.NET) (Vision installs this if it is not detected during installation) 

 

Vision does not support using any non-server operating system for production server 
installation. 

 

Process Server 

Supported Deployment Technology 

The supported minimum software requirements for a complete installation of the Deltek Vision 
Process Tier include: 

Operating System 

 Windows Server 2012 R2  
 Windows Server 2012 
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Supported Deployment Technology 

 

Other 

 Microsoft .NET Framework 4.6.1 
 Microsoft .NET Framework 4.5.2 
 Solid Documents (.NET) (Vision installs it if not detected during installation) 

Client Software Requirements 

Supported Deployment Technology 

Client Operating System 

 Windows 10 32-bit (x86) or 64-bit (x64) 
 Windows 8.1 32-bit (x86) or 64-bit (x64) 
 Windows 8 32-bit (x86) or 64-bit (x64) 
 Windows 7 32-bit (x86) or 64-bit (x64) 

 

Vision does not support using any non-server operating system for production server 
installation. 

Web Browsers 

 Microsoft Edge Browser 
 Internet Explorer 11 

Business Applications 

 Microsoft Office 2013 32-bit and 64-bit version 
 Microsoft Office 2010 32-bit version 
 Microsoft Project 2013 32-bit version 
 Microsoft Office 365 is supported but requires the full product installation 
 Adobe Reader 9.0 or higher (for exporting reports in PDF format) 

Other 

 Microsoft .NET Framework 4.6.1 
 Microsoft .NET Framework 4.5.2 

 

Compatible Deployment Technology 

Business Applications 

 Adobe Reader 8.0 or higher (for exporting reports in PDF format) 
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Database Requirements 
A Microsoft SQL Server database engine is required to run Vision. The Microsoft SQL Server 
edition that you choose to deploy with Vision depends on a number of factors, such as the size of 
your database and the number of employees actively using the application, which can impact 
database server performance.  

 For firms with fewer than 50 employees, Vision supports Microsoft SQL Server Express 
Edition with Advanced Services, which has a database size limitation of 10 GB, 1 GB 
maximum utilized RAM, and is limited to the lesser of 1 CPU socket or four cores. See 
this Microsoft article to learn about other limitations of this edition: 
https://msdn.microsoft.com/en-us/library/cc645993(v=sql.120).aspx   

 For firms with more than 50 employees, Vision supports Microsoft SQL Server Standard, 
Business Intelligence (BI), or Enterprise Edition. 

The machine on which you install Microsoft SQL Server depends on your firm’s deployment 
model. 

SQL Server Considerations  

SQL Server Standard, Business Intelligence (BI), or Enterprise Edition 
 If you decide to split the Report Server (web service) from the database server hosting 

the report server database, you need an additional Microsoft SQL Server license.  

 Report Server scale-out deployment is only available in Microsoft SQL Server Business 
Intelligence or Enterprise Edition. A scale-out deployment refers to an installation 
configuration that has multiple report server instances sharing a single report server 
database. 

 The following Microsoft link lists the features supported by the different editions of 
Microsoft SQL Server. Click Other Versions and select the version that you are using: 

https://msdn.microsoft.com/en-us/library/cc645993(v=sql.120).aspx 

SQL Server Express Edition with Advanced Services 
Owners of SQL Server Express Edition with Advanced Services (SQL Server Express) should 
note the following: 

 The report server database must be hosted on the local machine running the SQL Server 
Database Engine instance. You cannot use a remote SQL Server instance to host the 
report server database. 

 Data sources used in a report must also be SQL Server databases that run on the local 
machine running the SQL Server Database Engine instance. You cannot use remote 
data sources or other data source types. To use additional data source types, you must 
use a different edition of Reporting Services. This means that your Vision database must 
reside on the same machine where your report server databases reside. 

 You will either use the Single Server Deployment Model or Configuration 1 of the Two 
Server Deployment Model. 

 

See Appendix B: Microsoft SQL Server Edition and Version Information for information about 
downloading the latest version. 

https://msdn.microsoft.com/en-us/library/cc645993(v=sql.120).aspx
https://msdn.microsoft.com/en-us/library/cc645993(v=sql.120).aspx
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Deltek MSDE/SQL Express Management Console 

Deltek no longer ships the MSDE/SQL Express Management Console because the SQL Server 
Management Studio is now included with the SQL Express installations. Although the SQL 
Express Edition does not provide a way to schedule the automatic maintenance and backup of 
your database, Microsoft has provided documentation and Open Source tools for creating a 
scheduled backup and maintenance plan for SQL Express. The links below provide the details for 
performing those activities. Refer to these sites for guidance on implementing these tools in your 
environment. 

Database Maintenance Activities 

The Microsoft hosted Open Source Project site (www.codeplex.com) provides a Project/Tool for 
SQL Express users named ExpressMaint (http://expressmaint.codeplex.com/) that you can use 
to create maintenance plans. This project maintains two utilities for automating the backup and 
maintenance of databases for prior and current SQL Server Express Edition releases. They are 
based on the sqlmaint application that shipped with SQL Server 2000, but were updated to 
support current released versions. 

Microsoft provides basic documentation for manually creating a Windows scheduled task to work 
with SQL Stored Procedures for automating daily backups:   

 “How to Schedule and Automate Backups of SQL Server Databases in SQL Server 
Express” at http://support.microsoft.com/kb/2019698  

The site below is referenced by several SQL Server resource websites and by the SQLPass 
community. It provides details on automating the steps for maintaining your database using SQL 
Express: 

 “SQL Server Backup, Integrity Check, and Index and Statistics Maintenance” at 
http://ola.hallengren.com/  

Recommended Daily Activities 
Deltek recommends completing the following activities on your database daily: 

1. Check database integrity  

2. Rebuild indexes (doing this daily is not required, but it should be done at regular 
intervals) 

3. Update statistics 

4. Make a complete backup 

SQL Server Express Edition Requirement 
If you are implementing SQL Server Express Edition, Deltek requires that you use SQL Server 
Express Edition with Advanced Services as the database and report server for your Vision 
implementation because it contains the Database Engine and Reporting Services required for 
managing the database and running reports. The other SQL Express Edition installers do not 
have all the components needed to support Deltek Vision. 

Storing Vision Data in a Microsoft SQL Server Database 
 The installer creates a Microsoft SQL Server logon account used for the Vision database. 

The account requires the db_owner database role membership in the Login Properties 
and User Mapping dialog box for the following databases:  

 Vision database 

http://www.codeplex.com/
http://expressmaint.codeplex.com/
http://support.microsoft.com/kb/2019698
http://ola.hallengren.com/
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 ReportServer and ReportServerTempDB databases 

 

For more information and guidance on configuring rights, see How to Give Your 
Account Proper Rights and Privileges in Reporting Services in Appendix C. 

 Enable the "TCP/IP" and "Shared Memory" Network Protocols in SQL Server 
Configuration Manager on the Microsoft SQL Server. All network protocols are installed 
by SQL Server Setup, but may or may not be enabled. Use SQL Server Configuration 
Manager to enable "TCP/IP" and "Shared Memory" to allow Vision to connect to the 
database.  

 

For details, see the article on Microsoft's website titled How to: Enable or Disable a 
Server Network Protocol (SQL Server Configuration Manager) — 
http://msdn.microsoft.com/en-us/library/ms191294.aspx. 

 Verify the name of your SQL Server Instance. The default installation uses the Server 
Name for the connection and installs as an instance named SSQLSERVER.  Sometimes, 
Microsoft SQL Server is installed using an instance name other than the default 
(MSSQLSERVER). The SQL Server Express Edition installer from Microsoft installs as 
the named instance SQLEXPRESS.  

 

 When connecting to the Default SQL Server Database Engine instance, you use 
the name of your Database server. SQL Server automatically maps the Default 
Instance of the Database Engine to the Server Name when accepting 
connections. 

 When connecting to a named instance of SQL Server Database Engine, you must 
specify the name of the SQL Server plus the instance in the connection in the 
format of SERVERNAME\INSTANCENAME. 

For example, if your SQL Server is named SQLSERVER1 and you installed to an 
instance named SQLExpress, you would specify the server connection 
information in the format of SQLSERVER1\SQLExpress. 

 If you do not know the name of your SQL Server Instance or you are unable to connect to 
your database server after installation, see the article on Microsoft's website titled How to: 
Determine Whether the Database Engine Is Installed and Started: 
http://msdn.microsoft.com/en-us/library/ms366339.aspx.  

 Vision supports both SQL Server authentication modes: Windows Authentication Only 
mode or SQL Server and Windows Authentication mode (also known as "Mixed 
Mode").  

Mixed Mode is required for new installations. If you are unable to connect to your SQL 
Database Server and you have already performed the steps in the first two bullets, you 
should verify that the SQL Server security settings are properly configured.  

 

See the following Microsoft Article for details: https://msdn.microsoft.com/en-
us/library/ms188670(v=sql.120).aspx.  

 If you experience connection errors to your database or report server and have verified 
the previous steps, verify that Windows (or your) firewall is not blocking access to the 
SQL Server Database Engine and Reporting Services.   

http://msdn.microsoft.com/en-us/library/ms191294.aspx
http://msdn.microsoft.com/en-us/library/ms366339.aspx
https://msdn.microsoft.com/en-us/library/ms188670(v=sql.120).aspx
https://msdn.microsoft.com/en-us/library/ms188670(v=sql.120).aspx
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See the following Microsoft links for detailed steps: 

How to: Configure a Firewall for Report Server Access at 
http://msdn.microsoft.com/en-us/library/bb934283.aspx 

How to: Configure a Windows Firewall for Database Engine Access at 
http://msdn.microsoft.com/en-us/library/ms175043.aspx 

Technical Considerations 

Unsupported Environments 
The following are non-supported environments for Vision: 

 Vision cannot be installed side by side on the same Web/application or report servers as 
any previous version.  

 You cannot perform a Single Server deployment on the Microsoft Small Business Server. 
Only the Vision database tier or report tier can be installed on this server. 

 You cannot install any Vision tier on: 

 The Microsoft ISA/TMG server, or any other software-based firewall (except Windows 
firewall) 

 A Domain Controller 

 Any version of Microsoft Exchange Server 

 Any server with Microsoft Terminal Services (Application Mode Only) running, or if 
the server is configured as a Remote Desktop Session Host Server. Terminal 
Services in remote administration is fully supported. 

 Any version of SharePoint Server. 

(You can install the Document Management module on the SharePoint Server. See 
the Deltek Vision Document Management Guide for information). 

.NET Architecture  
Vision’s server-side architecture uses Microsoft’s .NET framework. .NET is Microsoft’s name for a 
set of software technologies developed to connect information, people, systems, and devices.  

 

See http://www.microsoft.com/net/ for more information. 

.NET allows Deltek developers and your in-house IT staff to extend Vision's workflow capabilities 
by calling outside Web services from within Vision. For example, you may send real-time, 
updated project information from Vision to an external collaboration web site so that your clients 
can view current project information.  

The .NET framework makes it possible for you to develop applications that integrate with Vision, 
call Web services from within Vision, and communicate with Vision through mobile devices.  

Deltek’s main client application is deployed using the ClickOnce technology, which requires 
Microsoft .NET Framework 4.5.2.  

You can download Microsoft .NET Framework 4.5.2 from this link: 

http://www.microsoft.com/en-gb/download/details.aspx?id=42642  

http://msdn.microsoft.com/en-us/library/bb934283.aspx
http://msdn.microsoft.com/en-us/library/ms175043.aspx
http://www.microsoft.com/net/
http://www.microsoft.com/en-gb/download/details.aspx?id=42642
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Multiple Languages 
Vision allows you to install a blank Vision database in a selected language on your database 
server.  

 New Installations — If you are installing Vision for the first time, the installation routine 
includes a step in which you select the language database version that you want to use 
for the installation. The database that you select determines the language that 
subsequently displays in the Vision application user interface. 

 Language Options — The Vision client deployment includes options for selecting the 
following language databases when you run the application:  

 English (United States or International) 

 France (Canada or France) 

 Spanish 

 Dutch (Netherlands) 

 Portuguese (Brazil) 

 German 
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Permissions Required for Installing Vision 
When performing the Vision installation, there are several rights and privileges required for the 
person performing the installations on the server tiers. 

Tier Permissions Required 

Web/Application 
Tier 

 The Windows account of the person performing the installation must be a 
member of the Local Administrator group on the server. 

 The Windows account of the person performing the installation must be a 
member of the System Administrator group and Content Manager Roles in 
SQL Server Reporting Services on the Report Server.  

 

For more information, see How to Give Your Account Proper 
Rights and Privileges in Reporting Services in Appendix C. 

 The person performing the installation must have/know the credentials of the 
user account created in the database as specified in the Database 
Requirements section. This is the Database user rights that the installation 
will require when it displays the database platform connection information. 

Process Server 
Tier 

 The Windows account of the person performing the installation must be a 
member of the Local Administrator group on the server. 

Report Server 
Tier 

 The Windows account of the person performing the installation must be a 
member of the Local Administrator group on the server. 

 The person performing the installation must have/know the credentials of the 
User account created in the database, as specified in the Database 
Requirements section. These are the Database user credentials that the 
installation will require when it displays the database platform connection 
information.  

 The Windows account of the person performing the installation must be a 
member of the System Administrator group and Content Manager Roles in 
SQL Server Reporting Services on the Report Server.  

 

For more information, see How to Give Your Account Proper 
Rights and Privileges in Reporting Services in Appendix C. 

 

Database Server 
Tier 

 The Windows account of the person performing the installation must be a 
member of the Local Administrator group on the server and a member of the 
SYSADMIN role in SQL Server. 

 The person performing the installation must know the credentials of the user 
account created in the database as specified in the Database Requirements 
section. These are the database user rights that the installation will require 
when it displays the database platform connection information. 
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Vision Server Account Requirements 
The installation creates a local account and uses that account to set up the initial Vision server 
components in several areas such as configuring the IIS Web Server settings, creating and 
launching the Deltek Vision Process Server Windows service, and running Vision reports.  

If there is a domain or local account policy that has more stringent password requirements, setup 
will be unable to create the account and the Vision server components will need to be manually 
configured before users can launch it. If this happens, you will not be able to run reports. 

 

Deltek strongly recommends that you change the default password for this local account after 
the installation is complete.  

In addition, if Vision users require access to domain printers and/or Windows Authenticated 
logins, you must use a Domain Account. The local account created during the install is not a 
Domain Account and will not have access to your domain by default.  

Changing From a Local Account to a Domain Account 
After the installation, you can change the local account created by the installer to a domain 
account. 

 

For more information about the local account, see one of the following: 

 Deltek KB Article #52458 on the Deltek Customer Care Connect site  
http://support.deltek.com. 

 The Deltek Vision Advanced Technical Administrator's Guide. 

Configuring Server-Side Printing 
If you deploy Vision with Windows Server, you must complete the following step to configure 
server-side printing: 

 Configure the VisionApplicationPool Identity (IIS) and the Report Server Windows 
Username (Report Server tab of WebLink) to be the same domain account. This must 
also match the domain account profile where your network printers are installed on the 
Vision web/application server.  

 

For more information, see How to Connect to the Report Server Web Service in Appendix C. 

See the Deltek Product Support Compatibility Matrix Guide on the Deltek Customer Care 
Connect site for additional information: http://support.deltek.com. 

https://deltek.custhelp.com/app/answers/detail/a_id/52458
http://support.deltek.com/
http://support.deltek.com/
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Installation Steps (Vision New Installs) 

One Server Installation  
This section provides instructions for installing all Vision tiers on one server for organizations that 
prefer the one-server deployment model. One-server deployment is suitable for demonstration 
purposes or for small organizations. 

When you choose the One Server deployment model, you install all Vision tiers (Web, 
application, process server, report, and database) on the same machine. You may want to install 
all Vision tiers on the same server if your deployment needs are simple.  

 

 Before you begin your installation, review the Preinstallation Checklist. 

 To review the various deployment options, see the Installation/Deployment Models section. 

The steps in this section explain how to install all tiers, including the database tier. The method 
that you use to create your Vision database file during installation depends on whether you are: 

 Installing Vision for the first time with a new database, or  

 Installing Vision for the first time and upgrading your database from a previous Deltek 
product.  

 Performing an upgrade of an existing Vision 7.5 installation. 

 Performing an upgrade of an existing Vision version earlier than Vision 7.5 

This section includes information about creating or locating your Vision database. 

 

If you are migrating your database from Deltek Advantage, Deltek Award, Deltek CRM and 
Proposals, or Deltek Sema4 to Vision, review Migrating from Deltek Legacy Products before you 
install Vision. 

 

If your existing Vision Web/Application Server is on a version of Windows that is no longer 
supported, you must perform a new installation. Review the Migrating/Upgrading To a New 
Server section. 

To install Vision tiers on one server: 

1. Double-click the DeltekVision76.exe file that you downloaded to run the installation.  

When you download the Vision installation, an email containing the installation password 
and your license information is sent to your email address.  

The Prerequisites page of the InstallShield Wizard displays. This screen shows the items 
that the installation checks for. If the criteria are not met for a particular tier, setup may 
exit or display a warning.  

2. Ensure that your environment meets all prerequisites and click Next.  

3. On the Welcome page, click Next. 

4. On the License Agreement page, read the agreement and select I accept the terms of 
the license agreement if you agree. Click Next.  

5. On the Choose Destination Location page, specify the location where you want to install 
Vision and its components and click Next. 
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Vision is configured to run as a 64-bit application; the default installation location is 
C:\Program Files\Deltek\Vision. 

6. On the Number of Deltek Vision Servers page, select One Server to install all server 
components (database, Web/application, process, and report) on one server, and then 
click Next. 

7. On the Reports to Load page, select the language to load and click Next. 

The Vision installation includes the language options that you are licensed to use. 

8. On the Database Server (MSSQL) Setup Connection page, set the following options and 
then click Next: 

 Database Server — Enter the name of the database server. 

 SQL Username — Enter a Microsoft SQL database server login/username that is a 
member of the SQL Server SYSADMIN Role. The default SYSADMIN account for 
SQL Server is sa. If you use the SQL Server Username and Password, ensure that 
the server security is configured to support Mixed Mode. 

 SQL Password — Enter the password associated with this SQL Username. 

 Windows Integrated — Select this check box. Selecting this option means that if 
you are logged on to the server with the appropriate administrative rights, you can be 
authenticated to your SQL server via your Windows account. Your current Windows 
account must also be a member of the SYSADMIN role in Microsoft SQL Server to 
perform the installation. If you use integrated authentication, ensure that your current 
logged in account is a member of the SYSADMIN role in SQL Server. When 
Microsoft SQL Server is installed, it does not add members of the local 
administrator’s group to the SQL Server SYSADMIN role by default.  

When you click Next, setup checks your Microsoft SQL Server Reporting Services 
configuration. Setup uses the default report server URL when it checks the configuration 
of Microsoft SQL Reporting Services on the Web Server to the Reporting Services Web 
Service. If it is unable to make a connection to the Reporting Service Web Service page, 
setup displays an error message to explain that it is unable to make the connection and 
then displays the Specify Report Server and Report Server URL Information form.  

9. After your configuration is verified, click Next.  

10. On the Databases to Restore page, select the database that you want to restore, if any. 
The database that you select determines the language that displays in the Vision user 
interface. Vision supports databases for languages that you are licensed to use. 

 No Selection (no boxes checked) — If you already have a Vision database or 
previous sample database, you can click Next without making a selection. The 
installer will prompt you to choose the database(s) to upgrade if the setup detects 
them. 

 Blank Databases – If there are any existing Vision 6.x databases that you want to 
upgrade on the database server you specified, do not select Blank Database. You 
can upgrade an existing 6.x or 7.x database in the next step. If you don’t have an 
existing Vision database, select this option to start a new Vision database.  

 Blank Database (Vision – US) — Select this option to install a blank database 
for English Language installations within the United States. 

 Blank Database (Vision – English International) — Select this option to install a 
blank database for English Language installations outside of the United States.  

 Blank Database (Vision – Dutch) — Select this option to install a blank database 
for Dutch Language installations.  
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 Blank Database (Vision – German) — Select this option to install a blank 
database for German Language installations.  

 Sample Database (VisionDemo76) — Select this option to install the Vision sample 
database. This database can be useful for troubleshooting. If you already have a 
previous version of the sample Database, the following options are available: 

 Do not select Sample Database. The setup will detect supported previous 
versions of databases (including the sample database) and give you the 
opportunity to upgrade your sample database. 

 In most cases, a previous version of the sample database has the Vision version 
number in its name (for example, VisionDemo73). If that is the case, when you 
convert a previous version’s demo database to the current release, the version it 
is upgraded to will no longer match the version number in its name. You can 
perform one of the following actions: 

 Delete the previous version’s sample database on your SQL Server before 
continuing, and then choose to restore the sample database. Deltek 
recommends this option. 

 Rename the database on the SQL Server and in WebLink after the 
installation to reflect the correct version number. 

 Allow the installation to restore a new VisionDemo76 Sample database 
without removing the previous copy. 

If the installation program cannot connect to the database using the username/password 
that you entered, a message asking you to try again displays when you try to continue. 
Resolve this connection issue before continuing with the installation. 

11. Click Next.  

12. The next page to display depends on your database version: 

 If your database is already at the current release, the Database to Upgrade screen 
does not display and you can skip this step. 

 If your database is older than version 6.x, a message displays letting you know that 
there are no valid databases to convert. You must manually convert those databases 
to a minimum of version 6.x and then upgrade to the current release. 

 

To upgrade your database to 6.x, see Converting a Database During Installation. 

 If your database version is 6.x, the Database to Upgrade page displays:  

a. If there are any existing Vision 6.x databases on your database server, setup will 
detect and display the databases on their version numbers on the Database to 
Upgrade page.  

 

Before displaying the Database to Upgrade page, setup will display a 
warning message: "If a database contains custom objects do not select it for 
automatic upgrade. For those databases you would drop the custom objects, 
manually run the upgrade scripts, and then re-apply the custom objects…"   

If you have added any custom indexes, triggers, and so on to your database 
you must remove them before performing the conversion to ensure they do 
not affect the conversion. 

b. Complete one of the following actions and then click Next to continue: 
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 Select a database to upgrade. If you upgrade a database, the setup process 
will make a backup of the database on your SQL Server in the default 
backup location before converting the database. If setup is unable to make 
the backup because of insufficient space or any other reason, the database 
will not be converted and an error message will display during the 
installation. This error will also be logged in the log file so that when you 
review the log file you can be reminded to convert the database manually.  

 If you choose the I will backup and upgrade the database myself after the 
installation option, setup will return a message that you will need to convert 
the database manually.  

 

If you choose to upgrade the database manually outside of the 
installation, a database conversion log will not be created. You must 
therefore review the query results from your query window to verify that 
there were no errors. If you encounter errors, save the output to a text 
file and submit it to Deltek Customer Care. Do not proceed with your 
implementation if you encounter errors during the database conversion. 

 If you are installing any tier that included the Web/application tier and did not 
restore or upgrade a database that is already at the current released version 
and setup does not detect any existing Vision 6.x databases on your 
database server, setup will display a message window stating that a 
database is required to continue and will exit. 

c. Manually create a backup of your database before you run the database 
conversion using the Deltekvision76.sql script file located in the <Installation 
folder>\databases\scripts folder.  The default location is C:\program 
files\Deltek\Vision\Databases\Scripts folder on the Vision Web/Application server.  

Do not run the UnicodeDeltekvision76.sql or other script files unless directed to 
by Deltek Customer Care. If you plan to convert your Vision database to 
Unicode, refer to the Vision Help for the appropriate steps. 

13. Click Next.  

14. On the Databases Available for Logon page, select the databases that you want to make 
available to Vision users on the Vision login screen and click Next. 

This page displays only if you have selected multiple databases to upgrade or restore. If 
you do not have multiple databases, skip to the next step. 

15. On the Specify Web Site page, select the web site to which you will install Vision and 
click Next.  

This page displays only if your Web server contains multiple web sites. If you are 
installing to an existing SharePoint server, SharePoint web sites are omitted from the list. 

If your Web server does not contain multiple web sites, skip to the next step. 

16. On the Error Reporting page, select Automatically send fatal error reports to Deltek, 
and click Next.  

17. On the Customer Experience Improvement Program page, select Send installation data 
to Deltek and click Next. 

18. On the Start Copying Files page, review and, if necessary, note the following installation 
settings: 

 The location of the installation log that tracks all the steps performed during the 
installation. 
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 The installation directory where you installed Vision. 

 The Setup Type and the option chosen – If you are performing a multi-server 
installation, this information is handy as it contains information required when 
installing on multiple server installations.   

 Information about the installation such as: 

 Web/Application Server: 

 Web/Application Server Name 

 The Web Site 

 The Virtual Directory 

 The Security Mode 

 Details of any accounts created by the installation 

 WebLink password configuration. 

 Report Server: 

 The report server name 

 Report Server URL 

 Database Server  

 The database server name\(Instance) 

 The database login used to perform the installation on the database server. 

 Any Vision database logins and passwords created in SQL Server during the 
installation. This information can be used when configuring WebLink. Deltek 
recommends that you change the passwords from their defaults and/or 
change the login name.  

 Any databases that you will be restoring or upgrading. 

 Any databases that will be added to the list in WebLink. 

19. When you finish reviewing settings, click Next to begin the installation. 

20. Click Finish to complete the installation. If prompted, you can restart your computer after 
installing Vision. 

 

If you encountered any errors during the installation, contact Deltek Customer Care and send 
them the installation log file. See Log Files for more information. 

 

During installation of the database tier, the Vision backup device is created on the database 
server to allow users to perform ad hoc database backups before major data changes or 
processes take place.  

To back up the database, select Utilities » Backup Database from the Vision Navigation 
menu. 

http://support.deltek.com/
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Two Server Installation 
This model is designed for small to medium-sized firms who may not have a technical staff.  

 

See Installation/Deployment Models for a complete description of each deployment model. 

There are two different methods for installing Vision across two servers: 

Configuration Description 

Configuration 1 Install the database and report components on one server machine and 
the Web/application and process server components on a separate 
server machine. Organizations with one SQL Server license will use this 
configuration. Organizations typically use this method if all users are at a 
single location and will only access Vision in the office or over a VPN 
connection into the corporate network. Infrastructure security is not 
necessarily a concern in this model, because all application usage is 
internal to the organization. This method is designed for small to medium-
sized organizations that may not have a technical staff. 

The topics that cover this method are: 

 Configuration 1 (Part 1) — Database and Report Installation for Two-
Server Deployment 

 Configuration 1 (Part 2) — Web/Application and Process Server 
Installation for Two-Server Deployment 

In a two-server deployment with Configuration 1, the Database and 
Report Server are on the same machine. In this configuration, the Vision 
client application needs a direct connection to the Report Server to run 
and view reports. Since the Database server is also on the Report server, 
it is not suitable for use in an environment with users accessing the 
application over the Internet. 

Configuration 2 Install the database component on one server machine and the 
Web/application, process server, and report components on a separate 
server machine.  

Configuration 2 has the Reporting Services installed on a server separate 
from the Database Engine. If you decide to split the Report Server (web 
service) from the Database Server hosting the Report Server database, 
you will need an additional Microsoft SQL Server license.  

The topics that cover this method are: 

 Configuration 2 (Part 1) — Database Server Installation for Two-
Server Deployment 

 Configuration 2 (Part 2) — Web/Application, Report, and Process 
Server Installation for Two-Server Deployment 
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Configuration 1 (Part 1) — Database and Report Installation for Two-Server 
Deployment 

 

If you are migrating your database from Deltek Advantage, Deltek Award, Deltek CRM and 
Proposals, or Deltek Sema4 database to Vision, review the information in KB Article # 11424 
titled Where is Conversion Utility for Advantage to Vision? prior to beginning your Vision 
installation. 

 

Review the Preinstallation Checklist before you begin your installation. 

For important information about upgrading from a previous version of Vision, see Installation 
Steps (Vision Upgrades). 

To install the database and report server: 

1. Double-click the DeltekVision76.exe file that you downloaded to run the installation.  

When you download the Vision installation, an email containing the installation password 
and your license information is sent to your email address.  

The Prerequisites page of the InstallShield Wizard displays. This screen shows the items 
that the installation checks for. If the criteria are not met for the particular tier, setup may 
exit or display a warning.  

2. Ensure that your environment meets all prerequisites and click Next.  

3. On the Welcome page, click Next.  

4. On the License Agreement page, review the agreement and click the I accept the terms 
of the license agreement option if you agree. Click Next.  

5. On the Choose Destination Location page, complete one of the following actions: 

 Click Next to accept the destination displayed on the form. 

 Click Browse…, select an alternate destination, and click Next. 

If you do not have at least 1GB of free space in the Destination location, Vision displays 
an error message. Change the path to select a folder with over 1GB of free space and 
click Retry. 

 

If you are upgrading from a previous installation, do not install into the same folder as 
the previous installation.   

6. On the Number of Vision Servers page, select Two Servers and click Next. 

7. On the Two tier – role of server page, select the Database/Report option and click Next. 
The Database Server (MSSQL) Setup Connection page displays.  

Setup checks for the Microsoft .NET Framework prerequisite before displaying the 
Database Server Setup Connection Information page. If it does not detect it, the setup 
exits. 

https://deltek.custhelp.com/app/answers/detail/a_id/11424
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Setup no longer upgrades databases on database tier or report/database tier 
installations. All database upgrades need to be completed from the web/application 
upgrade. During in-place Web/Application server upgrades, setup reads the 
configuration settings in the Vision \Web web.config file.  If there are any custom 
settings and those settings have been migrated to the database, the installer will 
include them in the database conversion script.  For this reason, the database script 
can only be created during the web/application server installation.  

For more details, refer to the Summary of Upgrade Installation Changes section. 

8. On the Database Server (MSSQL) Setup Connection page, enter the following 
information: 

 Database Server — Enter the name of the database server. 

 SQL Username — Enter a Microsoft SQL database server login/username that is a 
member of the SQL Server SYSADMIN Role. The default SYSADMIN account for 
SQL Server is sa. If you use the SQL Server username and password, ensure that 
the server security is configured to support Mixed Mode. 

 SQL Password — Enter the password associated with this SQL username. 

 Windows Integrated — Selecting this option means that if you are logged on to the 
server with the appropriate administrative rights, you can be authenticated to your 
SQL server via your Windows account. Your current Windows account must also be 
a member of the SYSADMIN role in the Microsoft SQL Server to perform the 
installation. If you are using integrated authentication, ensure that your current 
logged in account is a member of the SYSADMIN role in SQL Server. When 
Microsoft SQL Server is installed, it does not add members of the local 
administrator’s group to the SQL Server SYSADMIN role by default.  

You must make sure your connection is configured correctly before you can continue. If 
the installation program cannot connect to the database using the username/password 
you entered, when you click Next, a message displays asking you to try again. Click OK, 
correct the problem, and continue. 

9. Click Next.  

10. On the Databases to Restore page, select the database that you want to restore, if any. 
The database that you select determines the language that displays in the Vision user 
interface.  

 No Selection (no boxes checked) — If you already have a Vision database or 
previous sample database, you can click Next without making a selection. During the 
Web/Application server tier installation, the installer will prompt you to choose the 
database(s) to upgrade when it detects them. 

 Blank Database (Vision - US) — Select this option to start a new Vision database. 

 Blank Database (Vision – English International) — Select this option to start a new 
Vision database if you are using an English Language installation and are outside the 
United States. 

 Blank Database (Vision – Dutch) — Select this option to install a blank database for 
Dutch Language installations.  

 Blank Database (Vision – German) — Select this option to install a blank database 
for German Language installations.  
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 Sample Database (VisionDemo76) — Select this option to install the Vision sample 
database. This database can be useful for troubleshooting. If you already have a 
previous version of the sample database, the following options are available: 

 Do not select Sample Database. The setup will detect supported previous 
versions of databases (including the sample database) during the 
Web/Application server installation and give you the opportunity to upgrade your 
sample database.  

 In most cases, a previous version of the sample database has the Vision version 
number in its name (for example, VisionDemo73). If that is the case, when you 
upgrade a previous version’s demo database, the version it is upgraded to will no 
longer match the version number in its name. You can perform one of the 
following actions: 

 Delete the previous version’s sample database on your SQL Server before 
continuing and then choose to restore the sample database. Deltek 
recommends this option. 

 Rename the database on the SQL Server and in WebLink after the 
installation to reflect the correct version number. 

 Allow the installation to restore a new VisionDemo76 Sample database 
without removing the previous copy. 

11. Click Next to continue.  

The Checking configuration of Microsoft SQL Reporting Services message displays.  

The setup, when performed with any deployment model that has the Web tier option, will 
try to connect to the Microsoft SQL Reporting Services Web Service to verify connectivity 
to the Report Server. It uses a standard Report Server URL definition (containing the 
server name) to make the connection.  

If it is unable to make a connection to the Reporting Service Web Service page, the setup 
displays an error message to explain that it is unable to make the connection and 
displays the Specify Report Server and Report Server URL Information form.  

 

For additional information, see How to Connect to Report Server Web Service in 
Appendix C. 

12. When the connection is complete, click Next.  

13. On the Error Reporting page, select Automatically send fatal error reports to Deltek 
and click Next.  

14. On the Customer Experience Improvement Program page, select Send installation data 
to Deltek and click Next. 

15. On the Start Copying Files page, review the installation settings. The information on this 
page is also recorded in the Installation Log for future reference. It contains information 
such as: 

 The location of the installation log that tracks all the steps performed during the 
installation. 

 The installation directory where you installed Vision. 

 The Setup Type and the option chosen – If you are performing a multi-server 
installation, it is good to know what options were chosen when performing the 
installation on your other servers. 
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 Information about the Database/Report server configurations such as: 

 Any local accounts that were created for the setup, including their passwords.  

 Report server name and report server URL. 

 Database Server name / Instance name 

 List of databases that will be created (if option was selected). 

16. Click Next. 

17. On the Deltek Vision Installation Wizard Complete page, click Finish. If prompted, restart 
your computer after installing Vision. 

You have successfully installed the Database and Report Server tiers on a server. Proceed to 
“Configuration 1 (Part 2) — Web/Application and Process Server Installation of Two Server 
Deployment.” 

 

If you encountered any errors during the installation, contact Deltek Customer Care and send 
them the installation log file. See Log Files for more information. 

 

During installation of the database tier, the Vision backup device is created on the database 
server to allow users to perform ad hoc database backups before major data changes or 
processes take place. To back up the database, select Utilities » Backup Database from the 
Vision Navigation menu. 

http://support.deltek.com/
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Configuration 1 (Part 2) — Web/Application and Process Server Installation 
of Two Server Deployment 
Follow these steps to install the Vision Web/application and process server tier on one server. 
During installation, you will be prompted for database information, such as the database host 
name or IP address and Report Server information such as the Report Server Name, and Report 
Server URL. You must have this information to perform the installation. This is the second of two 
steps for the Two-Server Deployment Model where the Database/Report Server tiers are on one 
server and the Web/Application and Process Server tiers are on another server. . 

 

Review the Preinstallation Checklist before you begin your installation. 

Deltek recommends installing the Database Server first. In this configuration, you have already 
installed the Database and Report Server Tiers. That step must be performed before the 
installation of Deltek Vision on your Vision Web/Application Server.  

Additionally, the installation also created a default account named DeltekVision with the 
necessary rights to the Report Server Web Services. You can specify the username and its 
password when prompted for the Report Server Web Service credentials. 

 

The password information is listed on the Summary screen of the Database/Report Server 
installation. 

To install the Web/Application and Process Servers: 

1. Double-click the DeltekVision76.exe file that you downloaded to run the installation.  

2. When you download the Vision installation, an email containing the installation password 
and your license information is sent to your email address.  

The Prerequisites page of the InstallShield Wizard displays. This screen shows the items 
that the installation checks for. If the criteria are not met for the particular tier, setup may 
exit or display a warning.  

3. Ensure that your environment meets all prerequisites and click Next. 

4. On the Welcome page, click Next.  

5. On the License Agreement page, review the agreement and click the I accept the terms 
of the license agreement option if you agree. Click Next.  

6. On the Choose Destination Location page, complete one of the following actions: 

 Click Next to accept the destination displayed on the form. 

 Click Browse, select an alternate destination, and click Next.  

If you do not have at least 1GB of free space in the Destination location, Vision displays 
an error message. Change the path to select a folder with over 1GB of free space and 
click Retry. 

7. On the Number of Vision Servers page, select Two Servers and click Next.  

8. On the Two tier – role of server page, select the Web/Application/Process option.  
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9. On the Reports to Load page, select the language for the reports to load. English – US is 
the default. The Vision installation routine includes options for selecting the languages 
that you are licensed to use. 

 

If you have other report languages loaded, setup will also select those languages to 
reload. 

Setup checks for the Microsoft .NET Framework prerequisite before displaying the 
Database Server Setup Connection Information form. If it does not detect it, the setup 
exits. 

10. On the Database Server (MSSQL) Setup Connection page, enter the following: 

 Database Server — Enter the name of the database server. 

 SQL Username — Enter a Microsoft SQL database server login/username that is a 
member of the SQL Server SYSADMIN Role. The default SYSADMIN account for 
SQL Server is sa. If you use the SQL Server username and password, ensure that 
the server security is configured to support Mixed Mode. 

 SQL Password — Enter the password associated with this SQL Username. 

 Windows Integrated — Selecting this option means that if you are logged on to the 
server with the appropriate administrative rights, you can be authenticated to your 
SQL server via your Windows account. Your current Windows account must also be 
a member of the SYSADMIN role in the Microsoft SQL Server to perform the 
installation. If you are using integrated authentication, ensure that your current 
logged in account is a member of the SYSADMIN role in SQL Server. When 
Microsoft SQL Server is installed, it does not add members of the local 
administrator’s group to the SQL Server SYSADMIN role by default.  

11. Make sure your connection is configured correctly before you continue. If the installation 
program cannot connect to the database using the username/password you entered, 
when you click Next, a message displays asking you to try again.  

12. Click OK, correct the problem, and continue. The Checking configuration of Microsoft 
SQL Reporting Services page displays.  

The setup, when performed with any deployment model that has the Web tier option, will 
try to connect to the Microsoft SQL Reporting Services Web Service to verify connectivity 
to the Report Server.  It uses a standard Report Server URL definition (containing the 
server name) to make the connection.  If it is unable to make a connection to the 
Reporting Service Web Service page, setup will return an error message with the reason 
it is unable to make the connection and will display the Specify Report Server and Report 
Server URL Information form. Continue to the next step when the connection is complete. 

 

For additional information, see How to Connect to Report Server Web Service in 
Appendix C. 

13. The next screen to display depends on your database version: 

 If your database is already at the current release, the Database to Upgrade page 
does not display and you can skip this step. 

 If your database is older than version 6.x, a message displays letting you know that 
there are no valid databases to convert. You must manually convert those databases 
to a minimum of version 6.x then upgrade to the current release. 
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To upgrade your database to 6.x, see Converting a Database During Installation. 

 If your database version is 6.x, the Database to Upgrade page displays:  

a. If there are any existing Vision 6.x databases on your database server, setup will 
detect and display the databases on their version numbers on the Database to 
Upgrade page.  

 

Before displaying the Database to Upgrade page, setup will display a 
warning message: "If a database contains custom objects do not select it for 
automatic upgrade. For those databases you would drop the custom objects, 
manually run the upgrade scripts, and then re-apply the custom objects…"   

If you have added any custom indexes, triggers, and so on to your database 
you must remove them before performing the conversion to ensure they do 
not affect the conversion 

 

If you do not remove any custom indexes, triggers, and so on that you 
added, the conversion may fail.  If it fails, you must restore the database, 
remove the objects, convert the database and reapply your changes. 

b. Complete one of the following actions: 

 Select a database to upgrade. If you upgrade a database, the setup process 
will make a backup of the database on your SQL Server in the default 
backup location before converting the database. If setup is unable to make 
the backup because of insufficient space or any other reason, the database 
will not be converted and an error message will display during the 
installation. This error will also be logged in the log file so that when you 
review the log file you can be reminded to convert the database manually.  

 Click Next to bypass this form.  

 If you choose the I will backup and upgrade the database myself after the 
installation option, setup will return a message that you will need to convert 
the database manually.  

 

If you choose to upgrade the database manually outside of the 
installation, a database conversion log will not be created. You must 
therefore review the query results from your query window to verify that 
there were no errors. Do not close the query window until you review for 
errors.  If you encounter errors, save the output to a text file and submit 
it to Deltek Customer Care. 

 If you are installing any tier that included the Web/application tier and did not 
restore or upgrade a database that is already at the current released version 
and setup does not detect any existing Vision 6.x databases on your 
database server, setup will display a message window stating that a 
database is required to continue and will exit. 

c. Manually create a backup of your database before you run the database 
conversion using the Deltekvision76.sql script file located in the <Installation 
folder>\databases\scripts folder.  The default location is C:\program 
files\Deltek\Vision\Databases\Scripts folder.  
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Do not run the UnicodeDeltekvision76.sql or other script files unless directed to 
by Deltek Customer Care. If you plan to convert your Vision database to 
Unicode, refer to the Vision Help for the appropriate steps. 

14. Click Next.  

15. If you have more than one database, on the Databases Available for Logon page, select 
the databases that you want to make available to Vision users on the Vision login screen. 
The list displayed here includes: 

 The databases you selected to upgrade, along with their current version numbers (if 
any were selected). 

 The sample database (if restored or upgraded). 

 The blank database (if restored). 

 Any current version databases already previously restored or converted on your 
database server. 

You must select at least one database. You can use WebLink after installation to add or 
remove new databases.  

This page does not display if you do not have more than one database or did not choose 
to upgrade any databases and there is only one existing Vision 7.6 database. 

16. Click Next to continue.  

17. On the Specify Web Site page, select the web site to which you will install Vision and 
click Next.  

This page displays only if your Web server contains multiple web sites. If you are 
installing to an existing SharePoint server, SharePoint web sites are omitted from the list. 

If your Web server does not contain multiple web sites, skip to the next step. 

18. On the Error Reporting page, select Automatically send fatal error reports to Deltek, 
and click Next.  

19. On the Customer Experience Improvement Program page, select Send installation data 
to Deltek and click Next. 

20. On the Start Copying Files page, review the installation settings. The information on this 
page is also recorded in the Installation Log for future reference. It contains information 
such as: 

 The location of the installation log that tracks the steps performed during the 
installation. 

 The installation directory where you installed Vision. 

 The Setup Type and the option chosen. If you are performing a multi-server 
installation, this information is handy as it contains information required when 
installing on multiple server installations. 

 Information about the Web/application/report server configurations such as: 

 Web Site, Virtual Directory, Virtual Directory Security Mode 

 Any local Windows accounts that were created for the setup including their 
Password.  

 Database/Report server name and report server URL. 

 List of databases that will be converted. 
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 List of databases that will appear in WebLink after the installation. 

21. Click Next. 

22. On the Deltek Vision Installation Wizard Complete screen, click Finish. If prompted, you 
can restart your computer after installing Vision.  

You successfully installed the Web/Application and Process Server tiers on the current server. 

 

If you encountered any errors during the installation, contact Deltek Customer Care and send 
them the installation log file. See Log Files for more information. 

 

During installation of the database tier, the Vision backup device is created on the database 
server to allow users to perform ad hoc database backups before major data changes or 
processes take place. To back up the database, select Utilities » Backup Database from the 
Vision Navigation menu. 

http://support.deltek.com/
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Configuration 2 (Part 1) — Database Server Installation for Two-Server 
Deployment 
You do not need to perform this installation if your database tier is on its own server unless you 
plan to restore the sample, a blank database, or use the Performance Management (Analysis 
Cubes) module. 

 

If you are migrating your database from Deltek Advantage, Deltek Award, Deltek CRM and 
Proposals, or Deltek Sema4 database to Vision, review the information in the KB Article # 
11424 titled Where is Conversion Utility for Advantage to Vision? prior to beginning your Vision 
installation. 

 

Review the Preinstallation Checklist before you begin your installation. 

For steps to upgrade from a previous version of Vision, see Installation Steps (Vision 
Upgrades). 

To install the database server: 

1. Double-click the DeltekVision76.exe file that you downloaded to run the installation.  

2. When you download the Vision installation, an email containing the installation password 
and your license information is sent to your email address.   

The Prerequisites page of the InstallShield Wizard displays. This screen shows the items 
that the installation checks for. If the criteria are not met for the particular tier, setup may 
exit or display a warning.  

3. Ensure that your environment meets all prerequisites and click Next.  

4. On the Welcome page, click Next.  

5. On the License Agreement page, review the agreement and click the I accept the terms 
of the license agreement option if you agree. Click Next.   

6. On the Choose Destination Location page, complete one of the following actions: 

 Click Next to accept the destination displayed on the form. 

 Click Browse, select an alternate destination, and click Next.  

If you do not have at least 1GB of free space in the Destination location, Vision displays 
an error message. Change the path to select a folder with over 1GB of free space and 
click Retry. 

7. On the Number of Vision Servers page, select Two Servers and click Next.  

8. On the Two tier – role of server page, select the Database only option and click Next.  

 

Setup no longer upgrades databases on database tier or report/database tier installations. All 
database upgrades need to be completed from the web/application upgrade. During in-place 
Web/Application server upgrades, setup reads the configuration settings in the Vision \Web 
web.config file.  If there are any custom settings and those settings have been migrated to the 
database, the installer will include them in the database conversion script.  For this reason, the 
database script can only be created during the web/application server installation.  

For more details, refer to the Summary of Upgrade Installation Changes section. 

https://deltek.custhelp.com/app/answers/detail/a_id/11424
https://deltek.custhelp.com/app/answers/detail/a_id/11424
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9. On the Database Server (MSSQL) Setup Connection page, enter the following: 

 Database Server — Enter the name of the database server. 

 SQL Username — Enter a Microsoft SQL database server login/username that is a 
member of the SQL Server SYSADMIN Role. The default SYSADMIN account for 
SQL Server is sa. If you use the SQL Server Username and Password, ensure that 
the server security is configured to support Mixed Mode. 

 SQL Password — Enter the password associated with this SQL username. 

 Windows Integrated — Selecting this option means that if you are logged on to the 
server with the appropriate administrative rights, you can be authenticated to your 
SQL server via your Windows account. Your current Windows account must also be 
a member of the SYSADMIN role in the Microsoft SQL Server to perform the 
installation. If you are using integrated authentication, ensure that your current 
logged in account is a member of the SYSADMIN role in SQL Server. When SQL 
Server is installed, it does not add members of the local administrator’s group to the 
SQL Server SYSADMIN role by default.  

10. You must make sure your connection is configured correctly before you can continue. If 
the installation program cannot connect to the database using the username/password 
you entered, when you click Next, a message displays asking you to try again. Click OK, 
correct the issue, and continue.  

11. Click Next. 

12. On the Databases to Restore page, select the database that you want to restore, if any. 
The database that you select determines the language that displays in the Vision user 
interface. 

 No Selection (No Boxes checked) — If you already have a Vision database or 
previous sample database, you can click Next without making a selection. During the 
Web/Application server tier installation, the installer will prompt you to choose the 
database(s) to upgrade when it detects them. 

 Blank Database (Vision – US) —Select this option to start a new Vision database.  

 Blank Database (Vision – English International) — Select this option to start a 
new Vision database if you are using an English Language installation and are 
outside the United States.  

 Blank Database (Vision – Dutch) — Select this option to install a blank database for 
Dutch Language installations.  

 Blank Database (Vision – German) — Select this option to install a blank database 
for German Language installations.  

 Sample Database (VisionDemo76) — Select this option to install the Vision sample 
database. It is sometimes helpful to have this database installed for troubleshooting 
purposes. If you already have a previous version of the sample database, the 
following options are available: 

 Do not select Sample Database. The setup will detect supported previous 
versions of databases (including the sample database) during the 
Web/Application server installation and give you the opportunity to upgrade your 
sample database.  

 In most cases any previous versions of the sample database may have the 
Vision database version number in its name (for example, VisionDemo73). If that 
is the case, when you upgrade a previous version’s demo database, the version 
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it is upgraded to will no longer match the version number in its name. You can 
perform one of the following actions: 

 Delete the previous version’s sample database on your SQL Server before 
continuing, and then choose to restore the sample database. Deltek 
recommends this option. 

 Rename the database on the SQL Server and in WebLink after the 
installation to reflect the correct version number. 

 Allow the installation to restore a new VisionDemo76 Sample database 
without removing the previous copy. 

13. Click Next.  

14. On the Error Reporting page, select Automatically send fatal error reports to Deltek 
and click Next.  

15. On the Customer Experience Improvement Program page, select Send installation data 
to Deltek and click Next. 

16. On the Start Copying Files page, review and save the installation settings. This page 
contains the following information: 

 The location of the installation log that tracks all the steps performed during the 
installation. 

 The installation directory where you installed Vision. 

 The Setup Type and the option chosen – If you are performing a multi-server 
installation, this information is handy as it contains information required when 
installing on multiple server installations. 

 Information about the database server such as: 

 Database server name 

 Database login used to perform the installation on the database server 

 Any Vision logins and passwords created in SQL Server during the installation. 
This information can be used when configuring WebLink. It is recommended that 
you change at least the passwords from their defaults. 

 Any databases that you will be restoring. 

17.  Click Next to begin installation of the database server as part of a two server installation.  

18. On the Deltek Vision Installation Wizard Complete screen, click Finish. 

You have successfully installed the Database Server tier on a server. Proceed to 
Configuration 2 (Part 2): Web/Application, Report, and Process Server Installation for Two-
Server Deployment to install the Web/Application, Report, and Process Servers on a second 
server. 

 

If you encountered any errors during the installation, contact Deltek Customer Care and send 
them the installation log file. See Log Files for more information. 

 

During installation of the database tier, the Vision backup device is created on the database 
server to allow users to perform ad hoc database backups before major data changes or 
processes take place. To back up the database, select Utilities » Backup Database from the 
Vision Navigation menu. 

http://support.deltek.com/
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Configuration 2 (Part 2) —  Web/Application, Report, and Process Server 
Installation for Two-Server Deployment  
Follow these steps to install the Vision Web/application, report, and process server tiers on one 
server. During installation, you will be prompted for database information, such as the database 
host name or IP address. You must have this information to perform the following installation. 

 

Review the Preinstallation Checklist before you begin you installation. 

To install the Web/Application/Report/Process Servers: 

1. Double-click the DeltekVision76.exe file that you downloaded to run the installation.  

When you download the Vision installation, an email containing the installation password 
and your license information is sent to your email address. . 

The Prerequisites page of the InstallShield Wizard displays. This screen shows the items 
that the installation checks for. If the criteria are not met for the particular tier, setup may 
exit or display a warning.  

2. Ensure that your environment meets all prerequisites and click Next. 

3. On the Welcome page, click Next.  

4. On the License Agreement page, review the agreement and click the I accept the terms 
of the license agreement option if you agree. Click Next. 

5. On the Choose Destination Location page, complete one of the following actions: 

 Click Next to accept the destination displayed on the form. 

 Click Browse, select an alternate destination, and click Next.  

If you do not have at least 1GB of free space in the Destination location, Vision displays 
an error message. Change the path to select a folder with over 1GB of free space and 
click Retry. 

6. On the Number of Vision Servers page, select Two Servers and click Next.  

7. On the Two tier – role of server page, select Web/Application Report Process.  

8. On the Reports to Load page, select the language for the reports to load and click Next. 

English – US is the default. The Vision installation routine includes options for selecting 
the languages that you are licensed to use. If you have other report languages loaded, 
setup will also select those languages to reload. 

9. On the Database Server (MSSQL) Setup Connection page, enter the following: 

 Database Server — Enter the name of the database server. 

 SQL Username — Enter a Microsoft SQL database server Login/username that is a 
member of the SQL Server SYSADMIN Role. The default SYSADMIN account for 
SQL Server is sa. If you use the SQL Server Username and Password, ensure that 
the server security is configured to support Mixed Mode. 

 SQL Password  —  Enter the password associated with this SQL Username. 

 Windows Integrated — Selecting this option means that if you are logged on to the 
server with the appropriate administrative rights, you can be authenticated to your 
SQL server via your Windows account. Your current Windows account must also be 
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a member of the SYSADMIN role in the Microsoft SQL Server to perform the 
installation. If you are using integrated authentication, ensure that your current 
logged in account is a member of the SYSADMIN role in SQL Server. When SQL 
Server is installed, it does not add members of the local administrator’s group to the 
SQL Server SYSADMIN role by default.  

10. You must make sure your connection is configured correctly before you can continue. If 
the installation program cannot connect to the database using the username/password 
you entered, when you click Next, a message displays asking you to try again. Click OK, 
correct the issue, and continue.  

11. Click Next to continue.  

The Checking configuration of Microsoft SQL Reporting Services page displays.  

Setup uses the default report server URL when it first checks the configuration of 
Microsoft SQL Reporting Services on the Web Server to the Reporting Services Web 
Service. If it is unable to make a connection to the Reporting Service Web Service page, 
setup will return an error message with the reason it is unable to make the connection 
and will display the Specify Report Server and Report Server URL Information form. 
Continue to the next step when the connection is complete. 

 

For additional information, see these sections in Appendix C: How to Connect to the 
Report Server Web Service and SQL Report Server Database Setup Connection 
Screen. 

12. The next screen to display depends on your database version:  

 If your database is already at the current release, the Database to Upgrade page 
does not display and you can skip this step. 

 If your database is older than version 6.x, a message displays letting you know that 
there are no valid databases to convert. You must manually convert those databases 
to a minimum of version 6.x then upgrade to the current release. 

 

To upgrade your database to 6.x, see Converting a Database During Installation. 

 If your database version is 6.x, the Database to Upgrade screen displays:  

a. If there are any existing Vision 6.x databases on your database server, setup will 
detect and display the databases and their version numbers on the Database to 
Upgrade page.  

 

Before displaying the Database to Upgrade dialog box, setup will display a 
warning message:  "If a database contains custom objects do not select it for 
automatic upgrade. For those databases you would drop the custom objects, 
manually run the upgrade scripts, and then re-apply the custom objects…"   

If you have added any custom indexes, triggers, and so on to your database 
you must remove them before performing the conversion to ensure they do 
not affect the conversion 

 

If you do not remove any custom indexes, triggers, and so on that you 
added, the conversion may fail.  If it fails, you must restore the database, 
remove the objects, convert the database and reapply your changes. 
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b. Complete one of the following actions: 

 Select a database to upgrade. If you upgrade a database, the setup process 
will make a backup of the database on your SQL Server in the default 
backup location before converting the database. If setup is unable to make 
the backup because of insufficient space or any other reason, the database 
will not be converted and an error message will display during the 
installation. This error will also be logged in the log file so that when you 
review the log file you can be reminded to convert the database manually.  

 Click Next to bypass this form.  

 If you choose the I will backup and upgrade the database myself after the 
installation option, setup will return a message that you will need to convert 
the database manually.  

 

If you choose to upgrade the database manually outside of the 
installation, a database conversion log will not be created. You must 
therefore review the query results from your query window to verify that 
there were no errors. Do not close the query window until you review for 
errors.  If you encounter errors, save the output to a text file and submit 
it to Deltek Customer Care. 

 

If you choose to upgrade the database manually outside of the 
installation, a database conversion log will not be created. You must 
therefore review the query results from your query window to verify that 
there were no errors. If you encounter errors, save the output to a text 
file and submit it to Deltek Customer Care. 

 If you are installing any tier that included the Web/application tier and did not 
restore a database that is already at the current released version and setup 
does not detect any existing Vision 6.x databases on your database server, 
setup will display a message window stating that a database is required to 
continue and will exit. 

c. Manually create a backup of your database before you run the database 
conversion using the Deltekvision76.sql script file located in the <Installation 
folder>\databases\scripts folder.  The default location is C:\program 
files\Deltek\Vision\Databases\Scripts folder.  

Do not run the UnicodeDeltekvision76.sql or other script files unless directed to 
by Deltek Customer Care. If you plan to convert your Vision database to 
Unicode, refer to the Vision Help for the appropriate steps. 

13. Click Next.  

14. If you have more than one database, on the Databases Available for Logon page, select 
the databases that you want to make available to Vision users on the Vision login screen. 
The list displayed here includes: 

 The databases you have selected to upgrade, along with their current version 
number (if any were selected). 

 The sample database (if restored or upgraded). 

 The blank database (if you restored). 

 Any current version databases already previously restored or converted on your 
database server. 
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You must select at least one database. You can use WebLink after installation to add or 
remove new databases. This page does not display if you did not choose to upgrade any 
databases and there is only one existing Vision 7.6 database. 

15. Click Next to continue.  

16. On the Specify Web Site page, select the web site to which you will install Vision and 
click Next.  

This page displays only if your Web server contains multiple web sites. If you are 
installing to an existing SharePoint server, SharePoint web sites are omitted from the list. 

If your Web server does not contain multiple web sites, skip to the next step. 

17. On the Error Reporting page, select Automatically send fatal error reports to Deltek, 
then click Next.  

18. On the Customer Experience Improvement Program page, select Send installation data 
to Deltek and click Next. 

19. On the Start Copying Files page, review the installation settings. The information on this 
page is also recorded in the Installation Log for future reference. It contains information 
such as: 

 The location of the installation log of all the steps performed during the installation. 

 The installation directory – where you installed Vision. 

 The Setup Type and the option chosen – if you are performing a multi-server 
installation, this information is handy to use to know what options were chosen when 
performing the installation on your other servers. In this Scenario, Dual Server with 
the (Web/application/Report Tier) Options were selected. 

 Information about the Web/application/report server configurations such as: 

 Web Site, Virtual Directory, Virtual Directory Security Mode 

 Any Local accounts that were created for the setup including their Password.  

 Report server name and report server URL. 

 List of databases that will be converted (if any were chosen). 

 List of databases that will appear in the WebLink after the installation. 

20. Click Next. 

21. On the Deltek Vision Installation Wizard Complete screen, click Finish. You can restart 
your computer after installing Vision.  

You successfully installed the Web/Application, Report and Process Server tiers on the current 
server.  

 

If you encountered any errors during the installation, contact Deltek Customer Care and send 
them the installation log file. See Log Files for more information. 

http://support.deltek.com/
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Install on Three or More Servers 
The three or more servers installation model is designed for large firms who have multiple 
locations and will use Vision on an internal Wide Area Network (WAN). There might be additional 
report, application, or Web servers required for load balancing, performance, security, or fault 
tolerance reasons. 

This model best suits firms with complex deployment requirements. Firms deploying this model 
must have proficient firewall management. For more information about the various deployment 
options available, see the ”Installation/Deployment Models” section on page 13 for more 
information. 

For an installation that uses three or more servers, you can install any combination of the 
following: 

 A single database server 

 One or more report servers 

 One or more Web/application servers 

 One or more process servers, each on its own machine. 

Most organizations that setup a separate dedicated process server disable the Process Server 
service that was installed automatically on the Web/Application Server to free up the processing 
time and dedicate all the Process Server tasks to the Process Server. 

You must also select the appropriate tier or tiers on each individual server. To install these items, 
complete the following steps in the order listed: 

1. Set up your database server. 

2. Set up your report server. 

3. Set up your Web/application server.  

4. Set up a separate process server (if desired). When you install a Web/application server, 
a process server is also installed by default. You can, optionally, install as many stand-
alone process servers as you would like, on separate machines. 

This topic is divided into three sections based on the sequence that must be followed to ensure a 
successful installation of Vision. 

 Install the Database Tier 

 Install the Report Tier on a Second Server 

 Install the Web and Primary Application Tiers on a Third Server – You must install the 
Web/Application tier as the last step. The installation program needs to validate report 
server credentials and configuration as part of the Web/application tier installation. When 
you install the Web/application tier, a process server is also installed. If your firm wants to 
run multiple report, application, or Web servers on additional machines, contact your 
Deltek Technical Services representative for instructions. 

 

Because the three or more servers deployment model involves installing the Web and 
Application tier on one server, the Report tier on a second server, and the Database tier on a 
third server, you need to perform a different installation procedure for each server. 



 

 

Technical Installation Guide 63 

 

Benefits of Using Three or More Servers  
 Enhanced performance and scalability — Three or more servers tier distributes its 

tiers among three or more separate computers. In this setup, the client tier is installed on 
user workstations, the application tier resides on a more centralized computer, and the 
database tier is on a computer that manages data storage. Having each tier on a 
separate machine enhances performance and scalability because each tier runs on a 
dedicated machine. 

 Load balancing — Load balancing distributes the processing workload between two or 
more Web/Application servers. This optimizes the use of your resources and minimizes 
the response time for requested tasks.  

 Automatic client updating — When an update to Vision is available, you update only 
the Process and the Web/Application server. When a client connects to an updated 
Web/Application server, the updates are automatically transferred to the client. 

Step 1: Install the Database Tier (Optional) 
You do not need to perform this installation if your database tier is on its own server unless you 
plan to restore the sample, a blank database, or use the Performance Management (Analysis 
Cubes) module. 

 

If you are migrating your database from Deltek Advantage, Deltek Award, Deltek CRM and 
Proposals, or Deltek Sema4 database to Vision, review the information in the KB Article # 
11424 titled Where is Conversion Utility for Advantage to Vision? prior to beginning your Vision 
installation. 

 

Review the Preinstallation Checklist before you begin your installation. 

For steps to upgrade from a previous version of Vision, see Installation Steps (Vision 
Upgrades). 

To install the Database Server: 

1. Double-click the DeltekVision76.exe file that you downloaded to run the installation.  

2. When you download the Vision installation, an email containing the installation password 
and your license information is sent to your email address. 

The Prerequisites page of the InstallShield Wizard displays. This page shows the items 
that the installation checks for. If the criteria are not met for the particular tier, setup may 
exit or display a warning.  

3. Ensure your environment meets all prerequisites and click Next. 

4. On the Welcome page, click Next. 

5. On the License Agreement page, review the agreement and click the I accept the terms 
of the license agreement option if you agree. Click Next.  

6. On the Choose Destination Location page, complete one of the following actions: 

 Click Next to accept the destination displayed on the form. 

 Click Browse, select an alternate destination, and click Next.  

If you do not have at least 1GB of free space in the Destination location, Vision displays 
an error message. Change the path to select a folder with over 1GB of free space and 
click Retry. 

7. On the Number of Vision Servers page, select Three or more Servers and click Next.  

https://deltek.custhelp.com/app/answers/detail/a_id/11424
https://deltek.custhelp.com/app/answers/detail/a_id/11424
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8. On the Select Server Role page, select Database Server and click Next. The Database 
Server (MSSQL) Setup Connection page displays. 

 

Setup no longer upgrades databases on database tier or report/database tier installations.  All 
database upgrades need to be completed from the web/application upgrade. During in-place 
Web/Application server upgrades, setup reads the configuration settings in the Vision \Web 
web.config file.  If there are any custom settings and those settings have been migrated to the 
database, the installer will include them in the database conversion script.  For this reason, the 
database script can only be created during the web/application server installation.  

For more details, refer to the Summary of Upgrade Installation Changes section. 

9. On the Database Server (MSSQL) Setup Connection page, enter the following: 

 Database Server — Enter the name of the database server. 

 SQL Username — Enter a Microsoft SQL database server Login/username that is a 
member of the SQL Server SYSADMIN Role. The default SYSADMIN account for 
SQL Server is sa. If you use the SQL Server Username and Password, ensure that 
the server security is configured to support Mixed Mode. 

 SQL Password — Enter the password associated with this SQL Username. 

 Windows Integrated — Selecting this option means that if you are logged onto the 
server with the appropriate administrative rights, you can be authenticated to your 
SQL server via your Windows account. Your current Windows account must also be 
a member of the SYSADMIN role in the Microsoft SQL Server to perform the 
installation. If you are using integrated authentication, ensure that your current 
logged in account is a member of the SYSADMIN role in SQL Server. When SQL 
Server is installed, it does not add members of the local administrator’s group to the 
SQL Server SYSADMIN role by default.  

 

If you encounter errors connecting to the database, see Vision Installation Programs for 
additional connection information. 

10. Make sure your connection is configured correctly before you continue. If the installation 
program cannot connect to the database using the username/password you entered, 
when you click Next, a message displays asking you to try again. Click OK, correct the 
problem, and continue.  

11. Click Next to continue.  

12. On the Databases to Restore page, select the database that you want to restore, if any. 
The database that you select determines the language that displays in the Vision user 
interface. 

 No Selection (No Boxes checked) — If you already have a Vision database or 
previous Sample database, you can click on Next without making a selection. During 
the Web/Application server tier installation, the installer will prompt you to choose the 
database(s) to upgrade when it detects them. 

 Blank Database (Vision – US) — Select this option to start a new Vision database.  

 Blank Database (Vision – English International) — Select this option to start a new 
Vision database if you are using an English Language installation and are outside the 
United States. 

 Blank Database (Vision – Dutch) — Select this option to install a blank database for 
Dutch Language installations.  
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 Blank Database (Vision – German) — Select this option to install a blank database 
for German Language installations.  

 Sample Database (VisionDemo76) — Select this option to install the Vision sample 
database. It is sometimes helpful to have this database installed for troubleshooting 
purposes. If you already have a previous version of the Sample Database, the 
following options are available: 

 Do not select Sample Database. The setup will detect supported previous 
versions of databases (including the Sample database) and give you the 
opportunity to upgrade your Sample database.  

 In most cases any previous versions of the Sample database may have the 
Vision database version number in its name (for example, VisionDemo73). If that 
is the case, when you convert a previous version demo database to the current 
release, the version it is upgraded to will no longer match the version number in 
its name. You can perform one of the following actions: 

 Delete the previous version’s Sample database on your SQL Server before 
continuing, then choose to restore the Sample database. Deltek 
recommends this option. 

 Rename the database on the SQL Server and in WebLink after the 
installation to reflect the correct version number. 

 Allow the installation to restore a new VisionDemo76 Sample database 
without removing the previous copy. 

13. Click Next to continue.  

14. On the Error Reporting page, select Automatically send fatal error reports to Deltek 
and click Next.  

15. On the Customer Experience Improvement Program page, select Send installation data 
to Deltek and click Next. 

16. On the Start Copying Files page, review the installation settings. The information on the 
page should be saved. It contains information such as: 

 The location of the installation Log that tracks all the steps performed during the 
installation. 

 The installation directory – where you installed Vision. 

 The Setup Type and the option chosen – if you are performing a multi-server 
installation, this information is handy to use to know what your next option to choose 
when performing the installation on your other servers. 

 Information about the database server such as: 

 Database server name 

 Database login used to perform the installation on the database server 

 Any Vision logins and passwords created in SQL Server during the installation. 
This information can be used when configuring WebLink. It is recommended that 
you change at least the passwords from their defaults and/or the login name as 
well.  

 Any databases that you will be restoring or upgrading will be listed 

17. Click Next to begin installation of the database server as part of a three or more server 
installation. 
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18. On the Deltek Vision Installation Wizard Complete screen, click Finish. You can restart 
your computer after installing Vision.  

You have successfully installed the Database Server tier on a server. Proceed to Step 2: Install 
the Report Server.  

 

If you encountered any errors during the installation, contact Deltek Customer Care and send 
them the installation log file. See Log Files for more information. 

 

During installation of the database tier, the Vision backup device is created on the database 
server to allow users to perform ad hoc database backups before major data changes or 
processes take place. To back up the database, select Utilities » Backup Database from the 
Vision Navigation menu. 

Step 2: Install the Report Server  

 

Review the Preinstallation Checklist before you begin you installation. 

To install the Report Server: 

1. Double-click the DeltekVision76.exe file that you downloaded to run the installation.  

2. When you download the Vision installation, an email containing the installation password 
and your license information is sent to your email address. . 

The Prerequisites page of the InstallShield Wizard displays. This screen shows the items 
that the installation checks for. If the criteria are not met for the particular tier, setup may 
exit or display a warning.  

3. Ensure that your environment meets all prerequisites and click Next.  

4. On the Welcome page, click Next. 

5. On the License Agreement page, read the agreement and select I accept the terms of 
the license agreement if you agree. Click Next.  

6. On the Choose Destination Location page, complete one of the following actions: 

 Click Next to accept the destination displayed on the form. 

 Click Browse, select an alternate destination, and click Next. 

If you do not have at least 1GB of free space in the Destination location, Vision displays 
an error message. Change the path to select a folder with over 1GB of free space and 
click Retry. 

7. On the Number of Vision Servers page, select Three or more Servers and click Next.  

8. On the Select Server role page, select Report Server and click Next.  

The Checking configuration of Microsoft SQL Reporting Services page displays.  

The setup, when performed with any deployment model that has the Web tier option, will 
try to connect to the Microsoft SQL Reporting Services Web Service to verify connectivity 
to the Report Server.  It uses a standard Report Server URL definition (containing the 
server name) to make the connection. If it is unable to make a connection to the 
Reporting Service Web Service page, setup will return an error message with the reason 
it is unable to make the connection and will display the Specify Report Server and Report 

http://support.deltek.com/
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Server URL Information form. Setup will continue to the next step when the connection is 
complete. 

 

For additional information, see How to Connect to Report Server Web Service in 
Appendix C. 

If setup detects a version that is supported but lower than the recommended supported 
version of Microsoft SQL Server Reporting Services, it will display a warning message 
along with the recommended version and will continue. 

9. On the Customer Experience Improvement Program page, select Send installation data 
to Deltek and click Next. 

10. On the Start Copying Files page, review the installation settings. 

 

Important Information about Configuring Report Services 

If you will be using the server-side printing functionality of Vision, see Appendix D: 
Printing in Vision for instructions on where and how to configure the account. 

If you configured the Report Server Service Account to be a domain account, Reporting 
Services will use Kerberos Authentication by default. You must ensure that you have 
created an SPN for the account. To configure an SPN, complete the steps in this 
Microsoft link:  http://msdn.microsoft.com/en-us/library/cc281382.aspx 

Alternatively, you can configure the RSReportServer.config file with the following XML 
structure that specifies NTLM only. This is for deployments that do not support 
Kerberos or to work around Kerberos authentication errors (HTTP 401 errors) : 

<AuthenticationTypes> 

<RSWindowsNTLM/> 

</AuthenticationTypes> 

For details about Kerberos related authentication issues, see the following Microsoft 
documentation:   http://msdn.microsoft.com/en-us/library/cc281253.aspx 

11. After you review the installation settings, click Next to begin installation of a report server, 
as part of a three or more server installation. 

 

During installation, setup creates a local DeltekVision account and assigns rights within 
SQL Server Reporting Services (SSRS). 

12. If you want to install additional report servers, repeat these steps on any machine where 
you want to install additional report servers. Ensure that your SQL Server Edition and 
number of licenses support multiple report servers. 

You have successfully installed the Report Server tier on the current server. Proceed to Step 3: 
Install the Web/Application Server to install the Web/Application Server on a different server 
machine. 

 

If you encountered any errors during the installation, contact Deltek Customer Care and send 
them the installation log file. See Log Files for more information. 

http://msdn.microsoft.com/en-us/library/cc281253.aspx
http://support.deltek.com/
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Step 3: Install the Web/Application Server  

 

Review the Preinstallation Checklist before you begin you installation. 

To install the Web\application Server: 

1. Double-click the DeltekVision76.exe file that you downloaded to run the installation.  

When you download the Vision installation, an email containing the installation password 
and your license information is sent to your email address. .  

The Prerequisites page of the InstallShield Wizard displays. This screen shows the items 
that the installation checks for. If the criteria are not met for the particular tier, setup may 
exit or display a warning.  

2. Ensure that your environment meets all prerequisites and click Next.  

3. On the Welcome page, click Next.  

4. On the License Agreement page, review the agreement and click the I accept the terms 
of the license agreement option if you agree. Click Next.  

5. On the Choose Destination Location page, complete one of the following actions: 

 Click Next to accept the destination displayed on the form. 

 Click Browse…, select an alternate destination, and click Next. 

If you do not have at least 1GB of free space in the Destination location, Vision displays 
an error message. Change the path to select a folder with over 1GB of free space and 
click Retry. 

6. On the Number of Vision Servers page, select Three or more Servers and click Next.  

7. On the Select Server Role page, select Web/Application Server and click Next.  

8. On the Reports to Load page, select the language to load and click Next. 

The Vision installation includes the language options that you are licensed to use. If you 
have other report languages loaded, setup will also select those languages to reload. 

9. On the Database Server (MSSQL) Setup Connection Information page enter the 
following: 

 Database Server – Enter the name of the database server. 

 SQL Username – Enter a Microsoft SQL database server login/username that is a 
member of the SQL Server SYSADMIN Role. The default SYSADMIN account for 
SQL Server is sa. If you use the SQL Server Username and Password, ensure that 
the server security is configured to support Mixed Mode. 

 SQL Password — Enter the password associated with this SQL Username. 

 Windows Integrated — Selecting this option means that if you are logged on to the 
server with the appropriate administrative rights, you can be authenticated to your 
SQL server via your Windows account. Your current Windows account must also be 
a member of the SYSADMIN role in the Microsoft SQL Server to perform the 
installation. If you are using integrated authentication, ensure that your current 
logged in account is a member of the SYSADMIN role in SQL Server. When SQL 
Server is installed, it does not add members of the local administrator’s group to the 
SQL Server SYSADMIN role by default.  
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10. You must make sure your connection is configured correctly before you can continue. If 
the installation program cannot connect to the database using the username/password 
you entered, when you click Next, a message displays asking you to try again.  

11. Click OK, correct the problem, and continue. 

The Specify Report Server and Port Information page displays if setup is unable to detect 
the report server. 

12. Enter the following report server information: 

 Report Server — Enter the host name of the server where you installed your Vision 
report server.  

 Report Server URL — Setup auto-completes the report server URL based on the 
server name you enter in the Report Server field and the instance (if you specified 
an instance name).   

The setup, when performed with any deployment model that has the Web tier option, will 
try to connect to the Microsoft SQL Reporting Services Web Service to verify connectivity 
to the Report Server.  It uses a standard Report Server URL definition (containing the 
server name) to make the connection. If it is unable to make a connection to the 
Reporting Service Web Service page, setup will return an error message with the reason 
it is unable to make the connection and will display the Specify Report Server and Report 
Server URL Information form. Continue to the next step when the connection is complete. 

 

For additional information, see How to Connect to Report Server Web Service in 
Appendix C. 

13. On the SQL Report Database Server Setup page, enter the following report database 
server information: 

 Report Database Server — Enter the name of the Database Server that has the 
Report Server databases. 

 Select Windows Integrated or enter the SQL Login/Password: 

 SQL Login — The default SYSADMIN account for SQL Server is sa. If you use 
the SQL Server Username and Password, ensure that the server security is 
configured to support Mixed Mode Security.  

 SQL Password — Enter the password associated with this SQL Login. 

 ReportServer Database — Enter the name of your ReportServer Database. 
Typically, the default name for this database is ReportServer. If you have an 
instance, then it is ReportServer$InstanceName. 

 ReportServerTempDB Database — Enter the name of your ReportServerTempDB 
Database. Typically, the default name for this database is ReportServerTempDB. If 
you have an instance, then it is ReportServer$InstanceNameTempDB. If you did 
not choose the default names or you are unable to recall the name of your 
ReportServer databases, follow the steps in the SQL Report Server Database Setup 
Connection Information section to identify them. 
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If the SQL Login does not have db_owner membership of the Report Server and 
ReportServerTempDB databases, setup displays the message below and includes 
additional details in the installation log. Setup is then unable to continue until the SQL 
user name account specified is given the appropriate rights. 

14. The next screen to display depends on your database version: 

 If your database is already at the current release, the Database to Upgrade screen 
does not display and you can skip this step. 

 If your database is older than version 6.x, a message displays letting you know that 
there are no valid databases to convert. You must manually convert those databases 
to a minimum of version 6.x then upgrade to the current release. 

 

To upgrade your database to 6.x, see Converting a Database During Installation. 

 If your database version is 6.x, the Database to Upgrade page displays:  

a. If there are any existing Vision 6.x databases on your database server, setup will 
detect and display the databases and their version numbers on the Database to 
Upgrade page.  

 

Before displaying the Database to Upgrade dialog box, setup will display a 
warning message:  "If a database contains custom objects do not select it for 
automatic upgrade. For those databases you would drop the custom objects, 
manually run the upgrade scripts, and then re-apply the custom objects…"   

If you have added any custom indexes, triggers, and so on to your database 
you must remove them before performing the conversion to ensure they do 
not affect the conversion 

 

If you do not remove any custom indexes, triggers, and so on that you 
added, the conversion may fail.  If it fails, you must restore the database, 
remove the objects, convert the database and reapply your changes. 

b. Complete one of the following actions: 

 Select a database to upgrade. If you upgrade a database, the setup process 
will make a backup of the database on your SQL Server in the default 
backup location before converting the database. If setup is unable to make 
the backup because of insufficient space or any other reason, the database 
will not be converted and an error message will display during the 
installation. This error will also be logged in the log file so that when you 
review the log file you can be reminded to convert the database manually.  

 Click Next to bypass this form.  

 If you choose the I will backup and upgrade the database myself after the 
installation option, setup will return a message that you will need to convert 
the database manually.  

 

If you choose to upgrade the database manually outside of the 
installation, a database conversion log will not be created. You must 
therefore review the query results from your query window to verify that 
there were no errors. Do not close the query window until you review for 
errors.  If you encounter errors, save the output to a text file and submit 
it to Deltek Customer Care. 



 

 

Technical Installation Guide 71 

 

 If you are installing any tier that included the Web/application tier and did not 
restore or upgrade a database that is already at the current released version 
and setup does not detect any existing Vision 6.x databases on your 
database server, setup will display a message window stating that a 
database is required to continue and will exit. 

c. Manually create a backup of your database before you run the database 
conversion using the Deltekvision76.sql script file located in the <Installation 
folder>\databases\scripts folder.  The default location is C:\program 
files\Deltek\Vision\Databases\Scripts folder.  

Do not run the UnicodeDeltekvision76.sql or other script files unless directed to 
by Deltek Customer Care. If you plan to convert your Vision database to 
Unicode, refer to the Vision Help for the appropriate steps. 

15. Click Next.  

16. If you have more than one database, on the Databases Available for Logon screen select 
the databases that you want to make available to Vision users on the Vision login screen. 
The list displayed here includes: 

 The databases you selected to upgrade, along with their current version numbers (if 
any were selected). 

 The sample database (if restored or upgraded). 

 The blank database (if restored). 

 Any current version databases already previously restored or converted on your 
database server. 

You must select at least one database. You can use WebLink after installation to add or 
remove new databases.  

This page does not display if you do not have more than one database or did not choose 
to upgrade any databases and there is only one existing Vision 7.6 database. 

17. Click Next to continue.  

18. On the Specify Web Site page, select the web site to which you will install Vision and 
click Next.  

This page displays only if your Web server contains multiple web sites. If you are 
installing to an existing SharePoint server, SharePoint web sites are omitted from the list. 

If your Web server does not contain multiple web sites, skip to the next step. 

19. On the Error Reporting page, select Automatically send fatal error reports to Deltek, 
and click Next.  

20. On the Customer Experience Improvement Program page, select Send installation data 
to Deltek and click Next. 

21. On the Start Copying Files page, review the installation settings. The information on this 
page is also recorded in the Installation Log for future reference. It contains information 
such as: 

 The location of the installation log that tracks the steps performed during the 
installation. 

 The installation directory where you installed Vision. 
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 The Setup Type and the option chosen. If you are performing a multi-server 
installation, this information is handy as it contains information required when 
installing on multiple server installations. 

 Information about the Web/application/report server configurations such as: 

 Web Site, Virtual Directory, Virtual Directory Security Mode 

 Any local Windows accounts that were created for the setup including their 
Password.  

 Database/Report server name and report server URL. 

 List of databases that will be converted. 

 List of databases that will appear in WebLink after the installation. 

22. Click Next. 

23. On the Deltek Vision Installation Wizard Complete page, click Finish. If prompted, you 
can restart your computer after installing Vision.  

Repeat the steps in this section on any machine where you would like to install additional 
Web/application Servers.  

You have successfully installed the Web/Application Server tiers on the current server. Proceed 
to Step 4: Install the Process Server to install the Process Server on a different server machine.  

 

If you encountered any errors during the installation, contact Deltek Customer Care and send 
them the installation log file. See Log Files for more information. 

Step 4: Install the Process Server  

 

Review the Preinstallation Checklist before you begin you installation. 

To install the Process Server: 

1. Double-click the DeltekVision76.exe file that you downloaded to run the installation.  

2. When you download the Vision installation, an email containing the installation password 
and your license information is sent to your email address.  

The Prerequisites page of the InstallShield Wizard displays. This screen shows the items 
that the installation checks for. If the criteria are not met for the particular tier, setup may 
exit or display a warning.  

3. Ensure that your environment meets all prerequisites and click Next. 

4. On the Welcome page, click Next.  

5. On the License Agreement page, review the agreement and click the I accept the terms 
of the license agreement option if you agree. Click Next.  

6. On the Choose Destination Location page, complete one of the following actions: 

 Click Next to accept the destination displayed on the form. 

 Click Browse, select an alternate destination, and click Next.  

7. On the Number of Vision Servers page, select Three or more Servers and click Next.  

8. On the Select Server role, click Next to continue.  

http://support.deltek.com/
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9. If IIS is enabled on the server, a message displays. Click OK to continue.  

10. Browse to the databases.enc file (located on the Web server) and click Next. 

Setup displays the warning message that the process server should be updated if you 
change your entries in WebLink on the Web server.  

11. Click OK to continue. 

12. On the Error Reporting page, select Automatically send fatal error reports to Deltek, 
then click Next. The Start Copying Files page displays. 

 

If you are performing a Process Server tier upgrade and had previously made any edits to the 
Deltek.Vision.ProcessServer.Server.exe.config file to customize Process Server behavior such 
as the number of emails being sent at a time (EmailChunkSize) or the maximum size of an 
email (MaxEmailSize), after the installation is completed, login to the application and follow the 
steps in the Custom web.config Settings Migration section to ensure they are applied. If they 
are not, apply them as needed. 

You have successfully installed the Process Server tiers on the current server. 

 

Repeat the steps in this section for any machine on which you would like to install additional 
Process Servers. 

Refer to Step 2 of the Web Server post-installation checklist to add and configure dedicated 
process servers in Vision. 

 

If you encountered any errors during the installation, contact Deltek Customer Care and send 
them the installation log file. See Log Files for more information. 

http://support.deltek.com/
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Installation Steps (Vision Upgrades)  
Deltek encourages clients to upgrade to the latest version of Vision because: 

 New features are added only to the latest version. 

 Except in critical situations, Deltek fixes software issues only in the latest version. 

 Deltek support is typically available only for the latest and the next previous versions. 

 The latest version incorporates the newest technologies and tools. 

Before upgrading, you should first review the Deltek Vision Release Notes and perform a test 
conversion and test installation of the new version to ensure that your firm’s business processes 
are working properly in the new version.  

 

Deltek’s Global Services team is available to support you as you plan for this upgrade. We offer 
both technical and custom services to ensure the best possible Deltek experience. Contact 
VisionConsulting@deltek.com. 

Upgrade from Vision 7.5 
If you are upgrading from Vision 7.5, the upgrade detects the Vision 7.5 installation and installs 
directly into the existing folder structure using the current Vision settings. 

Upgrade from Vision 7.4 or Earlier Versions 
If you are upgrading from Vision 7.4 or an earlier version: 

 The upgrade process does not install directly into the existing folder structure. 

 Vision 7.6 installs into a new folder structure while preserving and “remembering” settings 
from your previous Vision installation. 

 The Vision 7.6 installation: 

 Detects the existing deployment model and makes recommendations and 
prepopulates settings based on that deployment model.  

 Takes settings from your existing web.config and databases.enc files and uses them 
to create a script that you can apply after the installation to upgrade your database. 
This script is created only during the installation on the Web/Application tiers because 
that is where the web.config and databases.enc files are located. 

 Supports upgrades from Vision 6.x and 7.x. on all tiers: Web, Application, Process 
Server, Report, and Database.  

Do Not Uninstall the Prior Version before Installing Vision 7.6 
Because the Vision 7.6 installer preserves and applies settings from your existing 
implementation, you should not uninstall Vision before installing Vision 7.6.  

You should also save any custom DLLs or reports for use by Vision 7.6. 

After you perform the installation and confirm that your settings migrated correctly, you can delete 
the old installation directories. 

mailto:VisionConsulting@deltek.com
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Migrating/Upgrading to a New Server 
If your existing Vision Web/Application Server is on a version of Windows that is no longer 
supported, you must perform a new installation. Any custom reports, DLLs, web.config settings, 
or other configuration changes that are on the server will not be migrated.   

Review the summary of changes below. If you customized your previous version, you will have to 
apply the customization again to the new deployment, keeping in mind the changes listed in the 
tables below. 

If your existing Vision Database/Report server is on a version that is no longer supported, you 
must restore or move your database to the new server prior to performing the installation. 

Installation Location/Configurations 

Configuration Previous New 

Installation 
Location  

<drive>:\Program Files 
(x86)\Deltek\Vision 

 New default folder location is  
<drive>:\Program Files\Deltek\Vision 

 The previous folder (typically found in the 32-
bit program files folder is renamed 

 “OLD” is appended to the end of the 
folder name. For example VisionOLD. 

 A readme.txt file is inserted into the 
renamed folder.  It contains the text:  
“This is a previously used Deltek Vision 
directory that is no longer used and can 
be safely removed after ensuring that all 
of your custom DLLs and custom reports 
have been copied to the new directory 
(<drive>:\Program Files\Deltek\Vision\)”  

Programs and 
Features 

Deltek Vision 7.4 or 
earlier version 

Previous version (Deltek Vision 7.4 or earlier 
version) is removed from Add/Remove Programs 
and replaced with new Deltek Vision 7.6 product 
name and release GUID. 

Registry Key 
Location 

HKLM\Software\Wow64
32\Deltek\Vision 

 HKLM\Software\Deltek\Vision 

 The entries in the previous registry location 
below the Vision folder are removed. 

Application Pool Application Pool is not 
removed 

 Existing Application Pool is updated with the 
following: 

 Updates the Enable32bitOnWow64 
from True to False 

Virtual 
Directories/ 
Applications 

Virtual 
Directories/Applications 
remains. 

Virtual Directories/Applications physical directory 
are changed to the new “<drive>:\Program 
Files\Deltek\Vision” TARGETDIR 
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Configuration Previous New 

Process Server 
Configuration 
and executable 

Process Server service   Process Server executable uses the new 
“<drive>:\Program Files\Deltek\Vision” 
TARGETDIR location. 

 If you changed the Process Server service 
identity account after installing a previous 
version of Vision, Vision prompts you to enter 
the credentials password for the account 
during the upgrade installation on any tier 
that contains the Process Server service.  

 If you do not know the password, type the 
text bypass and the installation continues 
without setting the password on the identity 
for the service.  After installation, you must 
update the Deltek Vision Process Server 
service account with the correct password or 
the service will not start. 

Custom Web.Config Settings Migration 
Some custom settings added to the web.config file on the web/application server have been 
migrated to the database and can be configured from within the application. Because of this 
change, database upgrades are only supported from any deployment option that includes the 
Web/Application tier installations. 

During any installation using a deployment option with the web/application tier installations, setup 
copies the prior version’s web.config file and uses it. It reads the web.config from the prior 
deployment and dynamically creates a v_WebConfigMigration.sql script file containing the custom 
settings noted below and builds the master upgrade script with those new settings so that the 
database is updated accordingly.  You can still choose to upgrade databases post installation. 

On upgrades, unused web.config values are commented out and others that were migrated to the 
database are removed. 

Original Setting New Location in Database 
(Table.Field) 

How to Edit:   

Launch Application » Navigate to 
Configuration » General » 
System Settings » 

MaxEmailSize CFGEmail.MaxEmailSize Email Tab » Email Size Limit 
(Megabytes) 

EmailChunkSize CFGEmail.EmailChunkSize Email Tab » Number of Emails to 
Send at Once 

WebAPI.EnableW
orkflow 

FW_CFGSystem.WebAPIEnableWorkfl
ow 

Miscellaneous Tab » Workflow 
section » Allow APIs to Trigger 
Workflows 

SessionTimeout FW_CFGSystem.SessionTimeout Miscellaneous Tab » Application 
Session Timeout (minutes) 

AllowFileSave FW_CFGSystem.AllowFileSave Miscellaneous Tab » Export Reports 
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Original Setting New Location in Database 
(Table.Field) 

How to Edit:   

Launch Application » Navigate to 
Configuration » General » 
System Settings » 

as Files Section 

Custom Changes Applied at Customer Sites 
If you have customized Vision previously: 

 Custom DLLs – You need to test all custom workflow DLLs (and any third party DLLs) to 
verify that they work in 64-bit mode. If they are compiled with AnyCPU, they should work. 
After testing, you can copy them into the new installation folder 

 Custom Reports (not in the database) – You need to copy all custom reports not 
stored in the report server database to the new installation folder and Load Report Files  
into the database.  

Option to Use HTTPS for Reporting Services Server-Side Calls 
A new check box, Use HTTPS for Reporting Services server-side calls, has been added to the 
Report Server tab in WebLink. It allows you to use HTTPS for server-side calls.  

Running reports involves both server-side calls (from the web/application server to the SSRS 
server) and client-side calls (from the Vision Smart Client to the SSRS server). By default, all 
server-side calls to SSRS will use HTTP and client-side calls to SSRS will use whatever protocol 
(HTTP or HTTPS) was used to access the Vision application. 

 Select Use HTTPS for Reporting Services server-side calls to use HTTPS for server-
side calls to the SSRS server. This will not affect client-side calls. 

 If you are using HTTP to access Vision, do not select this check box. It is designed to be 
used only with an SSL configuration.   

 If you are using HTTPS for Vision and you select this check box, HTTPS will be used for 
both server-side and client-side calls to SSRS. 

Shared databases.enc File Path 
You can now use a shared databases.enc file path. If your Vision deployment includes multiple 
web/application servers, or even just a dedicated process server, the shared path will eliminate 
the need to synchronize changes made to databases.enc across your servers. 

 

See the Deltek Vision Advanced Technical Administration Guide for more information. 



 

 

Technical Installation Guide 78 

 

Changes to the Upgrade Installation Process 
This section includes a list of changes affecting the tiers in all the deployment/installation models.  

For example, if you are performing a Web/Application/Process Server installation for the Dual 
Server (Two-Tier) Configuration 1 deployment, the details listed in the Web/Application and 
Process Server tiers below will apply. 

 

For an overview of the logical tiers and deployment models, see: 

 Logical Tiers 

 Installation/Deployment Models 

Database Tier 

 

The installer will not create a Deltekvision76.sql database conversion script file. The database 
conversion script file is created only on the web/application server because the web.config file 
exists only on the web/application tier. 

 The Installer attempts to detect previous tier installations (deployment model) and makes 
a recommendation about what you should select on the dialog boxes. 

 A readme.txt file is inserted into the renamed folder, containing the following text:  

“This is a previously used Deltek Vision directory that is no longer used and can be safely 
removed after ensuring that all of your custom DLLs and custom reports have been 
copied to the new directory (<drive>:\Program Files\Deltek\Vision\).”  

 The Installer renames the previous product installation directory by appending “OLD” to 
the end of the folder name. For example, “C:\Program Files (x86)\Deltek\VisionOLD.” 

 The Installer removes Deltek Vision 7.5 (or previous version) from Add/Remove 
Programs. 

Report Tier 
 The Installer attempts to detect previous tier installations (deployment model) and makes 

a recommendation about what you should select in the dialog boxes. 

 A readme.txt file is inserted into the renamed folder, explaining that the original 
installation folder was renamed. On the report only tier, the folder may contain custom 
report images that must be moved to the new folder location.  

 The Installer renames the previous product installation directory by appending “OLD” to 
the end of the folder name. For example, “C:\Program Files (x86)\Deltek\VisionOLD.” 

 The installer removes Deltek Vision 7.5 (or previous version) from Add/Remove 
Programs. 

Web / Application Tier 
 The Installer attempts to detect previous tier installations (deployment model) and makes 

a recommendation about what you should select in the dialog boxes. 

 The Installer attempts to detect a previous installation directory. 

 The Installer copies the databases.enc and web.config files from the previous 
installation and uses them for the new installation.   
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 The Installer applies applicable web.config changes detected from your old 
web.config file to the new installation (depending on the previous version from which 
it is upgrading). 

 The Installer creates the Deltekvision76.sql script file for upgrading the database only on 
the web/application server tier because the web.config file exists only on the 
web/application tier. 

 The Installer attempts to detect the existing DeltekVisionAppPool and detects Vision and 
VisionClient IIS application/virtual directories. It keeps the existing application pool and 
virtual directory custom configuration changes. 

This step is performed because some environment configurations may use different 
Application Pool identities, non-standard AppPool or virtual directory settings, non-
standard ports, SPNs, SharePoint, and so on. 

 
 
 

 A readme.txt file is inserted into the renamed folder, containing the text: “This is a 
previously used Deltek Vision directory that is no longer used and can be safely removed 
after ensuring that all of your custom DLLs and custom reports have been copied to the 
new directory (<drive>:\Program Files\Deltek\Vision\).” 

 The Installer uninstalls SQLXML 4.0 (SP2). 

 The Installer uninstalls Solid Documents (COM) and replaces it with Solid Documents 
(.NET). 

 The Installer renames the previous product installation directory by appending “OLD” to 
the end of the folder name. For example, “C:\Program Files (x86)\Deltek\VisionOLD.” 

 The Installer removes Deltek Vision 7.5 (or previous version) from Add/Remove 
Programs. 

Process Server Tier 
 Process Server is uninstalled from the previous installation directory and then installed 

using the new installation directory. 

 Service Identity 

 New Installations 

 Set to local DeltekVision. Uses the default password for the account created by 
the installer and sets start up mode to Automatic. 

 Upgrades 

 Identity is configured with the Deltek Vision default account. If setup cannot 
validate the local account, it will prompt you to enter a password for the identity. 
You can enter the text bypass as a password if validation fails or if you do not 
want to set the password during installation. You must set the password on the 
Process Server service after the installation or the service will fail to start. 

 Identity is configured with a domain account. Setup prompts you to enter a 
password. You can enter the text bypass as a password if validation fails or if 
you do not want to set the password during installation. You must set the 
password on the Process Server service after the installation or the service will 
fail to start. 
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• If the Process Server identity is configured with a domain account and, when 
performing the upgrade, you are logged into the server using a domain account, 
when you are asked for the domain password for the Process Server service 
identity, the account validation will be performed successfully. 

• If the Process Server is configured with a domain account and, when performing 
the upgrade, you are logged into the server using a local (non-domain) account, 
when you are asked for the domain password for the Process Server service 
identity, the account validation will fail, even when the credentials are entered 
correctly. To continue with the installation you must enter the text bypass. Then 
reset the password to the domain account password in the Services application 
after the installation is completed.  

 Identity is configured with the Windows LocalSystem account. Setup sets the 
identity to use the LocalSystem account after the upgrade. 

 The Installer sets the service start up mode to be the same as it was before the 
upgrade. 

 

If you entered the text bypass so that the installer could continue without validating the 
Process Server service identity, after the installation is complete, you must set the 
password on the Process Server service identity or the service will fail to start. 

 
 
 

 A readme.txt file is inserted into the renamed folder, containing the text:  “This is a 
previously used Deltek Vision directory that is no longer used and can be safely removed 
after ensuring that all of your custom DLLs and custom reports have been copied to the 
new directory (<drive>:\Program Files\Deltek\Vision\)” . 

 The Installer renames the previous product installation directory by appending “OLD” to 
the end of the folder name. For example, “C:\Program Files (x86)\Deltek\VisionOLD.” 

 The Installer removes Deltek Vision 7.5 (or previous version) from Add/Remove 
Programs. 

 

If you are performing a Process Server tier upgrade and had made any edits to the 
Deltek.Vision.ProcessServer.Server.exe.config file to customize Process Server behavior, such 
as the number of emails being sent at a time (EmailChunkSize) or the maximum size of an email 
(MaxEmailSize), log in to the application after the installation is completed and follow the steps 
in the Custom web.config Settings Migration section to ensure that they are applied. If they are 
not applied, apply them as needed. 

Considerations Prior to Upgrading 

Known Issue with the Vision Installation 
If you are upgrading from a 6.x version of Vision and you use a Microsoft SQL Server Session 
State that is located in a database other than your Vision database, see KB article # 72573 for 
additional instructions.  

During the Vision upgrade process from version 6.x or earlier, the SessionState table is renamed. 
However, if the table is not located in the Vision transaction database, it will not be renamed. You 
must manually rename the table using the instructions in the KB article. 
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Upgrading from Version 5.1 or Earlier 
 If you plan to upgrade your database during the installation, refer to the table in the 

Converting a Database During Installation section below. 

 Vision 5.1 installations did not support the currently supported Windows Operating 
Systems so all your deployments tiers will be run as a new installation.   

 

Before uninstalling your previous version of Vision, ensure that your hardware and software 
meet the minimum requirements for running this current Vision release. 

 

If you are using Vision 5.1 and have users connecting from the Internet outside of a Virtual 
Private Network (VPN), see the Deltek Vision Advanced Technical Administration Guide for 
advanced topics for configuring and securing connections to Vision. 

Database Upgrades 
 Vision database upgrades from Vision 6.x or 7.x are supported. 

 You cannot upgrade any Vision database from version 5.1 or older. 

 If your database is older than version 6.x, a message will display during the installation, 
letting you know that there are no valid databases to convert. You must manually convert 
those databases to a minimum of version 6.0 then upgrade to the current release.  

 

See Converting a Database During Installation below for more information. 

 Web Server installations create a Deltekvision76.sql file in the \program 
files\Deltek\Vision\Databases\Scripts folder that you can use to manually upgrade the 
database to the current version.  

To convert your database manually, create a backup of your database before you run the 
database conversion using the Deltekvision76.sql script file. Do not run 
UnicodeDeltekvision76.sql or other script files unless your database is Unicode. If you 
plan to convert your Vision database to Unicode, see the Vision online help for the 
appropriate steps. 

Converting Vision 5.x or Earlier Databases 
When completing the database portion of the installation process, Vision checks to see if there 
are any existing 6.x databases. If so, the Database to Upgrade screen displays. If you are 
migrating from a version prior to Vision 6.x, follow the steps listed in the table below on how to 
upgrade.  

Database Migration Path Table 

Database 
Migration Path 

Steps 

5.x to 6.x Log on to the Deltek Customer Care website. 

Select KB article # 43088, titled How to upgrade the Vision database. 
Download and run either DeltekVision61SP4_upgradescripts.zip or 
DeltekVision61SP2_upgradescripts.zip conversion script to convert your 
database to version 6.x. 

https://deltek.custhelp.com/app/answers/detail/a_id/43088/kw/43088


 

 

Technical Installation Guide 82 

 

Database 
Migration Path 

Steps 

4.x to 6.x Log on to the Deltek Customer Care website. 

1. Select KB article # 37233, titled How to Upgrade Vision from 3.0 to 5.0. 
Download and run the DeltekVision50.sql conversion script to convert 
your database to version 5.x. 

2. Select KB article # 43088, titled How to upgrade the Vision database. 
Download and run either DeltekVision61SP4_upgradescripts.zip or 
DeltekVision61SP2_upgradescripts.zip conversion script to convert 
your database to version 6.x. 

3.x to 6.x Log on to the Deltek Customer Care website. 

1. Select KB article # 37233, titled How to Upgrade Vision from 3.0 to 5.0. 

a. Download and run the DeltekVision41RTM.sql conversion script 
to convert your database to 4.x. 

b. Download and run the DeltekVision50.sql conversion script to 
convert your database to version 5.x. 

2. Select KB article # 43088, titled How to upgrade the Vision database. 
Download and run either DeltekVision61SP4_upgradescripts.zip or 
DeltekVision61SP2_upgradescripts.zip conversion script to convert 
your database to version 6.x. 

https://deltek.custhelp.com/app/answers/detail/a_id/37233/related/1
https://deltek.custhelp.com/app/answers/detail/a_id/43088/kw/43088
https://deltek.custhelp.com/app/answers/detail/a_id/37233/related/1
https://deltek.custhelp.com/app/answers/detail/a_id/43088/kw/43088
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Migrating from Deltek Legacy Products 
If you are migrating from an existing Deltek Advantage, Award, CRM and Proposals, or Sema4 
database to Vision, review the information below prior to installing Vision. 

Migrating from Deltek Advantage, Award, or CRM and Proposals 
To migrate: 

1. Install the Deltek Advantage to Deltek Vision, Deltek Award to Deltek Vision, or Deltek 
CRM and Proposals to Deltek Vision migration utility.  

You can obtain the installation utility from Vision 7.1 or earlier products from the Deltek 
Software Manager or KB Article # 11424 titled Where is Conversion Utility for Advantage 
to Vision? 

2. Run the Deltek Advantage to Deltek Vision migration utility, Deltek Award to Deltek Vision 
migration utility, or the Deltek CRM and Proposals to Deltek Vision migration utility. 

3. Install the Vision software. Do not select the Blank Database option during database tier 
installation.  

During Vision database tier installation, you will need your Microsoft SQL Server, or 
Microsoft SQL Server Express Edition, username and password.  

 

See Preinstallation Checklist prior to installation. 

Migrating from Sema4 
Deltek’s Data Migration group converts your Sema4 data to create your database backup file 
(.BAK). For instructions on migrating from Deltek Sema4 to Deltek Vision, contact your Deltek 
consultant. 

In all of the preceding scenarios, you can install a Sample Database along with your new or 
converted database. 

https://deltek.custhelp.com/app/answers/detail/a_id/11424
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Troubleshoot Vision 
This topic provides information about contacting Deltek if problems occur during installation. This 
topic also includes a list of errors that may occur during installation and possible solutions. 

Sending Files to Deltek 
If you encounter problems during the Vision installation on the server and are unable to continue, 
contact Deltek Customer Care for assistance and include the following information: 

 The DeltekVisionSetupLog.txt file stored in the 
C:\Users\%username%\AppData\Local folder of the administrator performing the 
installation on the Vision server.  

 Screenshots and details about the errors received. 

 

If you cannot access the DeltekVisionSetupLog.txt file directly from Windows Explorer, complete 
one of the following: 

 Copy and paste C:\Users\%username%\AppData\Local into your menu path to 
locate the folder.  

 Enter the %LocalAppData% variable at a Run prompt or in the Windows search box 
on the server.  

This information will help Deltek resolve your issue as quickly as possible. 

Troubleshoot Vision Tier Installation Messages 
This section documents messages that may display during installation of Vision tiers, with brief 
explanations and tips on how to proceed if you receive these messages. The following sections 
correspond to Vision tiers. 

All Tiers 

Free Space Error 

A warning can display during installation of any Vision tier, if you have less than 2 GB free on the 
drive. Deltek recommends having at least 2 GB of free disk space on the drive for any Vision tier. 
However, if you choose to continue with setup, you can.  

A message displays when any Vision tier has less than 1 GB free on the drive. The installation 
will halt and you will need to remove unneeded files so that there is a minimum of 1 GB free. 

Unsupported Environments Error 

A message displays when Terminal Services is installed. Note that you cannot install Vision on a 
Windows server with Terminal Services enabled.  
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Database Tier 
The following messages may display when installing the database tier, whether you install the 
database alone, or in conjunction with all other tiers.  

Cannot Connect to Database 

An “unable to validate connection to the database server” message may display after you click 
Next on the database page that contains the Database Server, Database Username, and 
Database Password fields. This message occurs if setup cannot successfully connect to the 
database server using the username and password that you entered. Setup will exit. 

No Database Selected 

A message box displays if you have no valid Vision databases to upgrade and you do not choose 
to restore a blank or demo database. Click OK to return to the restore window. You must either 
choose to restore a blank or demo database or click the Back button and select a database to 
upgrade. 

Report Tier 

 

If you experience errors connecting to the report server during installation, review the steps in 
How to Connect to Report Server Web Service in Appendix C. 

If you have configured the report server service account to be a domain account, Reporting 
Services will use Kerberos Authentication by default. To prevent HTTP 401 errors when you 
install the Vision Web tier, to test the Vision WebLink connections to Reporting Services, or to 
load reports in Vision, you must perform one of the following actions: 

 Create an SPN for the account. 

 Turn off Kerberos authentication in the rsreportserver.config file on the report server. 

Complete one of the following steps: 

 To configure an SPN, log on to a domain controller as a domain administrator and 
complete the steps in the following Microsoft link: http://msdn.microsoft.com/en-
us/library/cc281382.aspx. Do not specify a port in the command syntax as suggested 
from the Microsoft link. 

The screen shot below is an example of the syntax used to add an SPN (setspn -a) for 
the report server’s NETBIOS and FQDN names with a domain account as well as the 
syntax to show a list (setspn -l) of the registered SPNs for the domain account. In the 
screenshot example below, the domain=applebartlett.com, report server 
name=CAMOPSK33TRPT and the account name=RSAccount. 

http://msdn.microsoft.com/en-us/library/cc281382.aspx
http://msdn.microsoft.com/en-us/library/cc281382.aspx
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 Alternatively, instead of setting an SPN, you can configure the RSReportServer.config file 
with the following XML structure that specifies NTLM only. This is for deployments that do 
not support Kerberos or to work around Kerberos authentication errors (HTTP 401 
errors).  

By default this file is located in the Reporting Services Installation folder in a “\Reporting 
Services\ReportServer” subdirectory: 

<AuthenticationTypes> 

     <RSWindowsNTLM /> 

</AuthenticationTypes> 

You can find details related to Kerberos-related authentication issues and additional steps on 
how to edit the RSReportServer.config file in the following Microsoft Reporting Services 
documentation: http://msdn.microsoft.com/en-us/library/cc281253.aspx. 

Web/Application Tier 

Error: Running http://localhost/Vision/VisionServices.asmx 

 
 Problem: Missing runtime section in Vision web.config 

 Solution: Compare Web.config.template with web.config (specifically <runtime> section) 

http://msdn.microsoft.com/en-us/library/cc281253.aspx
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Error: Running Vision (500 error) and running http://localhost/Vision/VisionServices.asmx 

 
 Problem: Most likely a 32 bit DLL in the bin folder (see error for specific DLL) or 

Application Pool has Enable 32 bit applications set to True. 

 Solution: Could be a Custom DLL issue. Find 64-bit or AnyCPU compatibility DLL. Make 
sure Enable 32 bit applications is set to False. 

Error: Running Vision (500 error) and running http://localhost/Vision/VisionServices.asmx 

 
 Problem: Most likely Application Pool is set to v2.0 Framework. 

 Solution: Change Application Pool to v4.0 Framework. 
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Error: Running Vision (or WebLink) 

 
 Problem: databases.enc is missing or invalid or corrupt. 

 Solution: On new installations, make sure databases.enc exists. On upgrades, make 
sure databases.enc was copied from the previous installation directory. 
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Error: Running Vision (500 error) and running http://localhost/Vision/VisionServices.asmx 

 
 Check http://localhost/Vision/VisionServices.asmx and refer to previous errors. 

 Problem: Wrong physical path for virtual folder, could have a 32-bit DLL in the bin folder, 
AppPool set to wrong FW, or Enable32bit is enabled. 

 Solution: Check Physical folder path for Vision virtual directory, check bin directory, 
check IIS AppPool settings. 
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Post Installation (Vision New Installs) 
After you complete the installation process, verify the installation to confirm that all prerequisite 
software is installed and all installation steps were completed. 

To verify that your installation was successful: 

1. Open Internet Explorer and enter the URL to the Vision application.  

For example, http:\\<Web Server>\Vision. 

2. Click Deltek Vision or wait while the application loads.  

Vision displays the Vision logon form. 

3. Enter your User ID. If you are unsure of your user ID, enter admin. 

4. Enter your Password. If you are unsure of your password, leave this field blank. 

If you do not have a user ID and password, and a user ID of admin and a blank 
password do not work, contact Deltek Customer Care. 

5. Use the drop-down list to select the Database. 

6. Click Login. If the Vision application opens, displaying the Welcome page, your 
installation is successful. 

 

If there are any errors during the installation process when reloading reports, they will be listed 
in the installation log. Resolve any errors and reload your reports manually through the 
application.  

Backing Up Your Vision Database 
During installation of the database tier, the Vision backup device is created on the Database 
Server to allow you to perform ad hoc database backups before major data changes or processes 
take place.  

To back up the database, click Utilities » Backup Database on the Vision Navigation menu. 

Vision Configuration 
Review the Deltek Vision Implementation Guide for configuration and implementation information. 
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SDK Utility Installation 
The SDK is a self-extracting file named vbreporting.exe, containing the custom reporting business 
objects. It is installed on the web server into the <drive>:\Program 
Files\Deltek\Vision\Support\SDK folder.   

 

For instructions on building Vision reports, see the Vision online help system or contact Deltek 
Customer Care. 

For instructions on using the conversion utilities to convert an Advantage, Award, or Deltek CRM 
and Proposals database to Vision, please contact Deltek Customer Care. 
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Log Files 
Following an installation, Deltek recommends that you review the log files if you encounter any 
errors during the installation. If you find any errors, contact Deltek Customer Care with the 
contents of the log file. 

Temporary Log Files and the Log Files Folder 
All temporary log files are stored in the %localappdata% location 
(C:\Users\%username%\AppData\Local\) and a shortcut to the log file is added to the desktop. 
The log file name is similar to the name of the executable file but with a .txt file extension.  

When the installation is complete, the desktop shortcut is deleted and the log file is moved into a 
log subfolder located in the Vision installation folder location which contains the installation log as 
well as the logs created when the installation loads the reports into the Report Server and any 
subsequent database conversions from the database upgrade utility. 

Check Log Files After Installation 
The installation creates a logs subfolder, located in the \Program Files\Deltek\Vision folder, that 
contains the installation log as well as conversion log files created for each database that may 
have been upgraded during the installation.   

Installation Log 
To find errors in the log file, select one of the following actions: 

 Server installations — Search for the word error in the log file.  

 Database Upgrades — Search for “msg” in the log file.  

Log Files Generated During the Report-Loading Process 
If there are any errors during the installation process when reloading reports, they will be logged 
in the installation log. Resolve any errors and reload your reports manually through the 
application.  

If there are errors, you can reload your reports by accessing Utilities » Report Administration 
and clicking Load Report Files. 

Conversion Log 
If you upgraded any databases during the installation process, the installation creates database 
conversion log files, which are saved in the <drive>:\Program Files\Deltek\Vision\Logs\ScriptLogs 
folder. Database upgrade errors are listed in the errors.txt file.  

Upgrade the Database Manually  
A database conversion log will not be created if you choose to upgrade the database manually 
outside of the installation. You must therefore review the query results from your query window to 
verify that there were no errors. If you encounter errors, save the output to a text file and submit it 
to Deltek Customer Care. 

http://support.deltek.com/


 

 

Technical Installation Guide 93 

 

Appendix A: Microsoft Internet Information Server 
(IIS) Installation on Windows Server  

Microsoft (IIS) Is Already Installed 
If you have already enabled the Web Server role on your web server, then you need to check 
Features and Role Services. 

Windows Server 2012/2012 R2 

To check features and role services on Windows Server 2012/2012 R2: 

1. Launch Server Manager. 

2. In the left menu, click IIS. If the IIS option is not listed, perform the steps below for 
installing Microsoft IIS for the first time. 

3. In the Roles and Features group, verify that all of the required role services (as listed in 
the Installing Microsoft IIS for the First Time steps below) are installed.  

Installing Microsoft IIS for the First Time 
If you are installing Microsoft IIS for the first time, follow the steps below for the appropriate 
server. These steps are necessary for proper detection of ASP.NET. 

Windows Server 2012/2012 R2 

To install Microsoft IIS on Windows Server 2012/2012 R2: 

1. Logon to Microsoft Windows Server as a domain or local administrator. 

2. Launch Server Manager. 

3. Click Manage » Add Roles and features. 

4. In the Add Roles and Features Wizard, on the Before you begin screen click Next.  

5. On the Select installation type screen, select Role-based or feature-based installation 
and click Next.  

6. On the Select destination server screen, select your machine and click Next. 

7. On the Select server roles screen, select Web Server (IIS).  

8. On the Add Roles and Features Wizard dialog box, click Add Features. 

9. On the Select server roles screen, click Next. 

10. On the Select features screen, expand .NET Framework 4.5 Features and select .NET 
Framework 4.5 and ASP.NET 4.5. Click Next. 

 

These steps enable the .NET Framework features. However, you must also install the current 
supported version of the .NET Framework on the server, if you haven’t already. 

11. On the Web Server Role (IIS) screen, click Next. 
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12. On the Select role services screen, enable the following sub-options: 

 Web Server 

 Common HTTP Features 

 Default Document 

 Directory Browsing 

 HTTP Errors 

 Static Content 

 HTTP Redirection 

 Health and Diagnostics 

 HTTP Logging 

 Request Monitor 

 Tracing 

 Performance 

 Static Content Compression 

 Security 

 Windows Authentication (only necessary if you will be using it) 

 Request Filtering 

 Application Development 

 .NET Extensibility 4.5 

 ASP.NET 4.5 (Add Roles and Features Wizard dialog box displays when you 
select this option. Click Add Features button.) 

 CGI (Required if you will be using Deltek Touch products) 

 ISAPI Extensions 

 ISAPI Filters 

 Management Tools 

 IIS Management Console 

 IIS Management Scripts and Tools 

13. Click Next. 

14. Click Install on the Confirm Installation Instructions dialog box to begin the process. 

15. On the Installation Results dialog box, click Close. 

 

For detailed instructions on installing IIS on Windows Server 2012 / Windows Server 2012 R2, 
see http://www.iis.net/learn/install/installing-iis-85/installing-iis-85-on-windows-server-2012-r2  

http://www.iis.net/learn/install/installing-iis-85/installing-iis-85-on-windows-server-2012-r2
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Appendix B: Microsoft SQL Server Edition and 
Version Information 

Links to Recommended Microsoft SQL Server Service Packs and 
Cumulative Updates 

Microsoft® SQL Server® 2014 Service Pack 1 (SP1) 
 Microsoft SQL Server 2014 SP1 Update. This package contains the Microsoft SQL 

Server 2014 Service Pack 1 update to be applied to existing SQL Server 2014 
installations: http://www.microsoft.com/en-us/download/details.aspx?id=46694  

Microsoft® SQL Server® 2014 SP1 Express Edition 
 If you are using the free edition of SQL Server for the database and reporting services 

engine, download Microsoft SQL Server 2014 SP1 with Advanced Services: 
https://www.microsoft.com/en-us/download/details.aspx?id=46697  

Select ENU\x64\SQLEXPRADV_x64_ENU.exe (1.4 GB). 

 The following Microsoft link provides information on prerequisite requirements, release 
notes, an installation guide, and other helpful links for performing the SQL Server 
Express installation of SQL Server: https://www.microsoft.com/en-us/server-
cloud/products/sql-server-editions/sql-server-express.aspx  

Microsoft® SQL Server® 2014 SP1 Cumulative Update 
 Cumulative update package 6 for SQL Server 2014 SP1: 

http://catalog.update.microsoft.com/v7/site/Search.aspx?q=Microsoft%20SQL%20Server
%202014%20SP1%20Cumulative%20Update%20(CU)%206%20KB3167392%20 

Microsoft® SQL Server® 2012 SP3 
 Microsoft SQL Server 2012 SP3 for the database and reporting services engine:  

https://www.microsoft.com/en-us/download/details.aspx?id=49996 

 Cumulative update package 3 for SQL Server 2012 SP3:  
http://catalog.update.microsoft.com/v7/site/Search.aspx?q=Cumulative%20Update%203
%20for%20SQL%20Server%202012%20SP3 

Microsoft® SQL Server® Reporting Tools 
 Microsoft SQL Server Report Builder for Microsoft SQL Server 2014. You can use the 

Report Builder standalone version or the ClickOnce version of Report Builder installed 
with Reporting Services:  
https://www.microsoft.com/en-us/download/details.aspx?id=42301  

 Microsoft SQL Server Data Tools - Business Intelligence for Visual Studio 2013. Installs 
Microsoft SQL Server Data Tools Business Intelligence project templates for Analysis 
Services, Integration Services, and Reporting Services that support Visual Studio 2013 
and SQL Server 2014:  
https://www.microsoft.com/en-us/download/details.aspx?id=42313   

http://www.microsoft.com/en-us/download/details.aspx?id=46694
https://www.microsoft.com/en-us/download/details.aspx?id=46697
https://www.microsoft.com/en-us/server-cloud/products/sql-server-editions/sql-server-express.aspx
https://www.microsoft.com/en-us/server-cloud/products/sql-server-editions/sql-server-express.aspx
http://catalog.update.microsoft.com/v7/site/Search.aspx?q=Microsoft%20SQL%20Server%202014%20SP1%20Cumulative%20Update%20(CU)%206%20KB3167392%20
http://catalog.update.microsoft.com/v7/site/Search.aspx?q=Microsoft%20SQL%20Server%202014%20SP1%20Cumulative%20Update%20(CU)%206%20KB3167392%20
https://www.microsoft.com/en-us/download/details.aspx?id=49996
http://catalog.update.microsoft.com/v7/site/Search.aspx?q=Cumulative%20Update%203%20for%20SQL%20Server%202012%20SP3
http://catalog.update.microsoft.com/v7/site/Search.aspx?q=Cumulative%20Update%203%20for%20SQL%20Server%202012%20SP3
https://www.microsoft.com/en-us/download/details.aspx?id=42301
https://www.microsoft.com/en-us/download/details.aspx?id=42313
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Appendix C: Microsoft SQL Server Reporting 
Services 
Vision uses Microsoft SQL Server Reporting Services as its report management and delivery 
platform.  

There are several things to consider when you migrate to Vision: 

 SQL Server Reporting Services is not installed as part of the Vision installation. Vison 
setup requires that SQL Server Reporting Services be already installed and configured in 
order to connect to the report server. The next section provides links to Microsoft 
documentation that you can use in addition to the Microsoft documentation installed with 
your SQL Server installation.  

 

For related information, see Appendix C: Microsoft SQL Server Reporting Services. 

 The Vision reporting RDL schema (report definition language) supports the latest 
versions of SQL RS 2012 and 2014. SQL Server RS 2008 and 2005 Business 
Intelligence Development Studio (BIDS) are not supported with Vision 7.6.  

Overview of SQL Server Reporting Services 
Microsoft SQL Server Reporting Services is a server-based reporting platform that you can use to 
create and manage tabular, matrix, graphical, and free-form reports that contain data from 
relational and multidimensional data sources. The reports that you create can be viewed and 
managed over a World Wide Web-based connection. Reporting Services includes the following 
core components: 

 A complete set of tools that you can use to create, manage, and view reports. 

 A Report Server component that hosts and processes reports in a variety of formats. 
Output formats include HTML, PDF, TIFF, Excel, CSV, and more. 

 An API that allows developers to integrate or extend data and report processing in 
custom applications, or create custom tools to build and manage reports. 

The reports that you build can be based on relational or multidimensional data from SQL Server, 
Analysis Services, Oracle, or any Microsoft .NET data provider such as ODBC or OLE DB. You 
can create tabular, matrix, and free-form reports. You can also create ad hoc reports that use 
predefined models and data sources. 

Reporting Services use URLs to access the Report Server Web service and Report Manager. 
Before you can use either application, you must configure at least one URL each for the Web 
service and Report Manager. Reporting Services provides default values for both application 
URLs that work well in most deployment scenarios, including side-by-side deployments with other 
Web services and applications. 

Reporting Services use an SQL Server database for internal storage. The database is a required 
component. It is used to store reports, session data, resources, and server metadata. 

The migration to this tool includes the following benefits: 

 Ease of Deployment and Management — SSRS is embedded in the SQL Server the 
database clients already use. This streamlines deployment and updates and provides a 
platform for delivery of new functionality for years to come. 
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 Industry Leading Platform — SSRS is fast becoming one of the leading Business 
Intelligence (BI) platforms in the market. 

 Better Technology Alignment with Vision — SSRS aligns well with the rest of the 
Microsoft centric technology strategy for Vision. 

 

Scale-out configuration of SSRS is supported and provides a load balanced configuration for 
scalability. This requires the Enterprise Edition of SQL Server. 

How to Obtain Information about Reporting Services 
The best way to learn about Reporting Services and how to configure it is through the 
documentation included with your SQL Server (Books Online, Microsoft Labs, and so on). The 
following links provide steps for configuring the latest versions of Reporting Services: 

 For SQL Server Setup, Install and Upgrade (How-to Topics):  

http://msdn.microsoft.com/en-us/sqlserver/ff625277 

 For Configuring SQL Server Reporting Services (How-to Topics): 

http://msdn.microsoft.com/en-us/library/bb934490 

The following links provide additional information about Reporting Services: 

 Reporting Services Overview and Tutorials: 

http://msdn.microsoft.com/en-us/library/ms159106.aspx 

 Demos, Videos, Virtual Labs, Webcasts: 

http://msdn.microsoft.com/en-us/sqlserver 

Report Server Licensing Requirements 
The method you use to deploy your Report Server depends on the edition and licenses you own 
for your Microsoft SQL Server Database. If you plan to host your Reporting Services Web Service 
on a machine separate from the Reporting Services Report Server Database, you must 
determine whether your SQL Server edition and licenses can support this deployment. 

The following Microsoft link describes the licensing options available with SQL Server and 
Reporting Services: http://www.microsoft.com/en-us/server-cloud/products/sql-server/buy.aspx 

http://msdn.microsoft.com/en-us/sqlserver/ff625277
http://msdn.microsoft.com/en-us/library/bb934490(v=sql.100).aspx
http://msdn.microsoft.com/en-us/library/ms159106.aspx
http://msdn.microsoft.com/en-us/sqlserver
http://www.microsoft.com/en-us/server-cloud/products/sql-server/buy.aspx
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Features Supported by Different SQL Server Editions 
The table in this section outlines the licensing implications and impacts on functionality 
associated with the commonly used editions of Microsoft SQL Server available on the market 
today and supported by Vision.  

 Express w/Adv.  
Services 

Standard Business 
Intelligence 

Enterprise 

Custom Reporting 

Report Builder     

Report Models for Report 
Builder 

-    

Report Designer (SSDT-
BI) 

    

Standard Reporting 

Access to All Standard 
Reports 

    

Report History 
(Previously Run) 

-    

Email Reports -    

Email Report Links -    

Schedule Reports -    

Schedule and Report 
History 

-    

Search and Download in 
Preview 

-    

The following Microsoft link lists the features supported by the different editions of Microsoft SQL 
Server. Click Other Versions and select the version that you are using: 

https://msdn.microsoft.com/en-us/library/cc645993(v=sql.120).aspx 

https://msdn.microsoft.com/en-us/library/cc645993(v=sql.120).aspx
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Custom Reports and Custom Invoices 

Supported Report Writing Tools 
Vision 7.6 supports the following Microsoft SQL Server Reporting Services report writing tools for 
creating custom reports and custom invoices: 

  Report Builder 3.0 

 SQL Server Data Tools - Business Intelligence Report Writer for Visual Studio 2013 
(referred to as SSDT-BI 2013 Report Designer) 

These report writing tools produce a report file with the RDL 2010 schema that Vision 7.6 
requires. 

 

See the Deltek Vision 7.6 Custom Reports and Microsoft SQL Server Reporting Services Guide 
for information on: 

 Installing the supported report writing tools and the Microsoft links from which to 
download the software. 

 Creating custom reports. 

Upgrading Custom Reports and Custom Invoices 
If you are upgrading to Vision 7.6 from an earlier Vision version, see the Deltek Vision 7.6 
Custom Reports and Microsoft SQL Server Reporting Services Guide for upgrade instructions. 

Summary of Upgrading Custom Reports and Invoices 

Vision Version Upgrading 
From… Upgrade Action Required 

Deltek Vision 7.6 Custom 
Reports and Microsoft SQL 
Server Reporting Services 
Guide 

An earlier 7.x version 

(your custom reports and/or 
custom invoices have an RDL 
2005 or RDL 2008 schema) 

 

Upgrade your reports to the RDL 
2010 schema.  

See the “Custom Reports 
Created with Microsoft SQL 
Server Reporting Services 2005 
and 2008” section.  

A 6.x version 

(your custom reports and/or 
custom invoices have an RDL 
2005 schema) 

Complete both of the following: 

 Upgrade your reports to the 
RDL 2010 schema. 

 Perform additional steps for 
changes to some Vision 
database table names. 

See the following sections: 

 “Custom Reports Created 
with Microsoft SQL Server 
Reporting Services 2005 
and 2008” 

 “Vision Database Table 
Name Changes that Affect 
Custom Reports” section.  

A version earlier than 6.0 

(your custom reports and/or 
custom invoices were created 
with Actuate) 

Create new custom reports with 
a SQL Server Reporting Services 
report writing tool. 

See the “Custom Reports 
Created with Actuate” section.  
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How to Configure Microsoft SQL Server Reporting Services  
Use these steps to configure your SQL Server Reporting Services initial setup. This only needs to 
be done for Vision to verify SQL Server Reporting Services. However, Vision will use the 
accounts specified in the Report Server tab of WebLink to make connections to Reporting 
Services. 

 

For additional information about configuring Report Services, see Important Information about 
Configuring Report Services. 

To configure your initial setup: 

1. Click Start » All Programs » Microsoft SQL Server <Select Your Version> » 
Configuration Tools » Reporting Services Configuration Manager to launch the 
Reporting Services Configuration Wizard. 

2. On the Reporting Services Configuration Connection dialog box, select your SQL 
Reporting Services Instance Name then click Connect.  

 

If you have multiple installations of Reporting Services, you may see more than one 
instance. MSSQLServer is the default instance. 

3. On the Report Server Status pane of the Reporting Services Configuration Manager 
dialog box, click Start to start the Reporting Services instance. If it is already running, 
click Service Account in the left pane. 

4. On the Service Account pane of the Reporting Services Configuration Manager dialog 
box, choose the appropriate account and click Apply. Microsoft recommends using the 
Network Service account.  

 

For additional information on choosing a service account, see the Service Account 
Reporting Services Configuration topic for your version in SQL Server Books Online 
(http://msdn.microsoft.com/en-us/library/ms189964.aspx). 

http://msdn.microsoft.com/en-us/library/ms189964.aspx
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If you have configured the Report Server Service Account to be a domain account, 
Reporting Services will use Kerberos Authentication by default.  

5. The Service Account pane of Reporting Services Configuration Manager dialog box 
displays again showing the results in the bottom pane. Click Web Service URL in the left 
pane. 

The Web Service URL screen displays. 

6. On the Web Service URL pane of the Reporting Services Configuration Manager dialog 
box, accept the default values. The default value for Virtual Directory is ReportServer. 
If you installed Report Server as an instance, the virtual directory usually starts with 
ReportServer separated by a character, such as an underscore or dollar sign, and the 
instance name to differentiate itself from the others.  
 
Take note of the Report Server Web Service URL shown on the Web Service URL dialog 
box in case Vision is unable to connect to the Report Server during the installation and 
prompts you for the correct path. Click Apply to accept your settings. If the settings are 
correct, the Results pane displays the status. 

7. Click Database in the left pane. 

 

Vision uses the Report Server Web Service URL at the bottom of the dialog box as 
part of its test connection URL when it tries to connect to the Report Server. 

SQL Server Reporting Services does not require IIS to be enabled. 

8. In the Report Server Database pane of the Reporting Services Configuration Manager 
dialog box, click Change Database. The Change Database screen of the Report Server 
Database Configuration wizard displays.  

9. On the Change Database screen of the Report Server Database Configuration wizard, 
choose whether to create a new Report Server database or use an existing one. For a 
new installation, select Create a new report server database. Click Next. 

10. Enter the database Server Name and a user account that has the appropriate privilege to 
create or select the database and assign the required rights. 

a. Click Test Connection to test your credentials. Make the corrections as necessary if 
the server name or the user credentials are incorrect. 

b. Click OK when you have connected successfully to the database to go back to the 
Change Database of the screen of the Report Server Database Configuration wizard.  

c. Click Next. 

11. Accept the default values. Click Next.  

 

Only Native Mode is supported. Select Native Mode if it is not selected by default. 

12. In the Credentials pane of the Change Database screen, specify the type of credential 
and accounts for the Reporting Services connections to the database then click Next.  

13. The summary of the changes you made displays. Click Next. 

The Report Server Database Configuration Wizard displays the status of the steps taken 
to create the Report Server databases.  
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14. Click Finish when all steps have been marked as successfully completed.  

15. In the left pane of the Report Services Configuration Manager dialog box, click Report 
Manager URL. 

16. In the Report Manager URL pane, accept the default values. Then click Apply.  
The results pane displays the results. 

17. Click Encryption Keys in the left pane and back up the encryption keys to a safe 
location. Then click Apply.  

18. Click Exit. You are now ready to begin the Vision installation.  

 

Do not configure an Execution Account during the Report Server Configuration. 
Configuring this account causes the account specified in the Execution Account to be 
used instead of the credentials listed in WebLink. This may result in reporting errors in 
Vision. 

Important Information about Configuring Reporting Services 
 If you are not familiar with Microsoft Reporting Services or how to configure it, additional 

details and steps can be obtained from this Microsoft link: http://msdn.microsoft.com/en-
us/library/ms156305.aspx  

 If you will use the server-side printing functionality of Deltek Vision, see Appendix D: 
Printing in Vision for instructions on where and how to configure the account. 

 If you have configured the Report Server Service Account to be a domain account, 
Reporting Services will use Kerberos Authentication by default. You must ensure that you 
have created an SPN for the account. To configure an SPN, complete the steps in this 
Microsoft link: http://msdn.microsoft.com/en-us/library/cc281382.aspx.  

 Alternatively, you can configure the RSReportServer.config file with the following XML 
structure that specifies NTLM only. This is for deployments that do not support Kerberos 
or to work around Kerberos authentication errors (HTTP 401 errors) : 
<AuthenticationTypes> 

<RSWindowsNTLM/> 

</AuthenticationTypes> 

 

Details about Kerberos authentication issues can be found in the following Microsoft Reporting 
Services documentation: http://msdn.microsoft.com/en-us/library/cc281253.aspx. 

How to Connect to the Report Server Web Service 
SQL Server Reporting Services provides access to the full functionality of the Report Server 
through the Report Server Web Service. The Report Server Web Service is an XML Web service 
with a SOAP API. It uses SOAP over HTTP and acts as a communications interface between 
client programs and the Report Server. The Web service provides two endpoints: one for report 
execution and one for report management. Setup connects to the report execution endpoint. 

If it is unable to connect to the Reporting Service Web Service screen, setup returns an error 
message and displays the Specify Report Server and Report Server URL Information form.  

Specify Report Server and Report Server URL Information Screen 

Complete one of the following actions: 

http://msdn.microsoft.com/en-us/library/ms156305.aspx
http://msdn.microsoft.com/en-us/library/ms156305.aspx
http://msdn.microsoft.com/en-us/library/cc281382.aspx
http://msdn.microsoft.com/en-us/library/cc281253.aspx
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 Verify that the information on the screen is correct and click Next. 

 Update the fields with the correct values.  

  
 Report Server — The Report Server name is the name of your Report Server 

machine. Make sure that the Virtual Directory value matches the Virtual Directory of 
the Report Server displayed on the Reporting Services Configuration Manager dialog 
box. 

 Report Server URL — The following example shows the format of the URL used to 
connect to the Reporting Services Web Service on the Report Server: 

http://<Report Server Name>/Virtual Directory/reportservice2005.asmx 

 

The SQL Server Reporting Web Services (ReportingService2005.asmx) provides the 
interface for enumerating the reports and report folders. It provides a host of other capabilities 
for report execution, rendering and management.  

The “2005” in the web service name does not reflect any version of SQL Server. 

The following table describes each element in the URL.  

URL Element Description 

Server The name of the server on which the Report Server is deployed. 

Virtual Directory The name of the folder that contains the XML Web Service for 
report execution. This is configured during setup or when you run 
the Microsoft SQL Server Reporting Services Configuration tool. 
The default name//virtual directory is named reportserver. 

If you are unsure of the name of your Report Server virtual 
directory, launch the Reporting Services Configuration tool on the 
Report Server.  

Select the Web Service URL on the left, and then view the entry 



 

 

Technical Installation Guide 104 

 

URL Element Description 

from the Virtual Directory field on the right. If you install Reporting 
Services as an instance, the name of the virtual directory may also 
include the instance name. For example, 
reportserver_INSTANCENAME.  

<endpointname>.asmx The name of the web service endpoint is reportservice2005.asmx  

This is required in the URL for Vision to confirm the Report Server 
configuration. 

Reporting Services Web Service: The SQL Server Reporting Web 
Services (ReportingService2005.asmx –it has not been changed to 
match the SQL Server version) provides the interface for 
enumerating the reports and report folders. It provides a host of 
other capabilities for report execution, rendering and management. 

SQL Server Report Server Configuration Tool  

To identify the virtual directory required to detect Reporting Services for SQL Server: 

1. Click Start » All Programs » Microsoft SQL Server <Select Your Version> » 
Configuration Tools » Reporting Services Configuration Manager.  

2. Connect to the Report Server Web Service URL in the left pane. 

3. Check the Virtual Directory field in the right pane.  

 

Make sure that the entry in the Virtual Directory field matches the virtual directory 
entry listed on the Specify Report Server and Report Server URL form. 

If you have not configured SQL Reporting Services, click the Help icon in the lower left corner of 
the Reporting Services Configuration Manager dialog box to access Microsoft documentation for 
configuring Reporting Services. 
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SQL Report Server Database Setup Connection Screen  
If setup is unable to connect to the ReportServer Database Server or to identify the Reporting 
Services databases, then it may display the following screen: 

 
Enter the following: 

 Report Database Server — Enter the name of the Database Server that has the Report 
Server databases. 

 Select Windows Integrated or enter the SQL Login/Password: 

 SQL Login — The default SYSADMIN account for SQL Server is sa. If you use the 
SQL Server Username and Password, ensure that the server security is configured to 
support Mixed Mode Security.  

 SQL Password — Enter the password associated with this SQL Login. 

 ReportServer Database — Enter the name of your ReportServer Database. Typically, 
the default name for this database is ReportServer. If you have an instance, then it is 
ReportServer$InstanceName. 

 ReportServerTempDB Database — Enter the name of your ReportServerTempDB 
Database. Typically, the default name for this database is ReportServerTempDB. If you 
have an instance, then it is ReportServer$InstanceNameTempDB If you did not choose 
the default names or you are unable to recall the name of your ReportServer databases, 
follow the steps below to identify them. 
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If the SQL Login does not have db_owner membership of the Report Server and 
ReportServerTempDB databases, setup displays the message below and includes additional 
details in the installation log. Setup is then unable to continue until the SQL user name account 
specified is given the appropriate rights. 

To identify the names of the ReportServer and ReportServer TempDB databases that are 
required for setup to detect Reporting Services for SQL Server, complete the following 
steps on your Report Server: 

1. Click Start » All Programs » Microsoft SQL Server <Select your Version> » 
Configuration Tools » Reporting Services Configuration Manager. 

2. On the Reporting Services Configuration Manager dialog box, click Database in the left 
pane then click Change Database in the right pane. 

3. On the Change Database screen, select the Choose an existing report server 
database option. Click Next. The Change Database/Database Server screen displays.  

4. If you are: 

 Logged in as an Administrator, accept the default values to make a connection using 
Integrated Authentication.  

 Not logged in as an Administrator, select SQL Server Account from the 
Authentication Type drop-down list. Enter the System Administrator (SA) 
credentials in the Username and Password fields.  

5. Click Next. 

6. Use the Report Server Database drop-down list to view the names of the ReportServer 
and ReportServerTempDB databases. Take note of the names of the ReportServer and 
ReportServerTempDB databases. Click Cancel.   

7. Use the name of the ReportServer and ReportServerTempDB databases to populate the 
SQL Report Database Server Setup Connection screen that displays during the 
installation if the Report Server databases cannot be identified.  

 

See How to Configure Microsoft SQL Server Reporting Services in Appendix C for 
additional information. 

Extra Space in Invoice Header 
If you are using Vision with Microsoft SQL Server Reporting Services (SSRS), your invoices will 
print with extra space in the header when the top margins are expanded. This is a known issue 
with Microsoft SSRS. 
Deltek suggest that you carefully review your invoice templates, and wherever possible, reduce 
the top margins in the Vision Invoice Template Editor to prevent the extra space issue from 
occurring. 

How to Give Your Account Proper Rights and Privileges in 
Reporting Services Web Services 

Required Rights for Report Server Web Service 
During the installation of the Report Server, two types of credentials are required in order for the 
installation to complete successfully: 
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 A Windows Account with proper rights and privileges to the Report Server Web Services 
component. This account requires Content Manager and System Administrator privileges 
within the Reporting Services Report Manager Tool. (Prevents error: 401 unauthorized 
access when the installation is testing the connection to the Reporting Services Web 
Service and also when running reports). 

 A Report Server SQL Server database Login that is a member of the db_owner role for 
the ReportServer and ReportSeverTempDB databases and (if using a SQL Server 
database, your Vision database) 

To configure/verify proper rights and privileges to the Report Server Web Services 
Component: 

1. Log on locally to the report server desktop console with a Windows account that is a 
member of the local administrator group and launch Report Manager URL 
(http://localhost/reports):  

If you do not see the options below, launch Internet Explorer using the Run as 
administrator option in order to run Internet Explorer with elevated privileges. 

 

 

Although the Local Windows Administrator Group on the Report Server will appear as 
already being members of the Content Manager and System Administrator roles in 
Reporting Services, the account must still be explicitly granted those rights in order for 
the installation to be able to connect to Reporting Services and assign the proper 
privileges to the local Deltek Vision Windows account that the installer creates.  

You must be on the server and browse to the Report Manager URL using localhost as 
the server name (http://localhost/reports) in order to see the Report Manager 
configuration options. 

2. Click Folder Settings in the top of the SQL Server Reporting Services screen.  

3. Click New Role Assignment. 

4. Add the account you will be logged in as to perform the Vision installation to the content 
manager role. (During the installation, the account is used to connect to the report server 
and install the Vision reports into Reporting Services. These rights are also required by 
the account listed in WebLink in order to run the Vision reports). 

5. After the installation is complete, you can remove your Windows Domain Account if you 
prefer to not allow it to have rights to the reports. The installation creates an account 
named DeltekVision that is assigned the same rights listed in these steps in order to 
load and run Vision reports on behalf of Vision users.  

6. The account appears in the listing with the Content Manager rights. 

7. Click Site Settings in the top right section of the screen. 

8. Click Security. 

9. Click New Role Assignment.  

10. Enter your Windows Account in the box and check the box for System Administrator role.   

The account now has the necessary privileges to prevent a 401 Unauthorized error 
during installation or when testing and running reports. 

Prerequisite Report Server and SQL Server Database Credentials 
During the Installation of Vision, when the installer is testing for proper rights to the Report 
Server, a SQL Server account is required for connecting to the Microsoft SQL Server Database 
hosting the Report Server databases used for managing the Report Server and the Vision 

http://localhost/reports
http://localhost/reports
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reports. This account must be configured on the Microsoft SQL Server hosting the Report Server 
(most installations have the SQL Server Report Server database on the same machine as the 
Report Server Web Server component).  

In order to avoid errors during the Report Server installation, testing WebLink entries or running 
reports, a Report Server SQL Server database Login must be configured and given membership 
to the db_owner role on the SQL Server hosting the ReportServer and ReportSeverTempDB 
databases and your Vision database. 

 

The steps below should also be performed on your database. 

To configure/verify proper rights and privileges to the Report Server Database Server 
Component: 

1. Launch Microsoft SQL Server Management Studio. 

2. Expand the Server by clicking the Plus (+) in front of the Server Name, then expand the 
Security folder. 

3. Right-click the Logins folder and select New Login. 

4. Select the Windows account, existing SQL Server Login or Create a new SQL Server 
login and assign it a Password. The example below creates an account named Vision. 

5. Click User Mapping to display the User Mapping screen. 

6. Select the ReportServer database check box in the Users mapped to this login 
section. 

The Database role membership for the Server becomes enabled in the bottom section.  

7. Select the check box for db_owner to add the login to the db_owner role for the 
database. 

8. Repeat the same steps for the ReportServerTempDB database. 

 

Repeat the steps to map the login to the Vision database and to give it db_owner role 
membership to the database. 
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Appendix D: Printing in Vision  
In Vision 5.x and earlier, you could print using only the printers installed on the report server. 
Users who wanted to print to their local printers had to first print preview a report, save the report 
as a PDF file, and then, while viewing the PDF version of the report in their PDF viewer, they 
could print to their local printer. 

Vision 7.x provides the ability to: 

 Print directly to users’ local printers. 

 Send a printout or batch to printers that are installed directly on the Web server. This is 
primarily used for batch job printing using the process server for transactions such as 
Batch Billing. 

Server-Side Printing to Domain Printers 
You must complete the following to configure server-side printing (that is, network printers): 

Configure the DeltekVisionAppPool Identity (IIS) and the Report Server Windows Username 
(Report Server tab of WebLink) to be the same domain account. This must also match the 
domain account profile where your network printers are installed on the Vision Web/application 
server. 

Printing to Local Printers on End-User Workstations 
Vision 7.x uses the Microsoft SQL Reporting Services WinForms report viewer control to render 
reports and allow users to preview a report. From the preview window, a print job is sent directly 
to a user's local printer without the requirement of saving to a PDF file first. In the preview 
window, viewers still have the option to download to PDF and other file types. 

Reverse Proxy 
The Microsoft SQL Reporting Services WinForms report viewer control requires a direct 
connection to the server running the SQL Reporting Services Web Service. The connection is 
http://<server>/reportserver over Port 80 if no port is specified. If you have configured SSRS with 
a different port, then you will have to specify that port in the URL: 
(http://<server>/reportserver:<port>. 

This means that your report server (and possibly your database server if they are installed on the 
same machine) are directly exposed to the Internet. It also requires an external FQDN so that the 
report server can be resolved by the external users. 

A reverse proxy utilizing Microsoft’s Application Request Routing (ARR) extension for IIS allows 
the direct forwarding of requests through the Vision web server to the reporting services web 
service, with responses back to your Internet clients. This configuration resolves all of the issues 
identified in the previous paragraph.  

 

See the Deltek Vision Advanced Technical Administration Guide for information. 



 

 

Technical Installation Guide 110 

 

To print to a local printer: 

1. In Vision, preview a report. 

2. Click the Printer icon in the preview window to display a list of printers that are installed 
on the local workstation. 

3. Select the local printer, and click the Print button to send the printout to the local printer. 

Printing to Network Printers Installed on the Web Server 
In Vision 7.x, you print to network printers installed on the network server, the same as you did in 
previous versions of Vision. The only change is that the printers are now installed on the Web 
server instead of on the report server. Steps for installing printers on the Web server are in the 
next section titled Installing Network Printers on the Deltek Vision Web Server. 

To print to a network printer installed on the Vision Web server: 

1. In Vision, select a report, and click the Print icon on the toolbar.  

2. From the drop-down list, select the network printer. If only <Local Printer> is listed, the 
system administrator has not yet installed printers on the server.  

3. Click Print to send the job to the printer. 

Faster Printing 
If upgrading from Vision 6.x versions, server-side printing is now faster for Vision print jobs. This 
applies to printing reports, invoices, posting logs, checks, and so on. You will see a difference, 
especially when you print long reports. Reports print ten times faster. 

With the ability to print faster in Vision, there are some small formatting differences compared 
with prior versions of Vision: 

 Lines and boxes appear a little thicker. 

 Fonts appear a little smaller. One more line may print on a page. 

 Margins may be slightly different (0.1–0.3 cm difference). 

Faster printing applies only when you print directly to network printers that have been set up in 
Vision for which you have Vision role security. (The Vision print dialog box displays when you 
print.) It does not apply when you print from a Vision report preview window. (The standard 
Windows print dialog box displays when you print.) 

In Vision 7.x, you still have the option to print with the printing technology from Vision 6.1. You 
may prefer this for formatting purposes for some print jobs, such as for checks, forms, or invoices. 

To print using Vision's previous printing technology: 

1. Any place in Vision where you can select an option to open a Vision print dialog box, 
press the CTRL key on your keyboard and click the print option at the same time. 

Examples of print options that open a print dialog box in Vision are: 

 A print  icon on a Vision toolbar:  Print,  Print Checks, and so on. 

 A print command that displays in a drop-down list when you click a print command on 
a Vision toolbar. For example, on the toolbar of the Posting Logs form in Transaction 
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Center » Posting Logs, click  Posting Log, then press the CTRL key and click 

 Print on the drop-down list. 

 The Print Setup button on the Options dialog box. This dialog box displays when you 

select a report in Reporting, then click  Schedule on the toolbar. On the 
Schedule dialog box, click the Options button to open the Options dialog box. 

 The Run button on a report print options dialog box. 

A Print Using Previous Version's Method (May be Slower) check box displays at the 
bottom of the print dialog box. (This displays on the print dialog box only when you use 
the CTRL key.) 

2. Click the Print Using Previous Version's Method (May be Slower) check box. 

You must enter a network printer in the Printer Name field on the print dialog box to be 
able to select the Print Using Previous Version's Method (May be Slower) check box. 

3. Click Print. 

In the following scenarios, you have no control over the Print Using Previous Version's Method 
(May be Slower) check box. It will be selected automatically, regardless of whether or not you 
see the check box on the print dialog box: 

 On the print dialog box, you select more than one copy to print in the Number of Copies 
field, and you clear the Collate check box. 

 On the print dialog box, you select the Set Scale check box, and you change the 
percentage to something other than 100%. 

Known Issues with the Printing Enhancement 

 Some reports that are set to print automatically in landscape mode in order to fit all their 
columns now print in portrait mode. As a result, some columns are cut off entirely. Even if 
you change the layout from portrait to landscape on the Layout tab, the report still prints 
in portrait mode. The Project Planning List and Profit Planning Monitor reports are two 
reports that have this issue. Until this is fixed, you can print these reports in landscape 
mode using the previous version’s printing method. 

 The UK “check on bottom” check format and purchase orders are printing incorrectly. 
Some text near the left margin is cut off. Until this is fixed, you can print the checks using 
the previous version’s printing method. 

Installing Network Printers on the Vision Web Server 
The Vision WebLink application allows you to configure the account that connects Vision to SQL 
Server Reporting Services. Vision uses this account to run reports, view report activity, and 
perform server-side printing, such as when batch printing is required. It is possible to have two 
accounts that work with SQL Server Reporting Services, depending on your report server 
database access selection. 

 If you select Windows Authentication, you can only have one account.  

 If you select SQL Authentication, you can have two accounts (one for access to the 
printers and the URL, and the other to access the database). 

The following procedures address the requirements for establishing the necessary rights and 
privileges on the Web, database, and report servers for batch printing. This is required if you 
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change the Windows Username account specified in Weblink from the default local account 
“DeltekVision” created by the installation. 

In the WebLink application, the Report Server tab is used to configure Vision for connecting to 
Microsoft SQL Server Reporting Services. The tab contains the following two sections: 

 Report Server Web Service Access — The account entered in this section connects 
the SQL Server Reporting Services URLs for loading Vision reports into Reporting 
Services, checking Vision report versions, and running Vision reports. See Report Server 
Web Service Access for more information. 

 Report Server Database Access — The account entered in this section connects the 
database server hosting the Reporting Services Report Server Databases and the Vision 
database. It is also used for running reports and checking Vision reporting activity in 
Reporting Services. You can use the following two options:   

 Windows Authentication –- Select this option for the account in the Report Server 
Web Service Access section to be used to connect to the database server. 

 Specify a SQL Server Username and Password – Disable the Windows 
Authentication option and specify the SQL Server Login you created in SQL Server 
Management Studio in the Database Username field.  

Use the database server procedure below to configure the required rights for either 
option. See Report Server Database Access for more information.  

To configure network printers for Vision batch jobs, launch WebLink and complete the steps in 
the following sections to assign the appropriate rights to the account being used in each section.  

Report Server Web Service Access 
To change the account listed from Vision to a domain account: 

1. Create a domain user account (not a domain administrator). If local or domain password 
policies may cause the password to expire, ensure that the password is updated in 
WebLink in a timely manner to avoid connection errors.  

2. Complete these steps on the Web server: 

a. Log on to the Web server and add the account to the Local Administrator Group. 
(This gives the account the privilege to install the print drivers.) 

b. On the Web server, click Control Panel » Administrative Tools, and launch the 
Local Security Policy applet.  

c. Expand Local Policies and click User Rights Assignment. 

d. Double-click the Logon as a Service option and add the account to the list. (This 
allows Vision to enumerate the list of printers.) 

e. Log on to the Web server as the account and install all the printers that are required. 

3. Complete this step on the Report server: 

 

The account referenced in WebLink may not have the necessary privileges (even as a member 
of the local administrator’s group on the report server). 

Log on to the report server and add the account to the local administrator’s group using 
the steps in the Required Rights for Report Server Web Services section of Appendix C.  
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Report Server Database Access 
Follow these steps to create a SQL Server login that corresponds to the account you entered on 
the Deltek Vision WebLink Report Server tab. In these steps, you also give the account the 
appropriate rights to the databases on the SQL Servers hosting your Vision and report server 
databases.  

 

These steps are also listed with screenshots in the Prerequisite Report Server and 
SQL Server Database Credentials above section of Appendix C. 

To create an account and add the appropriate rights: 

1. Launch the SQL Server Management Studio and connect to the database server(s) 
hosting the Vision and report server databases. 

2. Expand the security folder. 

3. Right-click logins and select New Login. The New Login screen displays.  

4. Click the General tab. 

5. Complete the following fields: 

 Login name — Enter the name of the SQL Server Login. The login name you enter 
here and the authentication option you select must match the values you enter in 
WebLink on the Report Server tab. 

 Windows Authentication — If you selected Windows Authentication on your 
WebLink entry (Database Access section), select this option and enter the same 
name that you entered in the Windows Username field of the Report Server Web 
Service Access section of WebLink. The Integrated Authentication check box must 
be enabled in the Database Server Connection section of the Report Server tab in 
WebLink. 

 SQL Server Authentication — If you selected SQL Authentication on your WebLink 
Entry (Database Access section), select this option and enter the same name that 
you entered in the Database Username field of the Report Server Database Server 
Connection section of WebLink. The name specified for this section cannot be in the 
Domain\Username format. 

6. Click OK. 

7. Click the User Mapping tab.  

Use these fields to determine the databases to which the login name will be mapped and 
the role membership to which it will be assigned in the databases. 

8. Make sure the following databases are selected in the Users mapped to this login grid: 

 ReportServer 

 ReportServerTempDB 

 Your Vision databases  

This maps the login/user to the respective databases.  
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9. As you select each database (including your Vision database), select the db_owner role 
in the Database role membership for: section. You must select this option for each 
database. 

You must map the login that is created on the database server to all Vision databases 
that are configured in WebLink. This is in addition to the ReportServer and 
ReportServerTempDB databases. If the login is not a member of the db_owner role in 
those databases, the WebLink Reporting Services connections will fail.  

Launch Deltek Vision WebLink 
To launch WebLink: 

1. Launch the Deltek Vision WebLink application and select your database entry. The 
database entry you select here should have also been mapped previously. 

2. Select the Report Server tab. 
3. Enter the Domain account you created and configured on the Web server in the Report 

Server Web Service Access section. 
4. In the Report Server Database Access of WebLink, enter the SQL Server Login you 

created and configured on the database server, or select the Windows Authentication 
option. This allows you to use the domain account you used in the Report Server Web 
Services section to connect to the Report Server Database Servers. 
Do not enter a Windows Domain account. 

Launch Deltek Vision Application and Refresh Report Printers 
To launch Vision and refresh report printers: 

1. Launch the Deltek Vision application and log in to the database entry you configured in 
WebLink. 

2. Click Utilities » Report Administration. 
3. Select the Report Printers tab. 
4. Click Refresh Report Printers to update Vision with the printers that were installed. 
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Appendix E: Reload Reports into Vision 
During the Web server/tier installation process, Vision installs a standard set of reports. Vision 
uses the following internal steps to complete this process: 

1. Vision installs the Vision report folders and files into the Vision\Reports folder (default 
location: \Program Files\Deltek\Vision\Reports).  

2. Vision imports the Vision Report files into Microsoft SQL Server Reporting Services 
(SSRS), which makes the reports available in Reporting Services.  

Connection Errors  
If there are problems with the connection between Vision and the report server, the reports will 
not install correctly onto the report server. 

Installation Type Problem Possible Cause Solution 

Upgrade existing 
Vision 6.x 
installation 

The connection 
between the report 
server database and 
Reporting Services 
URL fails. 

The account specified in 
WebLink may not have 
the appropriate rights to 
the report server, web 
server, report server 
databases, and Vision 
database. 

Upgrade your installation.  

See Upgrade an Existing 
Vision 6.x Installation in 
the “Identify the Error” 
section below for steps to 
resolve the issue. 

New Vision 7.x 
installation 

An error displays 
during installation. 

An internal error 
occurred during the 
installation. 

Check the Vision installation 
log files and correct the 
condition that is listed in the 
error message.  

See New Installation of 
Vision 7.x in the “Identify 
the Error” section below for 
steps to resolve the issue. 

All installations The connection 
between the report 
server database and 
Reporting Services 
URL fails. 

The report server did 
not respond in a timely 
manner and the 
connection timed out. 

Launch Vision and reload 
the reports.  

See Reload Reports into 
Vision in the “Identify the 
Error” section below for 
steps to resolve the issue. 

Identify the Error 
If Vision displays a message stating that Vision reports were not successfully imported during the 
installation process, you must complete the appropriate procedure for your installation type.  

Test the Report Server Settings in WebLink 

To upgrade an existing Vision 6.x installation:  

1. Launch the Deltek Vision WebLink application. 
2. For each database in the drop-down list, click the Report Server tab. 
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3. Click the Test Report Server button to verify that no errors occur during the connection.  

 

For information on assigning rights to the account listed in WebLink, see Appendix D: 
Printing in Vision. 

4. Save your changes and exit WebLink. 
5. Reload your reports into Vision. See the “Reload Reports into Vision” procedure below for 

additional information. 

Reload Reports into Vision 

To reload reports on the Vision reports server:  

1. Double-click the Vision icon to launch the Vision application. 
2. From the Vision Navigation menu, click Utilities » Report Administration to display the 

Reporting Administration form.  
3. Select the Load Reports tab to load reports on the report server. 
4. In the Location of reports on application server field, enter the file path location of the 

reports (RDL files) on the report server. 
5. From the Type option drop-down list, select Standard. 
6. If you want to load a single report, enter the name of the report in the Report Name field. 

(You do not need to supply the .RDL extension.)  
You can also use this field as a wild card search. For example, if you enter Project, 
Vision finds and loads all files that contain the word Project, such as Project List, Project 
Summary, and Project Audit.  
Sub reports do not load for main reports; you must load them manually by name.  
If you leave the Report Name field blank, all reports load. 

7. Click Load Report Files. A loading reports warning message displays. 
8. Click OK to continue the reload report process. 
9. To install custom reports, return to step 5. This time, select Custom from the Type option 

drop-down list. Then complete the remaining steps of the procedure. 

 

For additional information on reloading reports, click the Help button on the Load Reports Tab. 
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Appendix F: Providing Single Sign-On with 
Microsoft Azure Active Directory 
This section applies only if you decide to use Microsoft Azure Active Directory (Azure AD) to 
enable single sign-on for Vision. 

Microsoft Azure AD’s single sign-on allows Vision users to log onto Vision using their Windows 
user name and password instead of a separate Vision user name and password. Azure AD 
allows you to securely synchronize your users’ network credential information to the cloud. 

Before users can log onto Vision with their Windows credentials, a Vision administrator must 
complete the following configuration steps, which are described in the sections below: 

1. Sign up for a Microsoft Azure AD account. 

2. In Azure AD, complete the single sign-on configuration. 

3. In Vision, complete the fields on the Azure Active Directory tab in Configuration » 
General » System Settings. 

4. In Vision, complete the settings on the General tab in Configuration » Security » Users 
that are related to single-sign on. 

Sign Up for a Microsoft Azure AD Account 
If your firm does not already have a Microsoft Azure AD account, you can sign up for a free 
account at https://azure.microsoft.com/en-us/free. 

Microsoft also offers an Azure AD Premium account for a cost at https://azure.microsoft.com/en-
us/trial/get-started-active-directory. 

The Premium edition is not required for using the single sign-on solution for Vision. 

Complete Single Sign-On Configuration in Azure AD 

Overview of Steps 
The following are the steps that you must complete to configure single sign-on in Azure AD: 

1. Configure Azure AD Connect. 

2. Add and configure Vision applications in your Windows Azure Active Directory. 

Use the directions in the sections that follow to complete these steps. 

Configure Azure AD Connect 

Overview 

For more background information about Azure AD Connect, see Microsoft’s Integrating your on-
premises identities with Azure Active Directory. This describes what Azure AD Connect is and 
how it works. 

Prerequisites 

Review and complete the prerequisites for Azure AD Connect as outlined by Microsoft’s 
Prerequisites for Azure Active Directory Connect (Azure AD Connect). 

https://azure.microsoft.com/en-us/free/
https://azure.microsoft.com/en-us/trial/get-started-active-directory/
https://azure.microsoft.com/en-us/trial/get-started-active-directory/
https://azure.microsoft.com/en-us/documentation/articles/active-directory-aadconnect/
https://azure.microsoft.com/en-us/documentation/articles/active-directory-aadconnect/
https://azure.microsoft.com/en-us/documentation/articles/active-directory-aadconnect-prerequisites/
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Hardware requirements are also listed in this article. 

 

Deltek recommends that you do not install Azure AD Connect on your domain controllers. 

Configuration Steps for Azure AD Connect 

Complete these steps after you have completed the prerequisites for Azure AD Connect in the 
section above.  

To configure Azure AD Connect: 

1. Download and install the Microsoft Online Services Sign-In Assistant for IT Professionals 
RTW (msoidcli_64.msi) from the following Microsoft web page: 

Microsoft Online Services Sign-In Assistant for IT Professionals RTW 

Refer to the installation instructions on the web page. 

2. Click the following Microsoft link to download and install Azure Active Directory Module 
for Windows PowerShell for the 64-bit version (AdministrationConfig-en.msi): 

Azure Active Directory Module for Windows PowerShell (64-bit version) 

3. Download and install Microsoft Azure Active Directory Connect (AdministrationConfig-
en.msi) using the following Microsoft link: Azure Active Directory Connect. 

 Review the account and permissions information at the following Microsoft web page: 
Azure AD Connect: Accounts and Permissions. 

 You must set up the following required accounts with a username and password: 

 Windows Azure Active Directory (Global Administrator) 

 On-Premise Active Directory (Enterprise Administrator) 

 

 For more information, see Managing Azure AD Connect. 

 Depending on the size of your on-premise Active Directory, the installation of 
Azure AD Connect can take some time, especially if you select the option to 
synchronize users at the end of the installation. 

4. Verify that users are synchronized with Windows Azure AD by logging into your Windows 
Azure portal. 

5. Test a user on the Microsoft Apps portal at: https://myapps.microsoft.com. 

 No applications will show but you can test authentication. 

 Use an existing user name and password for the test. 

 

For troubleshooting information, see: 
https://msdn.microsoft.com/library/azure/jj151834.aspx. 

Add and Configure Vision Applications in Your Windows Azure Active 
Directory 
You must add and configure two applications for Vision in Azure AD: Deltek Vision (Client) and 
Deltek Vision. 

http://go.microsoft.com/fwlink/?LinkID=286152
http://go.microsoft.com/fwlink/p/?linkid=236297
https://go.microsoft.com/fwLink/?LinkID=518309
https://azure.microsoft.com/en-us/documentation/articles/active-directory-aadconnect-accounts-permissions/
https://azure.microsoft.com/en-us/documentation/articles/active-directory-aadconnect-whats-next/?WT.mc_id=A0618AD18
https://myapps.microsoft.com/
https://msdn.microsoft.com/library/azure/jj151834.aspx
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Add and Configure the Deltek Vision (Client) Application 

To add and configure Deltek Vision (Client) in Azure AD: 

1. From your Microsoft Azure AD portal, navigate to Windows Azure » Active Directory » 
<DirectoryName>. 

2. On the Applications tab, click Add. 

3. On the What do you want to do dialog box, select Add an application my organization 
is developing. 

 
4. On the Tell us about your application dialog box: 

 In the Name field, enter Deltek Vision (Client). 

 For Type, select Native Client Application. 

 
5. On the Application information dialog box, enter https://deltekvisionclient in the 

Redirect URI field. 

This must be a valid URI, but not a reachable URL. 

 
6. Click the circled check mark icon to create and save the application. 
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7. Open the Deltek Vision (Client) application in the Azure AD portal, and go to the 
Configure tab to take note of what is entered in the Client ID field in the Properties 
section. 

You can click the clipboard icon next to the Client ID field to copy the field value to the 
clipboard and save it. 

You will need to enter this client ID when you enter settings on the Azure Active Directory 
tab in Vision Configuration » General » System Settings. This is one of the last steps 
for configuring single sign-on for Vision. You will enter this client ID in the Client ID field 
on the Azure Active Directory tab. 

 

Add and Configure the Deltek Vision Application 

To add and configure Deltek Vision in Azure AD: 

1. From your Microsoft Azure AD portal, navigate to Windows Azure » Active Directory » 
<DirectoryName>. 

2. On the Applications tab, click Add. 

3. On the What do you want to do dialog box, select Add an application my organization 
is developing. 

 
4. On the Tell us about your application dialog box: 

 In the Name field, enter Deltek Vision. 

 For Type, select Web Application and/or Web API. 

Clipboard icon 
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5. On the App properties dialog box, enter the fully qualified, internet-accessible URL/URI 

that your organization uses to access Vision in the Sign-On URL field and the App ID 
URI fields. 

Example: For ABC Engineers, enter https://www.abcengineers.com/deltekvision 

The URLs will be verified and should have a green check mark beside them. 

 
6. Click the circled check mark icon at the bottom of the screen to create and save the 

application. 

 
7. Open the Deltek Vision application in the Azure AD portal, and go to the Configure tab to 

take note of what is entered in the Client ID field in the Properties section. 

You can click the clipboard icon next to the Client ID field to copy the field value to the 
clipboard and save it. 

You will need to enter this client ID when you enter settings on the Azure Active Directory 
tab in Vision Configuration » General » System Settings. This is the last step of 
configuring single sign-on for Vision. You will enter this client ID in the Server Client ID 
field on the Azure Active Directory tab. 
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8. In the Keys section of the Configure tab, click the drop-down icon to select the duration 

for the key that you are about to generate. 

Deltek recommends that you create a 2-years key. 

 
9. Click Save at the bottom of the screen to create and save the key and generate the key 

value for it. 

 

Before you leave this screen, you must complete the next step. 

10. Before you leave the screen that displays the key value: 

Take note of what the key value is for the key. You must do this now because after you 
leave this screen, you cannot return to the screen to see the value. 

You can click the clipboard icon next to the field that displays the key value to copy the 
value to the clipboard and save it. 

You will need to enter this value when you enter settings on the Azure Active Directory 
tab in Vision Configuration » General » System Settings. This is the last step of 
configuring single sign-on for Vision. You will enter the key value in the Server Key 
(Secret) field on the Azure Active Directory tab. 

Clipboard icon 
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If you do not have the key value when you need to enter it in Vision Configuration » 
General » System Settings, you must delete the key in Azure AD and recreate it.  

11. In the Reply URL section, add the following reply URLs: 

 <The beginning of your Customer URL>  

(https://<Customer>.deltekfirst.com) 

Example: For ABC Engineers, enter https://abcengineers.deltekfirst.com. 

 https://deltekvisionclient 

 https://localhost 

 
12. Click Save at the bottom of the screen. 
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Set Up Trust Between the Deltek Vision (Client) Application and Deltek Vision Application 

To set up trust between the applications: 

1. From the Microsoft Azure AD portal, navigate to the Deltek Vision (Client) application. 

2. On the Configure tab, in the permissions to other applications section, click Add 
application. 

 
3. In the Permissions to other applications screen: 

a. In the Show field, select All Apps. 

b. In the Starting With field, enter Deltek. 

c. Click the circled check mark beside the Starting With field. 

 
4. Click the circled plus sign to the right of Deltek Vision application name. 
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5. Click the circled check mark in the lower right corner of the screen to return to the 
Configure tab. 

 
6. On the Configure tab, hover over Delegated Permissions to open the drop-down list, 

and select the Access Deltek Vision check box. 

 
7. Click Save at the bottom of the screen. 
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Complete the Azure AD Configuration in Vision 
After you have completed single sign-on configuration in Azure AD in Vision: 

1. From the Vision Navigation menu, click Configuration » General » System Settings. 

2. On the General System Settings form, click the Azure Active Directory tab, and complete 
the fields on the tab: 

 

 Domain Name (Tenant) — Enter your on-premise active directory domain name (for 
example abcengineering.com). If you do not have a .com in your domain name, 
contact your system administrator or a Deltek consultant. 

 Client ID — Enter the client ID that was generated when you added and configured 
the Deltek Vision (Client) application in Azure AD. This is described in the “Add and 
Configure the Deltek Vision (Client) Application “ section in step 7 on page 120 of this 
guide. 

 Server Client ID — Enter the client ID that was generated when you added and 
configured the Deltek Vision application in Azure AD. This is described in the “Add 
and Configure the Deltek Vision ApplicationAdd and Configure the Deltek Vision” 
section in step 7 on page 121 of this guide. 

 Server Key (Secret) — Enter the key value that was generated for the key added for 
the Deltek Vision application in Azure AD. This is described in the “Add and 
Configure the Deltek Vision Application” section in step 10 on page 122 of this guide. 

 Authentication type — From the drop-down list, select the Windows Azure 
prompts user for login credentials (default). 

3. Click Save on the toolbar. 

Complete Users Configuration in Vision 
When you set up users and passwords in Vision in Configuration » Security » Users, you must 
enter the following for each user on the General tab: 

 Select the Windows Authentication check box. 

 In the Domain field, enter your domain name (example: abcengineers.com). 

 



 

 

 

Deltek is the leading global provider of enterprise software and information solutions for government 
contractors, professional services firms and other project- and people-based businesses. For decades, we 
have delivered actionable insight that empowers our customers to unlock their business potential. 20,000 
organizations and millions of users in over 80 countries around the world rely on Deltek to research and 
identify opportunities, win new business, recruit and develop talent, optimize resources, streamline 
operations and deliver more profitable projects. Deltek – Know more. Do more.® 
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